
Save in Picture It! format?
This picture was originally opened in a file format other than .MIX. 
It was converted to the .MIX format so that you could work on it in Picture It!.

Click If you want to

Yes Save the current picture 
in the .MIX file format.

Yes to 
All

Saves all open pictures in 
the .MIX file format.

No Save your picture in its 
original file format.

Changing monitor settings
Click If you want to

Yes Change your display 
settings. You may need to 
restart your computer 
after you change the 
settings.

No Retain your current 
display settings.

Save changes
Click If you want to

Yes Save your picture, 
including all your changes.

No Close your picture without
saving your changes.

Large picture
Click If you want to

Save as 
finished 
collage

Create a temporary, 
smaller version of your 
picture to send in the 
e-mail message.

Create a 
slide show

Send your picture in 
slide show format 
rather than in an e-
mail message.

Send large 
picture (as 
is)

Send your picture in an
e-mail message without
trying to reduce the 
file size.

Tell me more about connecting devices
The device or drive you have selected is not available.
Verify that:



The disk is in the drive.
Your computer is connected to the device.

For more information on connecting drives and devices, refer to your computer's documentation.



Low disk space
Your computer is running out of disk space, and you may not be able to save your work. Picture It!
needs at least 30 megabytes of storage space on the hard drive where Windows places 
temporary files. 
To free up disk space, you can:

Delete any unnecessary files from your computer's hard drive, such as *.TMP files and old 
Internet links.

Empty the Recycle Bin.
Move files to a removable disk or another hard drive.



Cannot open picture
Pictures created or worked on in programs other than Picture It! probably use a proprietary 
formatthat Picture It! may not be able to open.
1 Start the program you used to originally create the picture.
2 Open your picture.
3 Save it again in one of the file formats Picture It! can open, such as .BMP.
          What file formats can Picture It! open?  
          Opening a picture created in a different program  



Tell me about file names
Picture It! file names must be less than 256 characters in length, including spaces and 
punctuation. There may also be characters that are not allowed, depending on your operating 
system. Refer to your operating system's documentation for more information.



How do I free disk space?
You can:

Delete any unnecessary files from your computer's hard drive.
Empty the Recycle Bin.
Move files to a removable disk or another hard drive.



Program could not start
Your computer does not have enough disk space or memory for Picture It! to start. Try:

Closing any open programs.
Deleting any unnecessary files from your computer's hard drive, such as *.TMP files and old 

Internet links.
Emptying the Recycle Bin.
Moving files to a removable disk or another hard drive.



Reserved file name
Your file name cannot end in .CON, .AUX, .PRN, .LPT*, or .COM*.
Please type a different file name.



Directory not found
The directory path you typed in the Options dialog box, under Path to my pictures, is not valid.
1 On the View menu, click Options.
2 You can either:

In Path to my pictures, type a new path.
--or--

Click Browse, and then click the folder you want.



Low memory
Your computer is running out of memory.
To regain more memory:

Quit all unnecessary programs on your computer.
Tip:    To see what is running on your computer, you can press CTRL-ALT-DEL on your keyboard. 
Microsoft Windows Task Manager shows you all the programs that are open, and allows you to 
close them.
--or--

Close some of your pictures in Picture It!



Convert to a catalog folder
If you include your pictures in a Catalog and add descriptions to them, then, if you forget the 
name or location of a picture, you can easily search for it.

Click If you

Yes Want Microsoft Media 
Manager to convert your 
My Pictures folder to a 
catalog folder.

No Don't want your My 
Pictures folder converted 
to a catalog folder.

Need an image to add
You selected a folder that does not contain any pictures. 
There must be at least one picture in a folder for Picture It! to create shortcuts in the Catalog. 
Click OK to close this message, and then click a folder that contains at least one picture.



No images to add
You selected a folder that does not contain any pictures. 
There must be at least one picture in a folder for Picture It! to create shortcuts in the Catalog. 
Click OK to close this message, and then click a folder that contains at least one picture.



Making a card
1 Click the Projects tab.
2 Click Cards, and then click the card you want to make.
3 Follow the instructions in the task pane. 



Making a calendar
1 Click the Projects tab.
2 Click Calendars, and then click the calendar you want to make.
3 Follow the instructions in the task pane. 



Making other fun stuff
1 Click the Projects tab.
2 Click Fun Stuff, and then click the project you want to make.
3 Follow the instructions in the task pane. 



Making combined pictures more compatible
The pictures you combine in a collage may have different tints, resolutions, focus, or other 
variations. 
You can try some of the following methods to give the objects you're using a more uniform look.
            Softening the edges  
            Correcting the tint  
            Changing the brightness or contrast  
            Blurring or sharpening focus  



Making a cutout
        Play movie: Making a cutout  

        Play movie: Moving and resizing  
1 Open the picture you want to use.
            How?  
2 Click the Workbench tab.
3 Click Pictures & Cutouts, and then click Cut Out of Picture.
4 Follow the instructions in the task pane.
What do you want to do now?
            Combine the cutout with other pictures  
            Edit the shape of the cutout  



Adding a picture
1 Click the Workbench tab.
2 Click Pictures & Cutouts, and then click Add Picture or Cutout.
3 Follow the instructions in the task pane.
What do you want to do now?
            Move or resize the picture  
            Making combined pictures more compatible  



Editing the shape of an object
You can use this procedure to remove sections of an object.
1 On the Stack, click the object you want to change.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Pictures & Cutouts, and then click Edit Cutout.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  
Tips
            Removing something you don't want from your picture  



Filling an object
1 On the Stack, click the object you want to fill.
            I haven't yet cut out the object I want to change.  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Pictures & Cutouts, and then click Fill Picture or Cutout.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Replacing an object
1 On the Stack, click the object you want to replace.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Pictures & Cutouts, and then click Replace Picture or Cutout or Replace Text.
4 Follow the instructions in the task pane.



Making a collage using a template
1 Click the Projects tab.
2 Click Collages, and then click Collage with a Template.
3 Follow the instructions in the task pane. 
Tips
            How can I keep my pictures a standard size?  
What do you want to do now?
            Paint on a picture  



Making a collage on your own
1 Click the Projects tab.
2 Click Collages, and then click Create on My Own.
3 Follow the instructions in the task pane. 
What do you want to do now?
            Paint on a picture  
            Add a mat  



Copying an object
1 On the Filmstrip, click the picture containing the object you want to copy.
            Where's the Filmstrip?  
2 In the Retriever, click the object you want to copy, and then drag it to the picture in the 

picture pane.
            Where's the Retriever?  
3 Move the copy to its new position.
            How?  



Changing color in an object in a picture
            Play movie: Changing color  
1 On the Stack, click the object you want to change.
            I haven't yet cut out the object  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Paint & Color Effects, and then click Change Color.
4 You can either:

Click around the Color tool to change the object's colors.
            How does the Color tool work?  

--or--
Click in the object to select the color that you want to change (this is called the "reference 
color"), and then use the Color tool to select the color you want.

            Why choose a reference color?  
Note: The Color tool does not work on black, white, or gray. First add color to the object using 
the Tint tool.
            How?  
Tip:    To prevent changing colors other than those similar to the reference color, first cut out 
the colors that you want to change.
            How?  
Troubleshooting
            What if I change my mind?  



Changing color in the whole picture
            Play movie: Changing color  
1 Click the Workbench tab.
2 Click Paint & Color Effects, and then click Change Color.
3 If there are two tabs, click the Whole Picture tab.
4 You can either:

Click around the Color tool to change the picture's colors.
            How does the Color tool work?  

--or--
Click in the picture to select the color that you want to change (this is called the "reference 
color"), and then use the Color tool to select the color you want.

            Why choose a reference color?  
Note: The Color tool does not work on black, white, or gray. First add color to the object by 
using the Tint tool.
            How?  
Tip: To prevent changing colors other than those similar to the reference color, first cut out the
colors that you want to change.
            How?  
Troubleshooting
            What if I change my mind?  



Adding color to a black and white picture
To add color to a black and white picture, you need to use the Tint tool.
1 Click the Workbench tab.
2 Click Touchup, and then click Correct Tint.
3 On the Tint tool, click the color you want to add to the picture.
4 To increase the level of the color you selected, drag the slider to the right.
Once you've tinted your black and white picture, you can use the Color tool to experiment 
further with its color.
            Using the Color tool  
Tip:    To add color to a small area of your picture, click Colorize in Touchup Painting.
            How?  



Why choose a different reference color?
When you're using the Color tool, the "reference color" in your picture or object is the color 
that changes to match the one you click on the Color tool. If you do not select a reference color, 
the Color tool automatically selects the dominant color in your picture or object as the reference
color, and this will generally work well.
In the following cases, you may want to choose a different reference color:

Patterns    If your picture is composed mainly of patterns or designs (plaid, for example), 
you can create a new pattern by clicking any part of the design, and changing the color. 

A small target area    If there's an area in your picture that you want to change to a 
specific color, click it, and then use the Color tool (the rest of your picture will also change). If you 
want only one part of the picture to change, cut that part out and then use the Color tool to change 
it.
Tip: Make a cutout consisting only of the colors you want to change.
            How?  



Painting on a picture
You can choose from a wide variety of painting tools for adding designs or handwritten text to 
your picture.
1 Click the Workbench tab.
2 Click Paint & Color Effects, and then click Creative Painting.
3 In step 1 in the task pane, click a painting tool.
4 In step 2 in the task pane, click a color
5 Each type of tool comes with a choice of shapes. If you want, choose a different shape for 

the tool you picked.
            How?  
6 Drag in the picture pane to start painting.
Troubleshooting
            What if I change my mind?  
Tips
            Choosing a different shape for the painting tool  
            Painting with stamps  
            What does adjusting paint transparency do?  
            What does choosing a paper texture do?  



Choosing a different shape for the painting tool
1 At the bottom of the Creative Painting task pane, click Customize paint settings.
2 In the new task pane, click a shape for your brush. 
3 Drag in the picture pane to see how the shape you've chosen paints. 
4 If you don't like the effect, click Undo your last stroke. Or try a different width or color 

by returning to the first Creative Painting task pane and making changes there.



Stamping
1 Click the Workbench tab.
2 Click Paint & Color Effects, and then click Stamping.
3 In step 1 in the task pane, click one of the three stamping styles.
4 In step 2 in the task pane, click the stamp you want.
            What if I want to use my own stamp?  
5 In step 3 in the task pane, click a smaller or larger ball, depending on the size stamp you want.
6 If you want to add transparency, texture, or assign a new color to a stamp, at the bottom of 

the task pane, click Customize stamp...
7 Click the picture in the picture pane to add one stamp at a time, or drag to create a line of 

connected stamps.
Troubleshooting
            What if I change my mind?  
Tips
            What does adjusting stamp transparency do?  
            What does choosing a paper texture do?  



Adding a gradient fill
1 On the Stack, click the object you want to fill.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Paint & Color Effects, and then click Fill with Gradient.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Adding a colored shape
1 Click the Workbench tab.
2 Click Pictures & Cutouts, and then click Add a Colored Shape.
3 Follow the instructions in the task pane.
Tip: You can also add colored shapes with the Stamp tool.
            How?  



Adding a solid fill
1 On the Stack, click the object you want to fill.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Paint & Color Effects, and then click Fill with Solid Color.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Removing paint
What do you want to remove?
            The entire painting  
            Part of the painting  



Removing an entire painting
If you Then
Are still in 
the 
Creative 
Painting 
task pane

Click Cancel or 
Reset.

Have 
clicked 
Done, but 
made no 
other 
changes yet

On the Edit menu, 
click Undo.

Have made 
other 
changes to 
your 
project 
since adding
the paint

On the Stack, click 
the painting you want 
to remove, and then 
press DELETE.



Erasing part of a painting
If you Then
Are still in 
the 
Creative 
Painting or 
Stamping 
task pane 
and want to
erase your 
last stroke 
and 

Click Undo your last
stroke.

Are still in 
the 
Creative 
Painting or 
Stamping 
task pane 
and want to
start over 
and 

Click Cancel or 
Reset.

Have not 
completed 
any tasks 
other than 
Creative 
Painting or 
Stamping 
since you 
painted 
your 
picture.

1 Click Paint 
and Color 
Effects, and 
then click 
Creative 
Painting.

2 Select the 
Eraser, and 
drag your 
mouse over 
the parts of 
the painting 
you want to 
erase.

Have made 
other 
changes to 
your 
project 
since you 
painted 
your 
picture.

1 On the 
Stack, click 
the painting 
containing 
elements you 
want to 
remove.

            Where's   
the Stack?

2 Click the 
Worbench 
tab.

3 Click Pictures
and 
Cutouts,and 
then click 
Edit Cutout.

4 Follow the 
instructions 



in the task 
pane.

Troubleshooting
            Cropping part of a picture  
            Removing something you don't want from your picture  



What you should know about copyrights
Picture It! features make it easy and fun to transform photographs and digital art into unique 
projects of your own. Sooner or later, you'll probably want to include professionally made 
photographs and digital art. Before you do, be aware of the limitations of using these materials.
In general, the two most important things to consider when working with copyrighted materials 
are:

You need permission to copy and redistribute other peoples' work. Sometimes obtaining 
permission will require paying royalties (a fee) and/or obtaining a license.

Having permission to copy and redistribute often does not include the right to change the 
picture. 
Feel free to use the contents of the Picture It! CD-ROM to make cards, calendars, and other 
items for your personal use. However, you are not allowed to sell any pictures or projects you 
created by using images or templates that came on the Picture It! CD-ROM. For more complete 
information regarding copyrights, consult a legal professional.
            What is a copyright?  
            How should I take copyrights into account?  



What is a copyright?
A copyright gives exclusive ownership rights to the individual who created an original work. These
rights are protected by U.S. law and international agreements.



How should I take copyrights into account?
In Picture It! whenever you use a picture that you didn't take or a piece of art that you didn't 
make, consider that it may be copyrighted. If you're not sure, ask. It's often quick and easy to 
get permission to use someone else's material, and it can avoid problems down the road.
            Copyrights for professional photographic portraits  
            Copyrights for photographs in published materials  
            Copyrights for online photographs or digital art  



Copyrights for professional photographic portraits
School pictures, wedding photographs, and those holiday pictures taken in department stores are
all generally taken by professional photographers. Before you scan these images for your own 
use, make sure that you get permission from the photographer. 



Copyrights for photographs in published materials
If you want to scan a picture from a magazine or book, or take a picture of something you see in 
a video, get permission from the publisher or check with your copy shop staff first. 



Copyrights for online photographs or digital art
Digital art can be copyrighted just as art in printed sources. Before you download art you find on 
the World Wide Web, make sure you get permission from the author or artist that created the 
work, not just the person who posted it online.



Using the Mouse and keyboard to speed up my work
            Keyboard shortcuts: The basics  
            Keyboard shortcuts: Viewing and editing a picture  
            Keyboard shortcuts: Working with text  
            Mouse shortcuts  



Keyboard shortcuts: Undoing and deleting
To Press

Undo the previous
action

CTRL+Z

Redo the previous
action

CTRL+Y

Delete a selected
item

DELETE

Delete one 
character to the 
right of the 
insertion point in 
text tasks

DELETE

Delete one 
character to the 
left of the 
insertion point in 
text tasks

BACKSPACE

Keyboard shortcuts: Nudging objects
On the Stack, click the object you want to move.
            Where's the Stack?  
To nudge 
something

Press

To the left ç
To the right è
Up é
Down ê

Keyboard shortcuts: Opening, saving, printing, and quitting 
Picture It!
To Press

Create a new 
collage

CTRL+N

Open an existing 
picture or collage

CTRL+O

Print part or all 
of a picture

CTRL+P

Save changes to a
picture

CTRL+S

Quit Picture It! ALT+F4
Open Picture It! 
Help

CTRL+F1



Keyboard shortcuts: Moving the insertion point in text tasks
To move Press

Up one line é
Down one line ê
Left one 
character

ç

Right one 
character

è

To the end of a 
line

END

To the beginning 
of a line

HOME

Right one word CTRL+è
Left one word CTRL+ç
To the beginning 
of the text

CTRL+HOME

To the end of the
text

CTRL+END



Keyboard shortcuts: Highlighting text
To highlight Press

One character to 
the left

SHIFT+ç

One character to 
the right

SHIFT+è

To the end of a 
word

CTRL+SHIFT+
è

To the beginning 
of a word

CTRL+SHIFT+
ç

To the end of a 
line

SHIFT+END

To the beginning 
of a line

SHIFT+HOME

One line down SHIFT+ê
One line up SHIFT+é
To the end of the
text

CTRL+SHIFT+
END

To the beginning 
of the text

CTRL+SHIFT+
HOME



Keyboard shortcuts: Editing text
To Press

Undo the last 
action

ALT+
BACKSPACE

End one line and 
begin another

ENTER



Mouse shortcuts
To Try

Select a word Double-clicking 
the word

Select multiple 
words

Double-clicking, 
then dragging

Resize an 
object, keeping 
its center

Pressing CTRL 
and dragging a 
Resize handle

Scroll in any 
direction in the
picture pane

If you have a 3-
button mouse, 
pressing the 
middle button 
while moving the 
mouse that 
direction

Skew an object Holding down 
ALT and dragging
a side handle 
("D" below)

If you have an IntelliMouse™

To Try

Zoom in Rotating the 
wheel forward

Zoom out Rotating the 
wheel back

Scroll in any 
direction in the
picture pane

Holding down the
wheel while 
moving the 
mouse that 
direction



Keyboard shortcuts: Working in Microsoft Windows
To Press

Quit Picture It! 
or close a task 
pane

ALT+F4

Switch to another
program

ALT+TAB

Switch to the 
Microsoft 
Windows 
operating system 
Start menu

CTRL+ESC



Keyboard shortcuts: Choosing menus and commands
To Press

Highlight the 
menu bar

ALT or F10

After you have highlighted the menu bar, you can do the following:
To Press

Choose the menu 
or command with 
an underlined 
letter

The key for 
the underlined 
letter

Move between 
menus

è or ç

Move between 
commands on a 
menu

é or ê

Choose a 
highlighted menu 
or command

ENTER

Cancel the 
highlighted 
command

ESC

Open Help F1



Keyboard shortcuts: Moving and making choices in task panes
To Press

Move to the next 
option, text box, 
or list box

TAB

Move to the 
previous option

SHIFT+TAB

Move to an option
with an 
underlined letter

ALT+ the key 
for the 
underlined 
letter

Move to the first 
item or character
in a list or text 
box

HOME

Move to the last 
item or character
in a list or text 
box

END

Open or close a 
list box

F4

Move between 
items in a list box

é or ê

Choose or clear a 
check box

SPACEBAR

Extend the 
highlight in a text
box one 
character to the 
left or right

SHIFT+ç 
or 
SHIFT+è

Move the 
selected slider 
control left or 
right

ç or è

Extend the 
highlight to the 
last character in 
a text box

SHIFT+END

Extend the 
highlight to the 
first character in
a text box

SHIFT+
HOME

Close the dialog 
box or task pane 
and keep the 
changes you made

ENTER

Close the dialog 
box or task pane 
and not keep the 
changes you made

ESC or 
ALT+F4



Keyboard shortcuts: The basics
            Working in Microsoft Windows  
            Choosing menus and commands  
            Moving and making choices in task panes  



Keyboard shortcuts: Viewing and editing a picture
            Undoing and deleting  
            Nudging objects and text  
            Opening, saving, printing, and quitting Picture It!  



Keyboard shortcuts: Working with text
            Moving the insertion point in text  
            Highlighting text  
            Editing text  





Adding a shadow
What do you want to add the shadow to?
            The whole picture (“A” below)  
            Part of my picture (“B” below)  



Adding a shadow to a picture
1 On the Filmstrip, click the picture you want to add a shadow to.
            Where's the Filmstrip?  
2. On the Stack, click the background object. (This is usually the bottom picture in the stack.
            Where's the Stack?  
3 Drag one of the corner selection handles inward to shrink the picture so that the shadow 

effect will be visible,. 
            How?  
4 Click the Workbench tab.
5 Click Special Effects, and then click Shadow.
6 Follow the instructions in the task pane. 
Troubleshooting
            What if I can't see the shadow?  
            What if I change my mind?  
What do you want to do now?
            Change the color, transparency, or edges of the shadow  
            Change the size and position of the shadow  



Adding a shadow to an object in a picture
1 On the Stack, click the object you want to add a shadow to.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Shadow.
4 Follow the instructions in the task pane. 
Troubleshooting
            What if I can't see the shadow?  
            What if I change my mind?  
What do you want to do now?
            Change the color, transparency, or edges of the shadow  
            Change the size and position of the shadow  



What if I can't see the shadow?
There are two reasons why a shodow you added might not be visible in your picture.

If you add a shadow to an entire picture, an object that overlaps the edges of the picture, 
you'll need to resize the object in the picture pane before you can see it. 
            Resizing an object  
            Changing the size and position of a shadow  

If the color of the shadow is similar to the background, you'll need to change the shadow 
color. 

Change the color, transparency, or edges of the shadow



Changing the color, transparency, and edges of a shadow
1 On the Stack, click the picture or cutout with the shadow.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Shadow.
4 At the bottom of the task pane, click Customize the shadow, and follow the instructions in 

the task pane.



Changing the size and position of a shadow
1 On the Stack, click the picture or cutout with the shadow.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Shadow.
4 In the picture pane, drag the handles until you like the size and position of the shadow.
            How?  



Distorting an object
1 On the Stack, click the object you want to distort.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Distort.
4 Follow the instructions in the task pane. 
Troubleshooting
            What if I change my mind?  



Highlighting the edges of an object
1 On the Stack, click the object you want to add a highlighted edge to.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Highlighted Edges.
4 Follow the instructions in the task pane.
Related topics
            Stamping the edges of an object  
Troubleshooting
            What if I can't see the highlighted edge?  
            What if I change my mind?  



What if I can't see the highlighted edge?
If you highlighted the edge of a whole picture or a background, you might need to resize it in the
picture pane before you can see the special effect.
            Resizing an object  



Undoing a change
If you Then

Are still in 
the task 
pane

Click Cancel or 
Reset.

Have 
clicked 
Done, but 
made no 
other 
changes

On the Edit menu, 
click Undo.

Want to 
undo a 
single 
effect

Select the object 
that has the effect 
you want to undo, 
and then return to 
the task pane where 
you added the 
effect. Click the 
first picture in the 
Click the distortion 
you want list (no 
effect), and then 
click Done.
Note:    Some 
effects, such as 
Illusions, cannot be 
undone using this 
technique.

Want to 
start over

On the File menu, 
click Return to Last
Save.
-or-
On the File menu, 
click Close. When 
asked to save, click 
No. Now you can 
reopen your picture.
Caution: You will lose
whatever work 
you've done since 
the last time you 
saved.

Undoing a change
If you Then

Are still in 
the task 
pane

Click Cancel or 
Reset.

Have 
clicked 
Done, but 
made no 
other 
changes yet

On the Edit menu, 
click Undo.

Want to Select the object 



undo a 
single 
effect

that has the effect 
you want to undo, 
and then return to 
the task pane where 
you added the 
effect. Click the 
first picture in the 
Click the distortion 
you want list (no 
effect), and then 
click Done.
Note:    Some 
effects, such as 
Illusions, cannot be 
undone using this 
technique.

Want to 
start over

On the File menu, 
click Return to Last
Save.
-or-
On the File menu, 
click Close. When 
asked to save, click 
No. Now you can 
reopen your picture.
Caution: You will lose
whatever work 
you've done since 
the last time you 
saved.

Adding an illusion to a whole picture
1 Click the Workbench tab.
2 Click Special Effects, and then click Illusions.
3 Click the Whole Picture tab.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Adding an illusion to an object in a picture
1 On the Stack, click the object you want to add an illusion to.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Illusions.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Softening the edges of an object
1 On the Stack, click the object you want to change.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Soft Edges.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Making an object transparent
1 On the Stack, click the object you want to make transparent.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Make Transparent.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Blurring or sharpening focus
1 On the Stack, click the object you want to blur or sharpen.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Blur or Sharpen Focus.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Closing a project
On the Filmstrip, right-click the picture and then click Close.

--or--
On the File menu, click Close.

Tip: To close all the projects that are on the Filmstrip, click Close All on the File menu.



Quitting Picture It!
On the File menu, click Exit.

--or--
Click the small "x" in the upper-right corner of your screen.



Opening a picture of your own
1 Click the Workbench tab.
2 Click Get Picture, and then click My Picture.
3 Follow the instructions in the task pane.
Troubleshooting
            What if I don't see any pictures?  
            What if I can't find my picture?  
Tips
            Looking for a specific file format  
            Opening more than one picture at a time  
            Changing the default path to your pictures  
What do you want to do next?
            Fix imperfections  
            Add text  
            Move an object to another picture  



What if I can't find my picture?
What is the problem?
            I can't find my picture in the My Pictures Catalog  
            I can't find a picture in a different Catalog  
            My picture isn't in a Catalog  
Note:    Catalogs are part of Microsoft Media Manager, which is an optional part of Picture It!
            What is a Catalog?  
            Installing Microsoft Media Manager  



I can't find my picture in the My Pictures Catalog
1 Click the Workbench tab.
2 Click Get Picture, and then click My Picture.
3 At the bottom of the task pane, click Search for your picture.
4 In step 1, click or type one of the descriptive words you previously added to your picture.

-- or --
If you aren't using the cataloging features, type part of the file name for the picture that 
you're looking for.

5 If you want, limit the search by including date information.
6 Click Find.
7 If the picture you want is in the preview pane, double-click it to open it. Otherwise, follow 

the instructions in the task pane.



I can't find a picture in a different Catalog
1 Click the Workbench tab.
2 Click Get Picture, and then click My Picture.
3 In step 1, click the down arrow on the right of the Click a folder box, and then click the name

of the Catalog you want to look in.
Tip: All Catalogs have a suitcase icon in front of the name.

4 At the bottom of the task pane, click Search for your picture.
5 In step 1, click or type one of the descriptive words associated with the picture.
6 If you want, limit the search by including date information.
7 Click Find.
8 If the picture you want is in the preview pane, double-click it to open it. Otherwise, follow 

the instructions in the task pane.



My picture isn't in a Catalog
1 Click the Workbench tab.
2 Click Get Picture, and then click My Picture.
3 In step 1, click the arrow to the right of the Click a folder box, and then click the disk drive 

you want to look in.
Note: If you know the picture is on your computer but you don't know where, click Hard Disk
(c:\).

4 To limit the folders Picture It! searches, click the name of the first folder that you want to 
search.

5 Click Search for your picture.
6 Type the name of the file you're looking for, and then click Find.
7 If the picture you want is in the preview pane, double-click it to open it. Otherwise, follow 

the instructions in the task pane.
Note: If you have more than one drive, repeat this procedure, clicking the name of another 
drive in step 3.



I don't see any pictures
Here are some things to try if you don't see any pictures in the preview pane:

To look in a different disk drive or folder, click the drive letter and folder name you want 
from the list in step 1 of the My Picture task pane.

To start fresh and look in the default disk drive and folder location, click Cancel and then 
follow the procedure for opening a picture.
Remember: Picture It! only shows files that it can open in the picture pane.



Looking for a specific file format
To look for files with a specific file format extension (for example, .BMP), click the file format 
you want from the Display this type of picture list in step 1 on the My Picture task pane.



Opening more than one picture at a time
To open multiple pictures at once, hold down CTRL and click each picture you want. Then click 
Open, or drag them onto the Filmstrip.



Downloading a picture from a digital camera
1 Plug in and turn on your digital camera.
2 Click the Workbench tab.
3 Click Get Picture, and then click Digital Camera.
4 Follow the instructions in the task pane.
Troubleshooting
            Digital camera problems  
What do you want to do next?
            Change the picture's size or position  
            Fix imperfections  
            Add or change text  



Digital camera problems
What is the problem?
            I got a message that there was no camera installed  
            My digital camera doesn't show in the task pane  
            I can't connect my digital camera to my computer  
            My problem isn't listed here  



No Camera Installed error message
Some digital cameras save their pictures to removable storage devices such as floppy disks 

or PCMCIA cards. If you have one of these kinds of cameras, follow this procedure to open the 
pictures.

1 Click the Workbench tab.
2 Click Get Picture,and then click My Picture.
3 Select the drive that contains the storage device from your camera. Then select and open

the pictures you want.
Make sure your camera is turned on and properly connected to the computer. If any 

conections are loose, if the camera was off, or if the batteries are dead, correct the problem and 
then restart your computer. Also, verify that the TWAIN software that came with your camera for
downloading pictures was installed. Sometimes, cameras come with additional programs, such as 
other image editing programs.
Related topics
            General scanner and camera information  
            What scanners and digital cameras are documented to have problems working with Picture   

It!
            I still can't download  



Nothing happened when I downloaded
Make sure your camera:

Is plugged in securely to your computer.
Is turned on.
Contains fresh batteries.
Has pictures stored in its memory.



Opening a picture from the Picture It! CD-ROM
1 Click the Workbench tab.
2 Click Get Picture, and then click PictureArt Cutouts & Backgrounds.
3 Follow the instructions in the task pane.
Troubleshooting
            What if I can't find any PictureArt that fits my project?  
            What if I can't see any PictureArt?  
What do you want to do next?
            Change the color of the PictureArt  
            Add or change text  



What if I can't find any PictureArt that fits my project?
If you're having trouble finding PictureArt that you want for your project, you can:

Change the color or add a special effect to a PictureArt image that is close to what you 
want.

Use the Picture It! search feature to look for pictures.
Use the Picture It! Shop for Pictures feature for sources of stock photographs or cutouts.
Buy a collection of images on CD-ROM.

What do you want to do next?
            Shop for pictures  
            I can't find a picture in a different Catalog  
            Finding pictures on the World Wide Web  



What if I can't see any PictureArt?
Make sure the Picture It! CD-ROM is in the CD-ROM drive.



What's PictureArt?
The Picture It! CD-ROM contains hundreds of pictures to help you get started quickly. Some of 
them have already been cut out for you, and others were designed as backgrounds for your 
projects. Use both types of pictures alone, or combine them with your own pictures to make 
collages, greeting cards, invitations, calendars, and more.
            Copyrights for online photographs or digital art  



Scanning a picture
1 Click the Workbench tab.
2 Click Get Picture, and then click Scan Picture.
3 Follow the instructions in the task pane.
Troubleshooting
            Scanning problems  
Tips
            Tips for better scanning  
            What you should know about copyrights  
What do you want to do next?
            Change the picture size or position  
            Fix imperfections  



Tips for better scanning
Clean the scanner glass with household window cleaner. Make sure it is dry before you place 

your picture on the glass.
Dust your picture before placing it in the scanner. This could save some touchup later on.
If your picture is very light or very dark, try clearing the Correct Brightness and Contrast

check box in the task pane. This feature works best when there is a broad range of contrast in the 
picture.

If you are scanning a physical object, Custom Scan will give you the best results. Do not 
attempt to scan an object that is more than two inches high, as it will be difficult for the scanner 
to focus correctly on anything taller.



Scanning problems
What is the problem?
            Smart Task Scan does not work  
            The scan took a very long time  
            It scanned too much or too little of my picture  
            Picture It! tells me my picture is too large to scan  
            The colors are wrong in my scanned picture   
            I got a message there was no scanner installed  
            My version of TWAIN does not work with Picture It!  
            My problem is not listed here  



How can I check to see if the drivers for my scanner or camera are 
properly installed?
Try scanning with another software program, such as Microsoft Publisher. If you can scan with a 
different program, try reinstalling Picture It! If you still can't scan, try reinstalling your scanner
software.



The scan took a very long time
Scanning a large picture at high resolution takes time. If you're using Smart Task Scan, it takes 
twice as long, but can save you a lot of time later when you touch up your picture). If you think 
the process is taking too long, try scanning a smaller picture. As you scan, listen to find out 
whether your scanner makes three complete passes over your picture (six, if you're using the 
Smart Task Scan feature). If it does, there is probably nothing wrong. To reduce the scanning 
time, use Your scanner software instead of Smart Task Scan, and adjust the scanner settings 
on your own.
If you still have problems, check to see if the scanner manufacturer has released a newer driver.
If so, update your driver.
            Finding scanner and digital camera manufacturers on the Web  
Related topics
            General scanner and camera information  



I scanned too much or too little of my picture
If you're using the Smart Task Scan feature with a flatbed scanner, and the color of your 
scanner lid and your picture edges are the same, Picture It! was not able to correctly identify 
the edges of your picture.
Put your picture on the scanner bed, and cover the entire scanner bed (not just your picture) 
with fabric or paper of a different solid color.
If you still have problems, here are some other things to try:

Update your scanner driver to the latest version.
            Finding scanner and digital camera manufacturers on the Web  

Use Your scanner software instead of Smart Task Scan and manually select the area to 
scan.

Use the Crop task to trim away unwanted edges after you scan.
            How?  
Related topics
            General scanner and camera information  
            What scanners and digital cameras are documented to have problems working with Picture   

It!



The colors are wrong in my scanned picture
If you scanned your picture using the Correct Brightness and Contrast feature, try turning

it off and scan again. Or, if you didn't use the Correct Brightness and Contrast feature when you 
scanned, try scanning again and using it.

On the View Menu, click Options. Then click Scanner/Camera Options and select Normal.
Update your scanner driver to the latest version.

            Finding scanner and digital camera manufacturers on the Web  
Related topics
            General scanner and camera information  
            What scanners and digital cameras are documented to have problems working with Picture   

It!



No scanner installed error message
Make sure your scanner is properly connected to the computer and is on. If any conections are 
loose, or if the scanner was off, correct the problem and then restart your computer. Also, 
verify that the TWAIN software that came with your scanner for scanning pictures was 
installed. Sometimes, scanners come with additional programs, such as other image editing 
programs and character recognition programs.
Related topics
            General scanner and camera information  
            What scanners and digital cameras are documented to have problems working with Picture   

It!



I got a different error message
The scanning software probably doesn't support the TWAIN calls needed by Picture It! Call your
scanner manufacturer (or visit their World Wide Web page), and check for an updated version of
their scanning software.

What is the web address of my scanner or digital camera manufacturer?



My computer froze or crashed
If you are using Smart Task Scan, try using Custom Scan instead. Since some scanners do not 
support the TWAIN calls Picture It! needs for Smart Task Scan, you still may be able to 
successfully scan with Custom Scan.
If you're still experiencing problems, call your scanner manufacturer (or visit their Web page), 
and check for an updated version of their scanning software.



Removing dust or blemishes
1 On the Stack, click the object you want to fix.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Remove Dust & Blemish.
4 Follow the instructions in the task pane. 
Troubleshooting
            What if I change my mind?  
Tips
            Is it dust or a scratch?  



Zooming in or out
1 In the lower-right corner of the main window, find the Zoom And Scroll tool.
2 Click the Zoom In indicator ("A" below) for a closer look, or click the Zoom Out indicator 

("B") to see more of the picture.

After zooming, you'll notice that a box appears inside the Zoom And Scroll tool.
This outlines the part of your picture that appears in the picture pane. To quickly view a 
different part of your picture in the picture pane, click the spot in the small picture where you 
want the center of the box to be. The display in the picture pane will move accordingly.
Note: Zooming in or out does not affect the size of your printed picture.



Is it dust or a scratch?
If you don't know whether that mark on your picture is a scratch or a dust spot, don't worry. You
can experiment and see which tool produces the best results.
Take your best guess and try either Remove Scratch or Remove Dust & Blemish. Click Cancel at
the bottom of the task pane when you're ready to try the other tool.



Removing a scratch
1 On the Stack, click the object you want to repair.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Remove Scratch.
4 Zoom in for a closer look at the scratch.
            How?  
5 Follow the instructions in the task pane. 
Troubleshooting
            What if I change my mind?  
Tips
            Is it dust or a scratch?  



Using the Tint tool
You can use the Tint tool to increase or decrease the amount of a selected color in your picture.
1 On the ring, click the color you want to add or remove.
2 To increase the intensity of the color you selected, drag the slider to the right.

--or--
To decrease the intensity of the color you selected, drag the slider to the left.

Troubleshooting
            What if I change my mind?  



Changing brightness or contrast in an object in a picture
1 On the Stack, click the object you want to change.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Brightness & Contrast.
4 You can either
            Use the   Smart Task Fix   to adjust brightness or contrast automatically.  

--or--
            Make adjustments yourself with the Brightness & Contrast tool.  
Tip:    To change the brightness and contrast of a small area of your picture, try using Brightness 
and Contrast in Touchup Painting.
            How?  
Troubleshooting
            What if I change my mind?  



Changing brightness or contrast in the whole picture
1 Click the Workbench tab.
2 Click Touchup, and then click Brightness & Contrast.
3 If there are two tabs, click the Whole Picture tab.
4 You can either
            Use the   Smart Task Fix   to adjust brightness or contrast automatically.  

--or--
            Make adjustments yourself with the Brightness & Contrast tool.  
Troubleshooting
            What if I change my mind?  



Using the Smart Task Fix to adjust brightness or contrast 
automatically
At the top of the Brightness & Contrast task pane, click Smart Task Fix.
Picture It! will automatically adjust the brightness and contrast.
            What if I don't like the results?  
            How do I get to the   Brightness & Contrast   task pane?  



Using the Brightness & Contrast tool
To 
increase

Drag

Brightness The upper slider to the 
right.

Contrast The lower slider to the 
right.

Make someone a star
Here's a cropping idea that's guaranteed to make any kid's day: 
1 Get a picture of him, go to the Crop task, and use the star shape. 
2 Print the star with his smiling face in the middle.
            How do I crop a picture?  



Where's the Stack?
            Play movie: Stacking Picture It! objects  

The Stack runs along the right side of the screen. It displays all of the objects in a collage. 



Cropping the whole picture
If you want to crop a collage, make sure your project is finished first. Once it's cropped, you 
won't be able to modify the individual objects.
1 Click the Workbench tab.
2 Click Size & Position, and then click Crop.
3 If there are two tabs, click the Whole Picture tab.
4 Follow the instructions in the task pane. 
Note: The area inside the pink outline will remain in the picture; everything else will be cut out of
the picture.

Troubleshooting
            What if I change my mind?  
            Getting the print size you want  
Tips
            Make someone a star  



Cropping part of a picture
1 On the Stack, click the object you want to crop.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Size & Position, and then click Crop.
4 Follow the instructions in the task pane.
Note: The area inside the pink outline will remain in the picture; everything else will be cut out of
the picture.

Troubleshooting
            What if I change my mind?  
            Getting the print size you want  
Tips
            Make someone a star  



Correcting the tint in the whole picture
1 Click the Workbench tab.
2 Click Touchup, and then click Correct Tint.
3 If there are two tabs, click the Whole Picture tab.
4 You can either
            Use the   Smart Task Fix   to automatically fix the tint.  

--or--
            Make adjustments yourself with the Tint tool.  
Troubleshooting
            What if I change my mind?  



Correcting the tint in an object in a picture
1 On the Stack, click the object you want to change.
            I haven't yet cut out the object  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Correct Tint.
4 You can either
            Use the   Smart Task Fix   to automatically fix the tint.  

--or--
            Make adjustments yourself with the Tint tool.  
Tip:    To change the tint of a small area of your picture, try using Tint in Touchup Painting.
            How?  
Troubleshooting
            What if I change my mind?  



Using the Smart Task Fix to automatically fix the tint
With the Correct Tint task pane open, click something in your picture that should be white. 
Picture It! will automatically fix the tint.
            What if I don't like the results?  
            How do I get to the   Correct Tint   task pane?  



Repairing red eye
1 On the Stack, click the photo you want to touch up.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Fix Red Eye.
4 Follow the instructions in the task pane.
Troubleshooting
            What if I change my mind?  



Undoing red eye repair
If you Then

Are still in 
the task 
pane

Click Cancel or 
Reset.

Already 
clicked 
Done.

On the Edit menu, 
click Undo.

Removing something you don't want from your picture
If you want to remove part of the picture, such as an unwanted airplane in a natural skyline, try 
Clone Painting to paint over the airplane by cloning the sky. If you want to remove a spec of dust 
a scratch, , or a wrinkle from a solid colored background, try Remove Dust Blemish, Remove 
Scratch, or Remove Wrinkle...
Tips
            Cloning something out of the picture  
            Removing dust or spots  
            Removing a scratch  
            Keyboard shortcuts: Nudging objects  



Adding a Cool Edge
A Cool Edge cannot be added to text.
1 On the Stack, click the object you want to add a Cool Edge to.
            I haven't yet cut out the object I want to change.  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Cool Edges.
4 Follow the instructions in the task pane. 
Troubleshooting
            What if I want to remove the Cool Edge?  



Working with Cool Edges
What do you want to do? 
            Add a Cool Edge  
            Change its color  
            Move or resize a picture within a Cool Edge  



Changing the color of a Cool Edge
1 On the Stack, click the object with the Cool Edge.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Cool Edges.
4 Click the category and edge you previously added, and then follow the instructions in the task

pane. 



Moving or resizing the picture within a Cool Edge
1 On the Stack, click the object with the Cool Edge.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Cool Edges.
4 Click the category, edge, color, and edge size you previously added, and then follow the 

instructions in the task pane. 



Stretching a Cool Edge to fit the picture
1 On the Stack, click the object with the Cool Edge.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Edge Effects, and then click Cool Edges.
4 Click the category and edge you previously added. 
5 Click Stretch edge to fit picture at the bottom of step 2 in the Cool Edges task pane, and 

then follow the instructions in the task pane.



Adding a frame
1 Click the Projects tab.
2 Click Mats & Frames, and then click Simple Frame or Designer Frame.
3 Follow the instructions in the task pane. 
Note: If you also want a Cool Edge on your picture, you must add it before adding the frame.
Troubleshooting
            What if I want to remove the frame?  
What do you want to do now?
            Change the look of the frame  



Changing the look of a frame
1 On the Stack, click the frame you want to change.
            Where's the Stack?  
2 Click the Workbench tab, and then experiment with the options in Size & Position, Special 

Effects, Paint & Color Effects, and Edge Effects to get the look you want.
Troubleshooting
            What if I want to remove the frame?  



Adding a mat
1 Click the Projects tab.
2 Click Mats & Frames, and then click Simple Mat or Designer Mat.
3 Follow the instructions in the task pane.
Note: If you also want a Cool Edge on your picture, you must add it before adding a mat.
Troubleshooting
            What if I want to remove the mat?  
What do you want to do now?
            Change the look of the mat  



Changing the look of a mat
1 On the Stack, click the mat you want to change.
            Where's the Stack?  
2 Click the Workbench tab, and then experiment with the options in Size & Position, Special 

Effects, Paint & Color Effects, and Edge Effects to get the look you want.
Troubleshooting
            What if I want to remove the mat?  



Adding a new background to a picture
1 If the picture you want to use as a background is already on the Filmstrip, drag it onto the 

picture pane.
2 On the Stack, drag the picture you added to the bottom.
--or--
1 Click the Workbench tab.
2 Click Pictures & Cutouts, and then click Add Picture or Cutout.
3 Click PictureArt background or cutout.
4 Follow the directions in the task pane to choose the new background you want.
5 On the Stack, drag the picture you added to the bottom.
What do you want to do now?
            How do I move, rotate, or resize an object?  



Picture It! Help
What do you want to do?
            Open, scan, or download a picture  
            Fix imperfections  
            Combine pictures  
            Add or change text  
            Change something's size or position  
            Work with color  
            Add special effects  
            Add a mat, frame, edge, or background  
            Print, e-mail, or make a slide show  
            Save, send, and organize my pictures and projects  
            Use the keyboard and mouse to speed up my work  
            Learn about the Picture It! screen  
            Solve Problems  



Fixing imperfections
What do you want to do to your picture? 
            Repair red eye  
            Remove dust or blemish  
            Remove a scratch  
            Remove a wrinkle  
            Correct the tint or color  
            Change the brightness or contrast  
            Blur or sharpen focus  
            Touchup small areas by using the mouse as a paintbrush  
            Restoring an old or faded picture  
            Remove unwanted parts of the picture  
Tip: For fast repairs on scanned and downloaded photos, click Workbench, click Touchup, and 
then click Quick Touchup, which contains all the most frequently needed touchup tasks in one 
place.



Correcting the tint or color
What do you want to do? 
            My picture has a funny tint to it, and I want to fix it  
            I want to recolor an object in my picture  



Cropping or removing an object from a picture
What do you want to do? 
            Clone something out of my picture  
            Crop the edges of a picture  



Changing something's size or position
What do you want to do? 
            Resize it  
            Move it  
            Use alignment guides to arrange objects  
            Rotate it  
            Flip it  
            Stretch it  
            Skew it  
            Crop it to a different shape  



Moving an object 
Where do you want to move it? 
            To a different position in the current picture  
            In front of or behind another object  
            To another picture  



Moving an object to another picture
What do you want to move?
            The whole picture (everything that's in the Stack)  
            Part of the picture (a single object in the Stack)  



Flipping something
What do you want to flip?
            The whole picture  
            Part of it  



Rotating something
What do you want rotate?
            The whole picture  
            Part of it  



Working with color
What do you want to do? 
            Recolor something in my picture  
            Change a color picture to black and white  
            Fill an object with a gradient color  
            Fill an object with a solid color  
            Paint on my picture  
            Add a colored shape  
            Change the color of text  
            Correct the tint  
            Change the brightness or contrast  



Adding special effects
What do you want to do? 
            Add a shadow  
            Blur or sharpen the focus  
            Warp or distort an object  
            Hand-paint something  
            Make an object transparent  
            Soften or add effects to the edges  
            Fill an object with a color, gradient, or photo  
            Add an illusion  
            What are illusions?  



Adding effects to edges 
What do you want to do? 
            Soften the edges  
            Highlight the edges of an object  
            Stamp the edges of an object  
            Add other kinds of cool edges  



Adding an illusion
What do you want to add an illusion to?
            The whole picture  
            Part of it  



Adding or changing text
What do you want to do?
            Add text  
            Change the wording, font, alignment, or formatting of text  
            Change its color  
            Add special effects  
            Move, resize, flip, or rotate text  
            Remove text  



Adding text
What do you want to add? 
            Regular text  
            Painted text  



Adding special effects to text
            Play movie: Special text effects  
What do you want to do to the text? 
            Add a shadow  
            Bend it  
            Highlight its edges  
            Add some Jazzy Effects  
            Fill text with a color, gradient, or picture  
            See more special effects  



Moving, resizing, flipping, or rotating text
What do you want to do to the text? 
            Move it  
            Use alignment guides to arrange objects  
            Resize it  
            Stretch it  
            Skew it  
            Flip it  
            Rotate it  



Adding a mat, frame, edge, or background
What do you want to add? 
            A mat  
            A frame  
            An edge  
            A new background  



Printing, e-mailing, or making a slide show
What do you want to do? 
            Print my picture  
            Print picture thumbnails  
            What are picture thumbnails?  
            Send my picture through e-mail  
            Make an online slide show  
            What's an online slide show?  



Saving pictures
What do you want to do? 
            Save a picture  
            Save a picture to put on a Web page  
            Save it with a different name  
            Save it in a different location  
            Save it so I can use it in a different program  



Combining pictures
Although it's easiest to use one of the Picture It! wizards to combine pictures into collages or 
other combinations, you may want to take advantage of the speed and flexibility you get by doing 
it on your own. 
What do you want to do? 
            Use a wizard to combine pictures into projects  
            Combine pictures on my own  



Combining pictures on your own
First open the pictures you want to combine. If you want to use only parts of a picture, cut out 
the parts you want. Then combine pictures, cutouts, and text, and arrange them the way you want
them.
What do you want to do? 
            Open a picture  
            Cut out part of a picture  
            Move a picture or object to another picture  
            Add text  
            Add a new background to a picture  
            Use alignment guides to arrange objects  
            See some tips for making your pictures work together  



Opening a picture
What do you want to open? 
            One of my own pictures  
            A picture from the Picture It! CD-ROM  



Using a wizard to create projects
What do you want to create? 
            A collage  
            A card  
            An e-mail postcard  
            A calendar  
            Business materials  
            Other fun stuff  



Using a wizard to make a collage
What do you want to do?
            Make a collage using a template  
            Make a Photo Album Page  
            Design my own collage  
            Which should I choose?  



Changing the color of your picture
What do you want to do?
            Recolor the whole picture for a great special effect  
            Change the color of an object in the picture  
            Changing the color of a cutout by painting  
            Add color to a black and white picture  
            Change a color picture to black and white  



Correcting the tint
What do you want to correct?
            The whole picture  
            A single object  
            Correcting the tint in my picture by painting  



Changing the brightness or contrast
What do you want to change?
            The whole picture  
            A single object  
            Correcting brightness and contrast in a cutout by painting  



Cropping a picture
What do you want to crop?
            The whole picture  
            Part of it  



Adding edges
What kind of edge do you want to add? 
            A cool edge  
            A highlighted edge  
            A soft edge  
            A stamped edge  



Resizing objects
What do you want to do? 
            Resize it  
            Stretch it  
            Crop it to a different shape  
            Skew it  



Moving, flipping, or rotating something
What do you want to do? 
            Move it  
            Rotate it  
            Flip it  



E-mailing pictures
What do you want to do? 
            Send my picture through e-mail  
            Make an online slide show  
            What's an online slide show?  
            Send an e-mail postcard  



Making an object transparent
What do you want to do?
            Make an entire cutout transparent by using a special effect  
            Make part of a cutout transparent by painting  



Should I use PictureArt, one of my own pictures, or text?
Click If you want to add

A PictureArt
cutout or 
background

A picture from the 
collection on the 
Picture It! CD-ROM

A picture or 
cutout of 
your own

A picture you already 
have stored on your 
computer, want to 
scan in, or are ready 
to download from 
your digital camera

Text Your own words

Should I save as a slide show only, or also as HTML?
Click If you want to

A slide show 
only

See the slide show 
on your computer, or 
send it in an e-mail 
message. Your show 
will be saved in the 
Slide Shows folder.

Both a slide 
show and in 
HTML 
format

Post your slide show 
to a Web site on the 
Internet. Your show 
will be saved in the 
Slide Shows folder, 
and in its own folder 
as an HTML 
document.

What's a slide show?
A slide show is a group of pictures in a viewer that friends and family members can view at their 
own pace. The three things you can do with a slide show are:

View it. Once you've created and saved a slide show, you can view it any time you like. 
            How?  

Send it over e-mail. Recipients can view the show whether or not they have Picture It! 
installed on their computer, but they must be using either the Microsoft Windows 95 or 98, or NT 
Workstation 4.0 or later.
            How?  

Post it on the Internet. It can be viewed by anyone with a Web browser.
            How?  



What is a gradient?
A gradient is a gradual blend of shades, from one color to another, or within a single color.
You can choose one of the preset color patterns, or create your own by selecting the start and 
end colors of the gradient. You can also decide if you want the gradient to draw from left to 
right, top to bottom, diagonally, or radiate outward. Experiment with the different options until 
you get the effect you want.



Using the Color tool
            Play movie: Changing color  
To make adjustments with the Color tool, move the yellow and blue balls, either by dragging or by
clicking the spot on the circle where you want the ball to be.
To adjust Move

Hue The yellow ball 
around the outside 
circle.

Saturation The small blue ball 
around the inner 
circle.

Brightness The small blue ball 
into or away from 
the center of the 
circle.

You can fine-tune the hue ("A" below), color saturation ("B"), and brightness ("C") by clicking the 
arrows to the right of each box or by typing a number.

Note: The Color tool does not work on black, white, or gray. To use the Color tool on these colors, 
you need to add color first by using the Tint tool. 
            How?  



How do I paint by dragging in the picture pane?
Use your mouse to apply any combination of strokes for the effect you want. 
Click on the spot where you want to start, and drag to where you want to paint or stamp. If you 
only want a small dot of color, click where you want to place the color.



What does adjusting paint transparency do?
Paint transparency corresponds to how much of the background is visible underneath the paint 
you apply in your picture. The greater the transparency, the more "see through" the color 
appears.
To make your paint look more transparent, drag the slider to the right. To make it look less 
transparent, drag the slider to the left.



What does choosing a paper texture do?
Paper textures affect how the paint will look when it is applied to your picture. Experiment with 
different options and see what you like best!



How do I move or resize the cookie cutter shape?
            Play movie: Moving and resizing  
The area inside of the cookie cutter shape defines the area you want to cut out of the picture. 
To change which part of the picture you keep, move or resize the shape.

To You

Move the 
cookie cutter
shape

Click inside the 
selection box ("A" 
below) and drag it to 
a new position.

Resize the 
height and 
width 
proportionate
ly 

Drag any corner 
handle ("C" below) 
inward to reduce the
size, or outward to 
enlarge it.

Stretch 
either the 
height or 
width 

Drag any side handle 
("D" below) inward to
reduce the height or
width, or outward to 
enlarge it.

Tips
To more precisely position the cookie cutter shape, try:
            Keyboard shortcuts: Changing and nudging items  



How do I trace on my own?
Tracing is useful for pictures where there is little contrast between the background and the 
object you want to cut out, or if you want to cut out a simple shape that isn't available as a 
cookie cutter.
To trace an intricate or curved shape, click where you want to start and drag along the edges of 
the object you want. Don't worry about returning to the exact spot where you started; Picture 
It! will connect the starting and ending points for you. 
To cut out a simple polygon, click the starting point, each point where you want the line direction 
to change, and the ending point. Picture It! will connect the points for you.
If you aren't totally satisfied with the results, follow the instructions in the task pane to adjust 
the edge. 
Or try using the Edge Finder. Just cancel out of the task pane and start over again, this time 
clicking With the Edge Finder on the first task pane.
Tips
            How do I use the Edge Finder?  



How do I use the Edge Finder?
            Play movie: Making a cutout  
The Edge Finder is a great way to quickly and easily cut out part of a picture, especially when 
there is a high degree of contrast between the object you want to cut out and its background.
Zoom in on the area you want to cut out, so that you can see the edge more clearly. Then, click 
key points along the edge, making sure that the rectangle connecting the points encloses the 
edge of the object you want to cut out. The Edge Finder will automatically connect those points 
for you.    
To finish selecting the area, click the green flag. To adjust the edge, follow the instructions in 
the task pane.
If you aren't totally satisfied with the results, try tracing an area on your own. Click Cancel, and 
start over, this time clicking By tracing an area on my own in the first task pane.
Tips
            How do I trace on my own?  



Should I use PictureArt or one of my own pictures?
Click If you want to add

A PictureArt
cutout or 
background

A picture from the 
collection on the 
Picture It! CD-ROM

A picture or 
cutout of 
your own

A picture you already 
have stored on your 
computer, want to 
scan in, or are ready 
to download from 
your digital camera

Should I use the Edge Finder, trace on my own, select by color, or 
use a cookie cutter shape?
            Play movie: Making a cutout using the edge finder  

Click If you want

With the 
Edge Finder

To cut out an object 
having a high degree 
of contrast with its 
background

By tracing an
area on my 
own

To cut out a simple 
polygon shape, or an 
object having little 
contrast with its 
background

By color 
selection

To cut out an area 
that consists of 
similar colors

With a 
cookie cutter
shape

To cut out your 
picture in one of the 
shapes provided with
Picture It!

What's the Retriever?
When you click a picture on the Filmstrip, the Retriever appears. The Retriever previews what 
that picture would look like if you switched to it, and includes a "mini-Stack" showing all the 
objects in the picture.
To add a single object from the picture in the Retriever, drag the object from the Stack in the 
Retriever ("A" below) to the picture pane.
To replace, or "switch" the picture in the picture pane with the picture in the Retriever, click 
Switch to ("B" below).
To add the whole picture in the Retriever to the picture in the picture pane, click the button in 
the lower-right corner of the Retriever ("D" below).





Should I save my project as a finished or active collage?
A finished collage is smaller than an active collage. It is the electronic equivalent of permanently 
"gluing down" all the objects in your collage, and you will not be able to do things such as change 
the text later on.
Smaller files:

Require less storage space on your hard drive.
Print out faster.
Can be transmitted faster in an e-mail message.



What are picture thumbnails?
Picture thumbnails are small previews of your pictures. When you print many picture thumbnails 
on a single page, you create what is called a "contact sheet" in the world of photography. You can 
select as many pictures as you want from a folder on your computer, or select all your pictures on
the Filmstrip to print the thumbnails. You can use the picture thumbnails to:

Decide which picture to use in a project.
Organize your pictures.
Select pictures for enlargement.



How do I drag an object on the Stack?
            Play movie: Stacking Picture It! objects  
The higher up an object is in the Stack, the closer to the front it appears in the picture pane.
To move something forward, click it and drag it upwards in the Stack. To move it backward, click 
and drag it downward. 



How do I drag in the picture to distort?
You can distort your picture in two ways. Experiment and see which technique you prefer for 
each effect. You can either:

Click the point where you want the distortion to start, and then paint the effect by 
dragging along any path you choose.
–or–

Click continuously in one spot to exaggerate the distortion effect in that spot.



What are illusions?
Illusions are preset color, pattern, and texture effects that can be applied to your entire picture
or to part of a picture. Experiment with different illusions and see what you like best!



How do I adjust a shadow?
            Play movie: Moving and resizing  
As soon as you click the shadow effect you want, a selection box ("A" below) appears around the 
shadow in the picture pane. Then you can move or resize it, just as you would any other object in 
Picture It!

To You

Move the 
shadow

Click inside the 
selection box and 
drag it to a new 
position.

Resize its 
height and 
width 
proportion-
ately

Drag any corner 
handle ("C" below) 
inward to reduce its 
size, or outward to 
enlarge it.
Note: "Skewed" 
shadows can only be 
stretched 
horizontally, not 
resized.

Stretch 
either its 
height or 
width

Drag any side handle 
("D" below) inward to
reduce the height or
width, or outward to 
enlarge it.

Tips
To more precisely position the shadow, try:
            Keyboard shortcuts: Changing and nudging items  



How do I move or resize the fill picture?
            Play movie: Moving and resizing  
After you open the picture you want, it appears beneath the object you are filling it with. 
Although you won't be able to see the whole picture, the selection box ("A" below) shows you its 
location and size. You can then move or resize the picture to change which part of it fills in the 
object. 

To You

Move the fill 
picture

Click inside the 
selection box ("A" 
below) and drag it to 
a new position.

Resize its 
height and 
width 
proportion-
ately 

Drag any corner 
handle ("C" below) 
inward to reduce its 
size, or outward to 
enlarge it.

Stretch 
either its 
height or 
width 

Drag any side handle 
("D" below) inward to
reduce the height or
width, or outward to 
enlarge it.

Tips
To more precisely position the picture, try:
            Keyboard shortcuts: Changing and nudging items  



Should I use a solid color, a gradient, or picture fill?
Click If you want to fill 

the object with

Solid color A single color
Color 
gradient

A range of colors in 
a chosen pattern

Picture A picture or cutout 
of your own, or with 
PictureArt

How do I trace the eyes?
If you haven't already, zoom in on the eyes. Then click where you want to start tracing, and drag 
along the inside edges of the eye. Don't worry about returning to the exact spot you started; 
Picture It! will connect the starting and ending points for you. 
If you aren't totally satisfied with the results, follow the instructions in the task pane to adjust 
the edge.
Tips
            How do I zoom in to see more detail?  



How do I zoom in to see more detail?
Find the Zoom And Scroll tool in the lower-right corner of your screen. Click the Zoom In 
indicator ("A" below) as many times as necessary to get a good look at the object you want.

If you've zoomed to a part of the picture that doesn't include the object, use the Scroll tool 
("C" below) to go right where you want. Click the area you want to see, and the Scroll tool takes 
you there. 



What if the eye discoloration isn't red?
The term "red eye" refers to any discoloration in the picture caused by the flash reflecting off 
of the eye. In humans, this discoloration is usually red. In animals, it's often green.
Whatever the discoloration is, follow the same directions in the task pane.



Should I use the Edge Finder or trace on my own?
            Play movie: Making a cutout  

Click If you want

With the 
Edge Finder

To add or remove an 
area having a high 
degree of contrast 
with its background

By tracing an
area on my 
own

To add or remove a 
simple polygon shape,
or an area having 
little contrast with 
its background



Should I use "Smart Task Scan" or "Your scanner software"?
Click Smart Task Scan if you're using a flatbed scanner, and if:

You want Picture It! to automatically locate the edges of your picture.
You want Picture It! to select the best resolution.
Your picture is in good condition.

Click Your scanner software if:
You want to control the settings for resolution, picture region, brightness, contrast, and 

color adjustment.
Your picture is in poor condition and will require fine-tuning.



How do I scan with a flatbed scanner?
1 Lift the scanner lid.
2 Place the picture face down on the scanner glass.
3 Close the scanner lid.
Note: Your picture doesn't need to be even with the edge of the scanner. If you are using Smart
Task Scan, Picture It! will automatically straighten the picture. You can also rotate the picture 
in Picture It! after the scan is complete.



How do I scan with a sheet-fed or hand-held scanner?
Follow the detailed instructions provided by your scanner manufacturer.



How to describe your scanner to Picture It!
Click If your scanner

Flatbed 
scanner

Has a flat glass 
surface on which to 
lay the picture 
during scanning.

Other Is a sheet-fed, 
hand-held, or film 
scanner. If you're 
unsure, click this 
option.

Do you want Picture It! to adjust the level, size, and 
brightness/contrast after the scan is complete?
Click Yes if you want some help adjusting the straightness (level), crop size, or brightness and 
contrast of your picture as soon as the scan is complete.
Click No if you want to wait and make changes later in Picture It!



What's a Catalog?
The Catalog is a special folder that contains two things: your pictures and the descriptions that 
you add to each picture. The descriptions can include a person's name, a date, an event, or 
anything else that will help you classify a picture. 
Once your pictures have descriptions attached to them, you can find a specific picture by 
searching for words appearing in its description.
If you installed Microsoft Media Manager with Picture It!, two Catalogs are created: My 
Pictures, which is where you save your pictures, and Picture It! Content, which contains 
PictureArt backgrounds, cutouts, and templates.
You can create new folders within the My Pictures Catalog, and use them to group pictures with a
similar theme.
Note: The Catalog capabilities in Picture It! are provided by Media Manager, which is included 
with Picture It! as an installation option.
            Tell me more about Microsoft Media Manager  



Should I use Smart Task Download or Custom Download?
Click If you want to

Smart Task 
Download

Quickly and easily 
download your 
pictures.

Custom 
Download

Control the settings 
for deleting 
pictures, downloading
pictures, and 
changing camera 
settings.



How do I move, rotate, and resize an object?
            Play movie: Moving and resizing  
Although you may not be able to see your whole picture, the selection box ("A" below) shows you 
its location and size. You can then move or resize it to change which part of it shows.

To You

Move an 
object

Click inside the 
selection box ("A" 
below) and drag it to 
a new position.

Rotate an 
object

Drag the large green
ball ("B" below) to 
the right or left.

Resize the 
height and 
width 
proportionat
ely

Drag any corner 
handle ("C" below) 
inward to reduce the
size, or outward to 
enlarge it.

Stretch 
either the 
height or 
width

Drag any side handle 
("D" below) inward to
reduce the height or
width, or outward to 
enlarge it.

Skew an 
object

Finish any open task, 
press ALT, and then 
drag any side handle 
("D" below) 
horizontally or 
vertically.

Tips
To more precisely position an object, try:
            Keyboard shortcuts: Changing and nudging items  



Where's the Filmstrip?
The Filmstrip is located near the bottom of your screen, below the picture pane and to the right 
of the task pane. All the pictures you opened during the current session are shown on the 
Filmstrip.



Why is the card laid out this way?
All of the greeting card layout choices require one or two folds after printing to complete the 
card. 

If the card is
a

Then

Top-fold card Fold your card 
once in half from 
top to bottom.

Side-fold card Fold your card 
once in half from 
left to right.

Three-panel 
card

Fold your card in 
thirds from left 
to right.

Four-panel 
card

Fold your card in 
half from top to 
bottom, and then 
again from left to 
right.

How do I use the Brightness & Contrast tool? 
To increase Click or drag

Brightness The brightness 
slider to the right

Contrast The contrast slider 
to the right

What if I have a black and white picture?
            Play movie: Correcting color tint  
If you want to add color to a black and white photograph, use the Tint tool rather than the Color 
tool. You can add tint to the entire picture, or cut out portions of your picture and add a 
different color to each one.
Related topics
            Correcting the tint  



What if there's no white in my picture?
Try zooming in to see if you can find a white spot in your picture.
On the Zoom tool located in the lower-right corner of your screen, click the Zoom In indicator 
("A" below). Move the Scroll box ("C" below) until it is over a part of your picture that contains 
some light areas, and click a white spot in the picture.
If you still can't see any white spots, click on a gray area instead. If you don't like the Smart 
Task Fix result, click Reset and then use the Tint tool to adjust the colors in your picture 
yourself.



How do I use the Tint tool?
The Tint tool increases or decreases the level of a selected color in your picture.
On the ring, click the color you want to add or remove. If you want to increase the amount of the
color you selected, drag the slider to the right. If you want to decrease the amount of the color 
you selected, drag the slider to the left.



What's color management?
Color management is a Microsoft Windows operating system feature that helps your printer 
match the colors that appear on your screen.
If you don't like the results, click in the Use Color Management box to uncheck it, and try 
printing again.
If the Use Color Management check box is grayed, don't worry about it. Some printers don't 
support the type of color management that Picture It! uses, and some don't support it at all.



Is it better to remove each dust spot, or dust the entire picture?
In most cases, your finished picture will look best if you remove each dust spot individually. It's 
more accurate to click on the precise spot where the dust is located, and remove only that one 
imperfection.
If you have too many spots on your picture, you can dust the entire picture. The drawback to this
method is that your picture may look blurry because some of the picture's detail has been 
removed.



What if I don't like the scratch or wrinkle removal results?
If you Then

Are still in 
the task 
pane and 
want to undo
the last 
repair

In the task pane, 
click Undo last 
action.

Are still in 
the task 
pane and 
want to 
restore the 
picture to 
the way it 
was before 
you started 
this task

Click Cancel or 
Reset.

Have clicked
Done, but 
made no 
other 
changes yet

On the Edit menu, 
click Undo.

Want to 
start over

On the File menu, 
click Return to Last
Save.
-or-
On the File menu, 
click Close. When 
asked to save, click 
No. Now you can 
reopen your picture.
Caution: You will lose
whatever work 
you've done since 
the last time you 
saved.

What if I don't like the spot or blemish removal result?
If you Then

Are still in 
the task 
pane and 
want to undo
the last spot
repaired

In the task pane, 
click Undo last 
action.
Note:    This is only 
available if you are 
removing dust or 
spots one at a time.

Are still in 
the task 
pane and 
want to 
restore the 
picture to 
the way it 
was before 

Click Cancel or 
Reset.



you started 
this task
Have clicked
Done, but 
made no 
other 
changes yet

On the Edit menu, 
click Undo.

Want to 
start over

On the File menu, 
click Return to Last
Save.
-or-
On the File menu, 
click Close. When 
asked to save, click 
No. Now you can 
reopen your picture.
Caution: You will lose
whatever work 
you've done since 
the last time you 
saved.

How do I repair a scratch in my picture?
If you haven't already, zoom in on the area you want to repair.
On the Zoom tool located in the lower-right corner of your screen, click the Zoom In indicator 
("A" below). Then move the Scroll box ("C" below) until it is over an area of your picture that 
contains the scratch.
To begin the repair, center the mouse pointer over one end of the scratch. Click points along the 
scratch, making sure that the repair box completely covers the scratch.
To start repairing a new scratch, click the green flag. When you have finished repairing all the 
scratches on your picture, click Done.
Note: If you're having trouble removing the entire scratch in one operation, click a larger ball. 
The scratch repair box should be only a little wider than the scratch itself.



How do I change the position of the object?
            Play movie: Moving and resizing  
            Play movie: Stacking Picture It! objects  

To You

Move an 
object

Click inside the 
selection box ("A" 
below) and drag it to 
a new position.

Resize the 
height and 
width 
proportionate
ly

Drag any corner 
handle ("C" below) 
inward to reduce the 
size, or outward to 
enlarge it.

Resize an 
object and 
retain the 
same center 
point

Press CTRL, and drag 
any corner handle ("C"
below) inward to 
reduce the size, or 
outward to enlarge it.

Stretch 
either the 
height or 
width

Drag any side handle 
("D" below) inward to 
reduce the height or 
width, or outward to 
enlarge it.

Rotate an 
object

Drag the large green 
ball ("B" below) 
clockwise or 
counterclockwise.

Skew an 
object

Press ALT, and drag 
any center handle.

Move an 
object in 
front of 
another

On the Stack, drag 
the object up to the 
one you want to put it
in front of.

Move an 
object behind
another

On the Stack, drag 
the object down to 
the one you want to 
put it behind.

Tips
            Use alignment guides to arrange your collages  
            Keyboard shortcuts: Changing and nudging items  
Related topics
            Where's the Stack?  



Why can't I see all my folders?
Only folders in the My Pictures Catalog are shown here. 
To organize pictures located somewhere else, you must first add them to the Catalog. To add 
pictures to the Catalog, click Add Pictures under step 2 in the first Organize Pictures task 
pane, and follow the instructions.    
If you want to find a picture that hasn't yet been added to the Catalog, on the Workbench tab, 
click Get Picture, and then click My Picture. Click the arrow to the right of the Click a folder 
box, and then click the drive that you think contains your picture. At the bottom of the task 
pane, click Search for your picture, and follow the instructions.



Which folder should I put my pictures in?
Unless you choose otherwise, when you add pictures to the Catalog, they will be stored in the My 
Pictures Catalog. 
You may want to create other folders within My Pictures so that you can organize your pictures 
by date, subject, location, or some other category.

To add your pictures to an existing folder, click the folder name in the list.
--or--

To make a new folder, click Create a new folder and follow the instructions in the task 
pane.



Adding pictures to the Catalog
The first step in adding pictures to the Catalog is to specify the current location of the pictures 
you want to add. If you don't see the folder containing your pictures in the list, you may have to 
search on another drive. Or perhaps Picture It! doesn't recognize the file format of the picture 
you are looking for.
To find a picture on another drive, click the arrow to the right of the Click a folder box, and 
then click the drive containing your picture. 
To see a list of the file types Picture It! will open, click the arrow to the right of the Display 
this picture type box.
            What's a Catalog?  



Which pictures do you want to add to the Catalog?
On the preview pane to the right, click each picture you want to add to the Catalog. To add all 
the pictures in the preview pane, click Select all pictures. 
If you change your mind, click Put the last selection back to remove pictures one by one in the 
order you added them. 



How should I add my pictures to the Catalog?
Click If you want to

Smart Task
choice

Copy pictures to the 
Catalog. If your 
picture is on a 
removable disk, 
Picture It! creates a 
shortcut to it 
instead.

Move 
pictures

Transfer a picture 
to the Catalog.
CAUTION: The 
picture will be 
deleted from its 
original location.

Copy 
pictures

Add a copy of the 
picture to the 
Catalog. The original 
picture remains in 
the place you copied 
it from.

Create 
shortcuts

Leave the picture in 
its original location, 
but store 
information about it 
in the Catalog.
Note: Make sure you
do not change the 
names of folders or 
files that have 
shortcuts associated
with them. If you do,
their shortcuts 
won't work.

Adding descriptions and dates to pictures and folders
You can add or change descriptions and dates for a single picture, several pictures at once, or a 
folder.
Here are some tips:

To add or change the description or date for more than one picture at the same time, hold 
down CTRL and click each picture you want. The description and date information you type will apply 
to all of the selected pictures. Any existing information will be replaced.

If you change only the date, your description will remain unchanged. If you change only the 
description, the date will remain unchanged.

If you misspell a word and have a dictionary (such as the one that comes with Microsoft 
Word) installed on your computer, Picture It! will try to correct it for you. If it cannot recognize 
the word you want, a red, wavy line will appear underneath it. 

If you date your pictures, you can search for all pictures taken within a specified time 
frame.



Describing and dating a folder
The descriptions and dates you type in now will allow you to search through the Catalog later.
When you create a new folder, type a description that applies to all the pictures you plan to 
store there. This description will be used as the folder name.
If you want, you may also add a date. If all the pictures you plan to put in the folder weren't 
taken on the same day, you can record the month and year, or just the year.



Help finding pictures
You can look for your pictures within Picture It! by using Find Pictures.
If you installed Microsoft Media Manager with Picture It!
To locate a picture using its description, you can click words in the box at the top of the task 
pane. If you'd rather type than scroll through the list, under Type in the descriptive words, 
type a word you may have used to describe the picture.
To search using a date, under Type in a date, or range of dates, type a specific date, a range 
of dates, or a portion of a date (such as the year).
If you did not install Microsoft Media Manager
You can search for your pictures by their file names. To find pictures that have common words in
their file names, you can include wildcards in your searches:

Use * (asterisk) to represent any character or characters in the position where you put the 
asterisk. For example, typing REDCA*.MIX might find the files REDCAR.MIX, REDCAB.MIX and 
REDCABLE.MIX.

Use ? (question mark) to represent any single character in the position where you put the 
question mark. For example, typing REDCA?.MIX might find the files REDCAR.MIX, and 
REDCAB.MIX.
Related Topics
            What is Microsoft Media Manager?  



What are related pictures?
Related pictures have descriptions that contain words that are similar to the search words you 
specified.
For example, if you typed "child" as part of your search, Picture It! will also look in the 
descriptions for words like "children," "son," and "daughter."
If you type a search word that doesn't match any pictures in the Catalog, Picture It! 
automatically looks for pictures with similar descriptive words.



I didn't find the pictures I wanted
If you didn't find the picture you were looking for, try:
If you installed Microsoft Media Manager with Picture It!

Extending the date range you specified.
Checking the spelling of the search words you typed.
Using more general search words.
Try looking in other folders.

            What if I still can't find my picture?  
If you did not install Microsoft Media Manager with Picture It!

Try extending your search using wildcards.
Try looking in other folders. 

Related Topics
            What is Microsoft Media Manager?  



I didn't find the pictures I wanted
If you didn't find the picture you were looking for, try:

Checking the spelling of the file name you typed.
Using only a portion of the file name.
Try looking for it in other folders.

            What if I can't find my picture?  



Hints on finding pictures
Type any portion of the file name. If you type "dog," for example, Picture It! will find "dog.mix," 
"Mary reciting doggerel.jpg," and "Jake and his dogs.gif."
Make sure you are looking in the disk drive where your pictures are located. 



Should I move or copy my pictures?
Click If you want to

Move pictures or
folders

Transfer a picture 
or folder to 
another folder. 
CAUTION: The 
picture will be 
deleted from its 
original location.

Copy pictures or 
folders

Add a copy of your
picture or folder 
to another folder, 
and leave it in the 
original location.

What should I name the folder?
When you create a new folder, type a description that applies to all the pictures you plan to 
store there. This description, which is used as the folder name, must be unique.



Why should I add descriptions to my pictures?
By adding descriptions to your pictures now, you'll be able to find them later, even after you've 
accumulated many different folders and pictures in a Catalog.



What does deleting my pictures do?
When you delete pictures from your My Pictures Catalog, they are permanently removed and 
cannot be recovered in the future. If you choose to delete an entire folder, everything in it will 
be removed, including any subfolders that it contains.
If you might need the pictures or folders later on, copy them to a floppy disk, Zip disk, writable 
CD, or another external storage device before you delete them.



New command (File menu)
Starts a new project.



Open command (File menu)
Opens or finds a picture and displays it in the picture pane.



Close command (File menu)
Closes the picture displayed in the picture pane. 



Close All command (File menu)
Closes all open pictures.



Save command (File menu)
Saves the picture in the picture pane with its existing name, location, and file format.



Save As command (File menu)
Saves the picture in the picture pane with the file name, location, and format you specify. 



Save All command (File menu)
Saves all open pictures (all pictures displayed on the Filmstrip).



Return to Last Save command (File menu)
Undoes any changes you've made to a picture since last saving.



Scan Picture command (File menu)
Scans a picture into Picture It!



Digital Camera command (File menu)
Loads a digital camera picture into Picture It!



Print command (File menu)
Prints the picture displayed in the picture pane.



Send command (File menu)
Sends a picture or slide show through e-mail.



File list (File menu)
Lists the most recently opened files.



Exit command (File menu)
Closes Picture It!



Undo command (Edit menu)
Reverses or deletes your last action.



Redo command (Edit menu)
Reinstates your last action. This is only available after you have used the Undo command.



Cut command (Edit menu)
Removes selected pictures or words from their location on the picture pane.



Copy command (Edit menu)
Copies selected pictures or words on the picture pane.



Paste command (Edit menu)
Places an item that you have cut or copied onto the picture pane.



Delete command (Edit menu)
Deletes the selected object. 



Select All command (Edit menu)
Selects an entire picture or collage.



Stack command (View menu)
Displays or hides the Stack.



Object Handles command (View menu)
Displays or hides the object handles and the rotate lever.



Microsoft Picture It! Help Topics command (Help menu)
Displays the online Help contents screen.



Show Index command (Help menu)
Displays the online Help index screen.



Introduction To Picture It! command (Help menu)
Launches an introductory demonstration of Picture It! features.



About Microsoft Picture It! command (Help menu)
Displays the version number of Picture It!, copyright information, and your copy's serial number.



Picture pane
In Picture It! the picture pane displays your picture or collage. It's where you do most of your 
work.
If the picture is too big to fit in the picture pane, either change its size with the Zoom tool or 
scroll the picture up and down and side to side.



Preview pane
The preview pane shows either thumbnail pictures or file names of the pictures in the current 
location. 
To work with a picture, click and drag the thumbnail or file name to the Filmstrip, or double-click 
it. The picture will appear on the Filmstrip.



Text command (Edit menu)
Edits the selected text.



Picture Object command (Edit menu)
Edits the selected picture.



Move Forward Or Backward command (Edit menu)
Opens a task pane to change an object's place on the Stack.



Menu Previews command (View menu)
Displays or hides previews for the buttons on the Workbench and Project tabs.



Display Settings command (View menu)
Opens the Microsoft Windows operating system Display Properties dialog box to the Settings 
tab.



Stack
            Play movie: Stacking Picture It! objects  
The Stack displays all of the objects in a collage.
The higher up an object is in the Stack, the closer to the front it appears in the picture pane.
To move something forward, click it and drag it upward in the Stack. To move it backward, click 
and drag it downwards.



Zoom And Scroll tool
Click the Zoom In indicator ("A" below) as many times as necessary to get a good look at the 
object you want. 
If you've zoomed to a part of the picture that doesn't include the object, use the Scroll tool 
("C") to go right where you want. Click the area you want to see, and the Scroll tool takes you 
there.



Filmstrip
This is where all your open pictures are displayed.

To display a picture that is on the Filmstrip, double-click it and it appears in the picture 
pane.

To add a picture on the Filmstrip to the picture that's currently displayed in the picture 
pane, drag it from the Filmstrip to the picture pane.

To add an object from a picture on the Filmstrip, single-click the picture in the Filmstrip. 
The Retriever will appear, which you can use to add any object that's been cut out of that picture.
            How?  



Microsoft Picture It! Home Page
Connects you to the Picture It! Home Page on the World Wide Web.



Microsoft Home Page
Connects you to the Microsoft Home Page on the World Wide Web.



Display Settings dialog box
Optimum settings to run Picture It! are 16-bit color, and at least 800 by 600 pixels. 
Warning: After changing settings you may need to restart your computer. You should save your 
work and close any other programs before doing so.
To change your settings:
1 If the Microsoft Windows operating system Properties dialog box is not already open, right 

click on the desktop and click Properties. Then click the Settings tab.
2 In the Color palette box, click High Color (16 bit) or higher.
3 In the Desktop area box, move the slider to at least 800 by 600 pixels.
4 Click Apply, and then OK. If necessary, follow the directions for restarting your computer. 



Export Options dialog box
Convert to lists the available color options. Some options (for example, True Color) take up hard 
disk space.
Compression type lists the available compression options for saving hard disk space.
Compression level sets the desired level, either by dragging the slider or typing in the box.
Export size lists available sizes for your picture.
Custom size allows you to define your own size by typing numbers in the Width and Height boxes.
Maintain aspect ratio keeps the original proportions of your picture as you adjust the size.



Options
Use this dialog box to change Picture It! settings. 
Settings with a check mark are turned on. Click them if you want to turn them off.
Show Introduction displays the Introduction to Picture It! that you see the first time you run 
Picture It!
Play Picture It! sounds turns on sounds for various mouse and keyboard actions.
Show Tool Tips displays small labels over screen controls when you hold the pointer over them.
Show alert to change screen settings displays an alert message if your screen resolution 
settings are not optimized for Picture It! The alert message gives you the option of automatically
changing the settings.
Path to my pictures is the place Picture It! looks first when you choose the My Picture command
from the Get Picture button. You can enter any location in this box.
Note: If you choose a directory other than My Pictures, Picture It! will prompt you to convert 
the new directory to a catalog folder. Converting the directory to a catalog folder enables the 
features in the Organize Pictures task pane, and requires that you have Media Manager installed.
You can still change the path to your pictures without converting the directory to a catalog 
folder.
Browse displays the contents of your computer's hard drive. From here you can select the path 
to your pictures.
Require CTRL to zoom with Microsoft IntelliMouse changes the wheel action of the Microsoft 
IntelliMouse. When this box is unchecked, rolling the wheel zooms in or out of a picture. When 
checked, rolling the wheel scrolls up or down, and rolling the wheel while holding down the CTRL 
key zooms in or out.
If you do not have the Microsoft IntelliMouse installed, this option does not appear.
Advanced options displays another dialog box with options for picture resolution and 
compression.
Scanner/Camera options displays another dialog box with options controlling scanner and digital 
camera performance.



Advanced Options
Use this dialog box to change resolution and compression settings for Picture It!
Settings with a check mark are turned on. Click them if you want to turn them off.
Note:    In addition to taking up disk space, settings which result in a larger file size ( for 
example, high resolution, low compression) may also make your pictures difficult to send over the 
Internet or via e-mail.
Resolution determines the visual quality of the picture you are working on.
Professional is the highest quality but uses the most disk space. Photographic is in the middle, 
and Computer Display is the lowest quality but uses less disk space.
Compression determines the quality of the picture being saved.
Higher compression results in lower quality but saves disk space, and lower (or no) compression 
offers higher quality but uses more disk space.



Scanner/Camera Options
Use this dialog box to control the performance settings of your scanner and digital camera.
Use Standard mode to import my photos Standard mode is the basic setting for scanners and 
digital cameras. Select this if you experience problems with your camera or scanner when 
downloading.
Use Enhanced mode to import my photos Enhanced mode takes advantage of advanced methods 
of using your computer's memory to download faster and reduce the burden on your computer. 
However, some devices might cause Picture It!, your scanner or camera, or even your computer to
freeze. Try using Enhanced mode first, and if you have troubles, switch to Standard mode.



Opening a picture created by a different program
1 Click the Workbench tab.
2 Click Get Picture, and then click My Picture.
3 In step 1, make sure All Picture Files is visible in the Display this type of picture box. If it 

is not, click the arrow on the right of the Display this type of picture box, and then click 
the file format you want from the list.
Note: If you still can't see your picture in the preview pane, then Picture It! cannot open 
that file type. Start the program that was used to create the picture, open it, and save the 
picture again in a file format Picture It! can open, such as .BMP.

4 Follow the remaining instructions in the task pane, and then click Open.



Switching to another open picture
On the Filmstrip, double-click the picture you want to view in the picture pane.



Setting your picture size and orientation
1 In step 1, if you want your picture to be taller than it is wide, click Portrait. click Landscape 

if you want it to be wider than it is tall.
2 In step 2, click the proportions you want for your picture. If you want your picture to fill as 

much of the page as possible when printed, click Fit to Page . For a picture with standard 
dimensions, such as standard print size or business card, choose the appropriate dimensions 
from the list. If you want to create a picture with you own specified dimensions, click Custom
Size, and click to set the size you want in the Height and Width boxes.



Removing a date stamp
Use the Remove Scratch task to quickly and easily remove those irritating date stamps from 
your pictures. 
Center the pointer over the start of the date, drag the box over the entire date, and then click 
to remove it.
            Removing a scratch  



Technical support
If you need more help, go to the Technical Support help topic. 
1 Click the Help menu, and then click About Microsoft Picture It!
2 Click the Tech Support button. You will see information on how to get more help.

Note: You might need to move or resize this Help window to see the button.



Saving a picture
1 Click the Workbench tab.
2 Click Save & Send, and then click Save.
Troubleshooting
            Saving problems  
Tips
            How can I organize my pictures?  
            Which file format should I use?  
            When should I use Save options?  



Saving a picture with a new name
Saving a picture with a new name creates a copy of the picture.
1 Click the Workbench tab.
2 Click Save & Send, and then click Save As.
3 In step 3, type a new name for your picture.
4 Click Save.
Troubleshooting
            Saving problems  
Tips
            How can I organize my pictures?  
            Which file format should I use?  
            When should I use Save options?  



Saving a picture in a different place
1 Click the Workbench tab.
2 Click Save & Send, and then click Save As.
3 In step 1, click the arrow on the right of the Click a folder box, and click a disk drive from 

the list. Then click a folder from the list.
4 Click Save.
Troubleshooting
            Saving problems  
Tips
            How can I organize my pictures?  
            What file format should I use?  
            When should I use Save options?  



Saving a picture for use in a different program
1 Click the Workbench tab.
2 Click Save & Send, and then click Save As.
3 In step 2, click the arrow on the right of the Save as this type box, and then click the file 

format you want from the list.
4 Click Save.
Troubleshooting
            Saving problems  
Tips
            Which file format should I use?  
            How can I organize my pictures?  
            When should I use Save options?  



Saving problems
What is the problem?
            My computer's out of storage space  
            I saw a No Write Access message  
            I saw a Device Not Available message  



My computer's out of storage space
If you see a message that says something like "Not enough disk space," you can try:

Saving your picture to a different disk drive, such as a floppy, a second hard drive, or a 
removable Zip drive. In step 1 of the Save As task pane, click the arrow on the right of the Click a 
folder box, and then click the drive you want. Click a folder from the list, and then click Save.

Note: A floppy disk may not have enough space to hold a picture that contains a large number
of objects.

Deleting any unnecessary files on your disk drive, and then saving your picture again. A good 
place to check for unnecessary files is the Temp folder in your Win95 folder.

Emptying the Recycle Bin on your desktop, and then saving your picture again.



I saw a No Write Access message
If you get a message that says something like “Cannot write to the disk," the device is probably 
write-protected. If you're saving to a:

Floppy disk, take it out of the drive. Turn it over and push the write-protection slider 
towards the middle of the disk.

Zip disk, use the Zip utility to remove the write protection.



I saw a Device Not Available message
If you get a message that says something like “Device not available," it could be that:

There's no disk in your floppy or Zip drive. Insert a disk, and try saving again.
The device is turned off or has been disconnected from your computer. Turn it on, or 

reconnect the device.



Which file format should I use?
If you are planning on using your picture in a program other than Picture It!, you'll probably need 
to save it in a file format other than .MIX.
You can save your pictures in any of the file formats listed in the table below. The most common 
programs or uses for each file format are also listed to help you decide the format you want.

File 
extension

File 
format

Programs/ 
Common uses

.bmp Windows 
bitmap

Microsoft 
Paint. Often 
used for 
desktop 
backgrounds.

.fpx Flashpix Some newer 
imaging 
applications. 
Found on 
high-quality 
photo CD-
ROMs, and 
very similar 
to the 
Picture 
It! .MIX 
format.

.jpg JPEG 
(Joint 
Photo-      
graphic 
Expert 
Group)

Very 
common, 
compressed 
file format 
that works 
well for 
photos. 
Because 
these files 
are quite 
small, use for
e-mail or 
posting to 
Web sites.

.png Portable 
Network 
Graphics

Supported by
newer 
imaging 
applications. 
Works well 
for photos, 
clip art, and 
sending in e-
mail.

.tif Tagged 
Image File
Format

Supported by
most imaging 
applications. 
Used for 
some clip art 
CD-ROMs.

.gif Graphics 
Inter-      
change 
Format

Palettized 
images, often
dithered, 
best used for
clip art and 



“solid” images
rather than 
for photos. 

.pcx PC 
Paintbrus
h

Older 
graphics file 
format.

.tga Targa Older 
graphics file 
format.

When should I use Save options?
If you are saving your picture with a file format other than .MIX or .FPX, you can click Options 
on the Save As task pane to specify any of the following settings:

Use To

Convert to Change to a 
different color 
option.

Export Size Select from a list of 
proportional image 
sizes (in pixels). The 
higher the numbers, 
the greater the size.
If you're printing, 
use high numbers. If 
you're sending in e-
mail or size is a 
problem, use smaller 
numbers.

Compression
type

Select a compression
type.

Custom size Specify the exact 
image dimensions (in 
pixels).

Width & 
Height

Specify the image 
height and width (in 
pixels).

Maintain 
aspect ratio

Maintain the original 
proportions of the 
image. If unchecked,
you can change the 
height and width 
separately to 
stretch or squash 
the picture.

Compression
level

Increase or 
decrease the degree 
of image 
compression. 
Increasing the 
compression level 
reduces the image 
quality as well as the 
file size.

Closing a picture



On the Filmstrip, right-click the picture, and then click Close.
--or--

On the File menu, click Close.



Saving a picture as wallpaper
When you save the current picture as wallpaper, its size and color depth are optimized for your 
current display settings.
1 Click the Workbench tab.
2 Click Save & Send, and then click Save As Wallpaper.
3 Follow the instructions in the task pane. 



Organizing pictures
Use this task to add, find, move, copy, or delete pictures in a Catalog, and add or change the 
descriptions of the pictures in your My Pictures Catalog.
1 Click the Workbench tab.
2 Click Get Picture, and then click Organize Pictures.
3 Follow the instructions in the task pane. 
Tips
            Tell me more about organizing my pictures  
            What's a Catalog?  
Related topics
            Creating a new folder in the Catalog  



Creating a new folder in the Catalog
You can only add a new folder to your My Pictures Catalog when you're adding, moving, or copying
pictures to the Catalog.
1 Click the Workbench tab.
2 Click Get Picture, and then click Organize Pictures.
3 Click Add pictures.
4 Follow the instructions in the task pane.
5 After you click Next twice, in step 3 click Create a new folder.
6 Follow the instructions in the task pane to create a new folder, and complete the task. 
--or--
1 Click the Workbench tab.
2 Click Get Picture, and then click Organize Pictures.
3 Click Move or copy pictures.
4 Follow the instructions in the task pane.
5 After you click Next, in step 3 click Create a new folder.
6 Follow the instructions in the task pane to create a new folder, and complete the task. 
Tips
            Tell me more about organizing my pictures  
            What's a Catalog?  



Tell me more about organizing my pictures
When you organize your pictures in Picture It!, you can:

Move or copy pictures or folders to another folder in your Catalog.
Create a link in a folder to pictures stored in a different folder.
Look for pictures in your Catalog by description, key word, or date.
Change or add descriptions to pictures or folders in your Catalog.
Remove from your Catalog pictures or folders you no longer need.

Related topics
            What's a Catalog?  
            Organizing pictures  
            Creating a new folder in the Catalog  



Changing the file format of a picture
The standard file format for Picture It! is a .MIX file, but you can easily change a picture to a 
different file format.
1 Click the Workbench tab.
2 Click Save & Send, and then click Save As.
3 Follow the instructions in the task pane. In the Save as this type box, click the file format 

you want.
4 If necessary, click Options to change the file's default characteristics, such as its 

dimensions, compression, and data type.
Tips
            Which file format should I use?  



Printing picture thumbnails
Picture thumbnails are small previews of the pictures you select. As many thumbnails as possible 
are printed on the same page.
1 Click the Workbench tab.
2 Click Print, and then click Print Picture Thumbnails. 
3 Follow the instructions in the task pane.
Tips
            Why should I keep the thumbnails open?  



Why should I keep the thumbnails open?
If you want to save or make changes to your picture thumbnails after they are printed, click Yes,
keep it open in step 7 of the Print Picture Thumbnails task pane. If you only want a printout, 
click No, close it.



Making an online slide show
A slide show is a group of pictures in a viewer that friends and family members can view on their 
computer. 
1 Click the Projects tab.
2 Click Active E-mail, and then click Slide Show.
3 Follow the instructions in the task pane.
Tips
            Changing the sequence of my pictures in a slide show  
            Getting my slide show ready for the World Wide Web  
            How do I send a slide show?  



Getting my slide show ready for the World Wide Web
If you want to post your slide show to the World Wide Web, you first have to save it as an 
HTML file. In step 5 in the Slide Show task pane, make sure you click Both a slide show and in 
HTML format. Picture It! will create a folder using the name you assign to the slide show. The 
new folder will be in the "For E-Mailing from Picture It!\Slide Shows" folder on your computer. 
In the new slide show folder, you'll find several files. You need these files to display the slide 
show properly on a Web page. You can move the files in your slide show folder to a different 
location, but keep them together in the same folder, and don't change the file names. 
The first page of your slide show is named 0.HTM. To start an HTML slide show, open this file in 
your Web browser.
If you want to link your slide show to an existing Web page, you might need to edit some of the 
files yourself. If you don't know how to edit HTML files, most bookstores carry a wide selection 
of books on this subject.
Contact your Web service provider for instructions on posting the slide show files to a server.



How do I send a slide show?
To send a slide show from within Picture It!, your computer needs to use an e-mail program that 
supports MAPI (Messaging Application Programming Interface). Check your e-mail program 
documentation to see if it supports MAPI. The recipient's computer needs to have Microsoft 
Windows 95 or 98 or NT Workstation 4.0 or later, and any e-mail program capable of receiving 
messages with attachments.
            What if my e-mail program does not support MAPI?  
1 Click the Projects tab.
2 Click Active E-mail, and then click Slide Show.
3 Follow the steps for creating the slide show. When you get to step 5, click A slide show only.
4 In step 1 of the Save As task pane, click the folder on your hard disk where you want to 

store your slide show. In step 3, type a name for your slide show. Then click Save. 
5 Click Send it via e-mail.
6 In step 1 of the Save As task pane, click the folder on your hard disk where you want to 

store your slideshow. Then, in step 3, type a name for your slide show.
7 Click Save.

Your e-mail program starts and creates a message that contains the file for your slide show 
and instructions for viewing.

8 Send the message as you would any other e-mail message.
Tips
            Changing the sequence of my pictures in a slide show  



Sending my picture through e-mail
To send pictures through e-mail, both the sender and the recipient must use an e-mail program 
that is capable of sending and receiving attachments, and have a program that can open JPEG 
files installed on their computer, such as Microsoft Internet Explorer. 
To send a picture from within Picture It!, your computer must use an e-mail program that 
supports the Messaging Application Programming Interface (MAPI) . Check your e-mail program 
documentation to see if it supports MAPI.
1 Click the Workbench tab.
2 Click Save & Send, and then click Send via E-mail.

An e-mail message with your picture file attached appears on your screen.
3 Use your e-mail system to send the picture.
Troubleshooting
            What if my e-mail program does not support MAPI?  



Printing more than one picture on a page
You can repeat the same picture several times on a page, or choose different pictures to print 
together.
1 Make sure that all the pictures you want to print are open on the Filmstrip.
            How do I open a picture?  
2 Click the Workbench tab.
3 Click Print, and then click Print Reprints.
4 Follow the instructions in the task pane.
Troubleshooting
            I don't like the way Picture It! sized my picture  



I don't like the way Picture It! resized my picture
The template openings in Print Reprints are standard photographic sizes. If you drag a picture 
that is not a standard size onto the template, Picture It! will resize it to fit the opening.
To correct this, crop your picture to the size the template uses.
Note: If you choose a template with two different size openings, crop your pictures to one of 
the sizes. Picture It! will size your picture correctly in both places.
Related topics
            Cropping to a specific proportion  
            What size should I make my picture?  



Cropping to a specific proportion
1 Click the Workbench tab.
2 Click Size & Position, and then click Crop.
3 Click Enter exact proportions for the shape.
4 Click to find the dimension you want in the width and height boxes..
5 Drag and resize the opening so that the part of the picture you want to keep appears inside 

it.
6 Click Done.
            What size should I make my picture?  



What size should I make my picture?
For the best results when you print reprints, make sure the pictures you use have already been 
cropped to the standard photographic proportions for the template you select. The following 
table gives the correct dimensions for the various templates.

Template
Width 
(inches)

Height 
(inches)

Two Medium
Frameables 
(Horizontal)

6 4

Two Small 
Frameables 
(Horizontal)

5 3.5

Avery Kids 
#3611 
Postcards 
(Horizontal)

5.75 3.75

Avery 
#3263 
White Post 
Card 
(Horizontal)

4.25 3

Six Wallets 
(Horizontal)

3.5 2.5

One Large 
Frameable &
Two Wallets
(Horizontal)

7
3.5

5
2.5

Two Medium
Frameables 
(Vertical)

4 6

Two Small 
Frameables 
(Vertical)

3.5 5

Avery Kids 
#3611 
Postcards 
(Vertical)

3.75 5.75

Avery 
#3263 
White Post 
Card 
(Vertical)

3 4.25

Six Wallets 
(Vertical)

2.5 3.5

One Large 
Frameable &
Two Wallets
(Vertical)

5
2.5

7
3.5

            Cropping to a specific proportion  
            Printing more than one picture on a page  



Tips for printing on your black-and-white laser printer
If your printouts are darker than you expect, and the white areas look gray, you can try changing
your printer's dithering method. This option may not be available on all printers.
1 Click the Microsoft Windows Start button.
2 Click Settings, and then click Printers.
3 Right-click the icon for your printer, and then click Properties.
4 Click the Graphics tab.
5 In the Dithering box, click Coarse.
6 Click OK.
Note: You may have to restart Microsoft Windows for the change to take effect.
For further information and other technical issues, see the Readme file.



Printing the current picture
1 Click the Workbench tab.
2 Click Print, and then click Print This Picture.
3 Follow the instructions in the task pane.
Troubleshooting
            Printing problems  
Tips
            Getting the print size you want  
            Improving your print quality  



Getting the print size you want
In step 4 of the Print This Picture task pane, choose the dimensions for your printout.

To Click

Print your 
picture as 
large as 
possible on the
page

Fit to Page.

Print your 
picture in a 
standard 
photographic 
size

The arrow to the 
right of the Click 
a print size box, 
and then click the 
size you want.

Print your 
picture with 
the dimensions
you want

The arrow to the 
right of the Click 
a print size box, 
click Custom Size,
and then type the 
height and width 
you want.

Keep the same
relative shape 
of your 
picture

After choosing 
Custom Size, type
in one of the 
dimensions you 
want and click 
Maintain 
proportions.

Improving your print quality
To get the best quality printouts, make sure the right conditions exist for the pictures you want 
to print:

Make sure you download quality pictures. If you are using a scanner, scan at the highest 
practical resolution available (150-200 ppi usually works well). For the best picture, use Smart Task
Scan, or, refer to your scanner's documentation for advice on selecting the best resolution. 

For digital cameras, select the highest quality photography setting for the camera. You may 
not be able to take as many pictures at one time, but the ones you do take will look a lot better 
when printed.

Some printers have a feature called color matching that helps correct for differences 
between onscreen display and printouts. If your printer supports color matching, use it. Sometimes 
the colors you see onscreen do not match those you see when printed.

Use the best print quality settings. Picture It! offers up to three different settings in Step
5 of the Print task: Good, Better, and Best. Remember, the better your picture looks, the longer it 
takes to print.

Reduce the print size. If you want to use the Best print quality settings but that option is 
not available in step 5 of the Print task, consider reducing the dimensions of your picture. By 
reducing the size, Picture It! can use the data in your image more effectively for printing.

Use good paper. As a rule, pictures do not print well on standard laser printer paper. That's 
because of the way the ink is absorbed and dried on the paper. Get paper designed for color or 
photographic printing so your colors are more vibrant. If you have trouble finding the paper you 
need at your computer store, try going to a camera store.





Printing problems
What is the problem?
            Nothing happened when I printed  
            I wanted my picture on a different size paper  
            I don't like the way Picture It! resized my pictures when I printed reprints  
            My computer displayed a general protection fault, invalid page fault, or exception error   

message



Nothing happened when I printed
Make sure:

Your printer is plugged into a power source.
Your printer is turned on.
Your printer is securely connected to your computer.
The correct printer driver for your printer was installed. Try printing from another 

program to verify.



I wanted my picture on a different size paper
In step 1 of the Print This Picture task pane, click Change printer settings, and then click the 
paper size you want.



My computer displayed a general protection fault, invalid page 
fault, or exception error message

Try printing from another program to see if you can print anything.
Try printing the same picture from another paint program, such as Microsoft Paint.
If another printer is available, try printing the same picture to it.
Print a different picture to the same printer.
Check to see if there is an update to the driver for your printer.
If a new driver isn't available, remove the existing printer driver and reinstall it.



Adding text
1 Click the Workbench tab.
2 Click Text, and then click Add Text.
3 Follow the instructions in the task pane. 
Tip: Press ENTER on your keyboard while typing text to insert a carriage return while adding text.
Troubleshooting
            What if I want to remove the text?  
What do you want to do next?
            Fill text with color, gradient, or picture  
            Bend text  
            Add a shadow  
            Highlight text edges  



Removing text
If you Then
Are still in the Add 
Text task pane and 
want to start over

Click Cancel or 
Reset.

Are still in the Add 
Text task pane and 
just want to remove
a few letters

In step 1 of the 
task pane, place 
your pointer to the
right of the 
letters you want to
remove, and then 
press BACKSPACE 
on your keyboard.

Have made other 
changes to your 
project since adding
the paint

On the Stack, click
the painting you 
want to remove, 
and then press 
DELETE.

Chan
ging 
text 
color

            
Play 
movie: 
Special 
text 
effects

1 On 
the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
cha
nge
.

            
Where's 
the 
Stack?

2

Clic

File 
format

Compatible 
programs



k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Te
xt,
and
the
n 
clic
k 
Te
xt 
Col
or 
or 
Fill
.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Chan
ging 



text
            
Play 
movie: 
Special 
text 
effects

1 On 
the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
cha
nge
.

            
Where's 
the 
Stack?

2

Clic
k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Te
xt,
and
the
n 
clic
k 
Edi



t 
Te
xt.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e 
to 
cha
nge
the
wor
din
g, 
fon
t, 
alig
nm
ent
, 
for
ma
ttin
g, 
or 
col
or 
of 
you
r 
tex
t.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Movi



ng 
an 
obje
ct

            
Play 
movie: 
Moving 
and 
resizing

1 On 
the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
mo
ve.

            
Where's 
the 
Stack?

2 In 
the
pic
tur
e 
pan
e, 
dra
g 
the
obj
ect
unt
il 
you
like
the
new
pos
itio
n.



            
How?

Resi
zing 
an 
obje
ct

            
Play 
movie: 
Moving 
and 
resizing

1 On 
the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
res
ize.

            
Where's 
the 
Stack?

2 In 
the
pic
tur
e 
pan
e, 
dra
g 
one
of 
the
cor
ner
sel
ect
ion 
han



dle
s 
("C
" 
bel
ow)
inw
ard
or 
out
war
d.

Stre
tchin
g an 
obje
ct
1 On 

the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
str
etc
h.

            
Where's 
the 
Stack?

2 In 
the
pic
tur
e 
pan
e, 
dra
g 
the
sid
e 
sel
ect



ion 
han
dle
s 
("D
" 
bel
ow)
out
war
d 
unt
il 
you
like
the
sha
pe.

Flipp
ing a
pict
ure
1

Clic
k 
the
Wo
rkb
enc
h 
tab
.

2

Clic
k 
Siz
e &
Pos
itio
n, 
and
the
n 
clic
k 
Flip
.

3 If 
the
re 



are
two
tab
s, 
clic
k 
the
Wh
ole
Pic
tur
e 
tab
.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Flipp
ing 
an 
obje
ct in 
a 
pict
ure
1 On 

the
Sta
ck, 
clic
k 



the
obj
ect
you
wan
t 
to 
flip
.

            I   
haven't 
yet cut 
out the 
object I 
want to 
change

            
Where's 
the 
Stack?

2

Clic
k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Siz
e &
Pos
itio
n, 
and
the
n 
clic
k 
Flip
.

4

Foll



ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Rota
ting 
a 
pict
ure

            
Play 
movie: 
Moving 
and 
resizing

1

Clic
k 
the
Wo
rkb
enc
h 
tab
.

2

Clic
k 
Siz
e &
Pos
itio



n, 
and
the
n 
clic
k 
Rot
ate
.

3 If 
the
re 
are
two
tab
s, 
clic
k 
the
Wh
ole
Pic
tur
e 
tab
.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Tips
            
Rotating 
the quick 
way
Trou
blesh
ootin
g

            



What if I
change 
my mind?

Rota
ting 
an 
obje
ct in 
a 
pict
ure

            
Play 
movie: 
Moving 
and 
resizing

1 On 
the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
rot
ate
.

            I   
haven't 
yet cut 
out the 
object I 
want to 
change

            
Where's 
the 
Stack?

2

Clic
k 
the



Wo
rkb
enc
h 
tab
.

3

Clic
k 
Siz
e &
Pos
itio
n, 
and
the
n 
clic
k 
Rot
ate
.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Tips
            
Rotating 
the quick 
way
Trou
blesh
ootin
g

            
What if I
change 



my mind?

Movi
ng 
an 
obje
ct 
forw
ard 
or 
back
ward

            
Play 
movie: 
Stacking 
Picture 
It! 
objects
The 
higher 
up an 
object 
is in 
the 
Stack, 
the 
closer 
to the 
front 
it 
appear
s in 
the 
picture
pane.

To move 
an object
forward, 
click and 
drag it 
upward in
the 
Stack. To
move it 
backward
, click 
and drag 
it 



downward
in the 
Stack. 

            
Where's 
the 
Stack?

Movi
ng 
an 
obje
ct to
anot
her 
pict
ure
1

Ma
ke 
sur
e 
tha
t 
bot
h 
the
pic
tur
es 
you
're 
wor
kin
g 
wit
h 
are
ope
n 
on 
the
Fil
mst
rip.

            
How do I 
open a 
picture?

2 On 



the
Fil
mst
rip,
dou
ble
-
clic
k 
the
pic
tur
e 
to 
whi
ch 
you
wan
t 
to 
add
the
obj
ect
.

3 On 
the
Fil
mst
rip,
sin
gle
-
clic
k 
the
pic
tur
e 
con
tai
nin
g 
the
obj
ect
you
wan
t 
to 
add
.
Th



e 
Ret
rie
ver
app
ear
s 
on 
you
r 
scr
een
. It
has
its 
own
Sta
ck, 
whi
ch 
sho
ws 
all 
the
obj
ect
s in
the
pic
tur
e.

4

Dra
g 
the
obj
ect
you
wan
t 
to 
mo
ve 
fro
m 
the
Sta
ck 
in 
the
Ret
rie
ver



to 
the
pic
tur
e 
pan
e.

Tips
            
Use 
Alignmen
t Guides 
to 
arrange 
objects

Movi
ng 
the 
whol
e 
pict
ure 
to 
anot
her 
pict
ure
1

Ma
ke 
sur
e 
tha
t 
bot
h 
pic
tur
es 
are
ope
n 
on 
the
Fil
mst
rip.

            
How do I 



open a 
picture?

2 On 
the
Fil
mst
rip,
dou
ble
-
clic
k 
the
pic
tur
e 
to 
whi
ch 
you
wan
t 
to 
add
the
obj
ect
.

3

Dra
g 
the
pic
tur
e 
you
wan
t 
to 
add
fro
m 
the
Fil
mst
rip 
to 
the
pic
tur
e 
dis



pla
yed
in 
the
pic
tur
e 
pan
e.

Fillin
g 
text 
with 
a 
color
, 
grad
ient,
or a 
pict
ure

            
Play 
movie: 
Special 
text 
effects
1 On 

the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
fill.

            
Where's 
the 
Stack?

2

Clic
k 
the



Wo
rkb
enc
h 
tab
.

3

Clic
k 
Te
xt,
and
the
n 
clic
k 
Te
xt 
Col
or 
or 
Fill
.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Ben
ding 
text

            



Play 
movie: 
Special 
text 
effects

1 On 
the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
ben
d.

            
Where's 
the 
Stack?

2

Clic
k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Te
xt,
and
the
n 
clic
k 
Ben
d 
Te
xt.

4



Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

High
light
ing 
the 
edge
s of 
text

            
Play 
movie: 
Special 
text 
effects

1 On 
the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
hig
hlig



ht.

            
Where's 
the 
Stack?

2

Clic
k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Edg
e 
Eff
ect
s, 
and
the
n 
clic
k 
Hig
hlig
hte
d 
Edg
es.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.



Trou
blesh
ootin
g

            
What if I
change 
my mind?

Addi
ng a 
Jazz
y 
Effec
t to 
text

            
Play 
movie: 
Special 
text 
effects

1 On 
the
Sta
ck, 
clic
k 
the
tex
t 
you
wan
t 
to 
add
a 
Jaz
zy 
Eff
ect
to.

            
Where's 
the 
Stack?

2

Clic
k 



the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Te
xt,
and
the
n 
clic
k 
Ja
zzy
Eff
ect
s.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

Trou
blesh
ootin
g

            
What if I
change 
my mind?

Rota
ting 
the 
quic
k 



way
            
Play 
movie: 
Moving 
and 
resizing

1 On 
the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
rot
ate
.

            
Where's 
the 
Stack?

2 In 
the
pic
tur
e 
pan
e, 
dra
g 
the
rot
ate
han
dle 
("B
" 
bel
ow)
clo
ckw
ise 
or 
cou
nte



rcl
ock
wis
e.

A 
mediu
m 
border
.
A 
narrow
border
.
A one-
page 
calend
ar for 
the 
month.
A one-
page 
calend
ar that
shows 
three 
consec
utive 
months
.
A one-
page 
calend
ar for 
the 
year.
A 
selecti
on of 
prepar
ed 
phrase
s for 
your 
edge.
A 
selecti
on of 
design
er 
edges.



A 
selecti
on of 
textur
ed 
edges.
A 
selecti
on of 
traditi
onal 
looks 
for 
your 
edge.
A 
Smart 
Task 
that 
automa
tes the
proces
sClick 
a white
area in
your 
picture
to 
remove
a color
cast.
A tool 
that 
helps 
you 
trace 
the 
object.
A tool 
that 
helps 
you 
edit 
the 
cutout.
A wide
border
.
Additi
onal 
options
for 



changi
ng 
text 
appear
ance.    
Adds a
new 
dimens
ion of 
illusion
.
Adds a
picture
that's 
stored 
on your
comput
er, 
scanne
d, or 
downlo
aded 
from a 
digital 
camera
.
Adds a
picture
to My 
Picture
s, from
your 
comput
er, a 
networ
k, a 
disk, 
or a 
CD-
ROM.
Adds 
anothe
r 
object 
to the 
collage
.
Adds 
new 
picture
s to 
the 
slide 



show.
Adds 
text.
Adds 
the 
entire 
picture
that 
you 
selecte
d.
Adds 
the 
object 
that 
you 
selecte
d on 
the 
Stack.
Aligns 
text 
along 
the 
left 
edge.
Aligns 
text 
along 
the 
right 
edge.
Allows 
you to 
decide 
how to 
add 
new 
images
to your
Catalo
g.
Any 
descri
ptive 
name 
or 
phrase
for 
your 
picture
file.



Any 
descri
ptive 
name 
or 
phrase
for 
your 
picture
file.
Any 
descri
ptive 
word 
or 
phrase.
Picture
It! will 
attach 
the 
approp
riate 
extens
ion 
(for 
exampl
e, 
*.MIX,
*.GIF, 
or 
*.JPG).
Applies
a color
filter.  
Applies
decora
tive 
effect
s.    
Applies
distort
ion 
automa
tically. 
Applies
the 
selecte
d level 
of 
edge 
softne
ss to 
your 



cutout.
Attach
es your
finishe
d work
to an 
e-mail 
messag
e.
Autom
atically
remove
s red 
eye 
(eye 
discolo
ration 
in a 
photo 
caused
by a 
camera
's 
flash).
Catego
ries of
ready-
to-use 
collage
s or 
backgr
ounds.
Catego
ries of
ready-
to-use 
frame 
patter
ns.
Catego
ries of
ready-
to-use 
mat 
textur
es.
Center
s text.
Change
s an 
existin
g slide 



show.
Change
s the 
hue 
(color) 
by 
moving
the 
ball 
from 0
to 359
degree
s 
around
the 
ring.
Change
s 
setting
s for 
saving 
the 
picture
file. 
The 
setting
s 
availab
le 
depend
on the 
file 
type 
that 
you 
select.
Change
s 
setting
s for 
the 
selecte
d 
printer
(refer 
to your
printer
docum
entatio
n).
Change
s the 
descri



ption 
of a 
picture
or 
folder.
Additi
onal 
control
s for 
fine-
tuning 
your 
color 
selecti
on.
Change
s the 
frame'
s color,
satura
tion 
(color 
purity)
, and 
bright
ness.
Change
s the 
mat's 
color, 
satura
tion 
(color 
purity)
, and 
bright
ness.
Change
s the 
rotatio
n angle
in 
small 
increm
ents.
Change
s the 
rotatio
n to 
the 
angle 
you 
type in



the 
box 
below.
Additi
onal 
control
s for 
fine-
tuning 
your 
color 
selecti
on.
Change
s the 
wheel 
action 
of the 
Micros
oft 
Intelli
Mouse.
When 
this 
box is 
unchec
ked, 
rolling 
the 
wheel 
zooms 
into or 
out of 
a 
picture
. When
checke
d, 
rolling 
the 
wheel 
scrolls 
up or 
down, 
and 
rolling 
the 
wheel 
while 
holding
down 
the 
CTRL 
key 



zooms 
in or 
out.
Check 
this 
box to 
display
a Help 
topic 
that 
sugges
ts 
what 
to do 
after 
you 
have 
placed 
everyt
hing on
the 
collage
. 
Check 
this 
box to 
have 
Picture
It! try 
to find
the 
edges 
of the 
area 
you 
are 
tracing
.
Choose

a 
siz
e 
for
you
r 
sav
ed 
pic
tur
e.

On the
left 
palette



, click 
a color
you 
want 
to use. 
The 
color 
appear
s in 
the 
large 
center 
square.
On the
right 
palette
, you 
can 
click a 
differ
ent 
shade 
of that
color.
On the
left 
palette
, click 
a 
finish 
color. 
The 
color 
appear
s in 
the 
large 
center 
square.
On the
right 
palette
, you 
can 
click a 
differ
ent 
shade 
of that
color.
On the
left 
palette
, click 



a start
color. 
The 
color 
appear
s in 
the 
large 
center 
square.
On the
right 
palette
, you 
can 
click a 
differ
ent 
shade 
of that
color. 
Click 
any 
words 
that 
may be
associa
ted 
with 
your 
picture
file.
Click 
any 
words 
that 
may be
associa
ted 
with 
your 
picture
file.
Click 
the 
green 
flag to
begin 
fixing 
anothe
r 
scratc
h.



Click 
the 
object 
that 
you 
want 
to 
place 
on the 
picture
pane.
Click 
this 
after 
you 
have 
selecte
d the 
object 
on the 
Stack 
that 
you 
want 
to 
move 
forwar
d.
Click 
this 
after 
you 
have 
selecte
d the 
object 
on the 
Stack 
that 
you 
want 
to 
move 
backwa
rd.
Click 
for 
more 
inform
ation.
Click 

for
mo



re 
inf
or
ma
tio
n.

Click 
to 
adjust 
the 
size or
shape 
of your
cutout.
Click 
to 
narrow
the 
scope 
of your
search
after 
you 
have 
clicked
More.
Click 
to 
create 
a new 
folder 
for 
your 
picture
files. 
This 
new 
folder 
will be 
a 
subfol
der of 
the 
folder 
selecte
d 
above.
Click 
to 
display
a Help 
topic 
that 



provid
es 
inform
ation 
about 
the 
task.
Click 
to 
enter a
descri
ption 
for 
the 
saved 
picture
file.
Click 
to 
hear 
the 
sound 
you 
have 
selecte
d.
Click 
to 
broade
n your 
search
by 
using 
descri
ptive 
words 
that 
are 
relate
d to 
your 
initial 
entry. 
Click 
again 
to 
keep 
expand
ing 
your 
search.
Closes 
the 



About 
dialog 
box.
Closes 
the 
dialog 
box 
and 
cancels
any 
change
s you 
have 
made.
Closes 
the 
dialog 
box 
and 
saves 
the 
new 
options
.
Saves 
your 
picture
as a 
file of 
the 
selecte
d type.
Moves 
the 
entire 
picture
to the 
front 
of the 
collage
.
Copies 
picture
files 
from 
their 
source 
locatio
n to 
anothe
r 
locatio
n in 



your 
Catalo
g. The 
picture
files 
then 
exist 
both in
the 
origina
l 
locatio
n and 
the 
destin
ation 
locatio
n.
Copies 
the 
selecte
d 
object 
and 
moves 
it to 
the 
front 
of the 
collage
.
Copyri
ghts 
and 
credits
.
Create
s a 
cutout 
in a 
standa
rd 
shape 
to 
replac
e the 
picture
.
Create
s a 
cutout 
in a 
standa



rd 
shape.
Create
s a 
greetin
g card 
that is 
folded 
along 
the 
top. 
Click 
this 
option 
to see 
a 
previe
w.Crea
tes a 
greetin
g card 
that is 
folded 
along 
the 
side. 
Click 
this 
option 
to see 
a 
previe
w.
Create
s a link
betwee
n the 
origina
l 
source 
file 
and 
your 
Catalo
g 
picture
file. 
You 
can 
view 
the 
picture
file in 
your 



Catalo
g, but 
it 
remain
s in its
origina
l 
locatio
n.
Create
s a 
mirror 
image 
of the 
object 
that 
you 
starte
d with 
(the 
left 
becom
es the 
right).
Create
s a new
folder.
Create
s a 
shortc
ut 
button 
on your
deskto
p that 
you 
can 
click 
to view
the 
slide 
show.
Create
s an 
upside-
down 
image 
of the 
object 
that 
you 
starte
d with 



(the 
top 
becom
es the 
bottom
).
Custom
izes 
the 
width 
of the 
Edge 
Finder.
Allows 
you to 
add 
differ
ent 
types 
of 
shadow
s to 
the 
text.
Delete
s 
object
s from 
the 
collage
.
Deter
mines 
the 
best 
values 
for 
the 
light 
and 
dark 
areas 
(contra
st) and
for 
the 
picture
's 
overall 
bright
ness.
Display
s the 



full 
text 
of the 
softwa
re 
license
agreem
ent, 
with a 
Print 
option.
Display
s a 
messag
e when
the 
screen 
setting
is:

Less than
24-bit 
colors.

Less than
800 x 
600 
screen 
resolutio
n.
Display
s in 
the 
previe
w pane 
miniatu
re 
version
s of 
the 
picture
s.
Display
s only 
the 
file 
names 
of the 
picture
s in 
the 



curren
t 
direct
ory in 
the 
previe
w pane.
Display
s the 
initial 
startu
p 
screen,
which 
you 
see 
the 
first 
time 
you run
Picture
It!
Display
s the 
names 
of 
screen 
elemen
ts 
when 
the 
pointer
pauses 
over 
them.
Display
s the 
result 
in 
miniatu
re.
Allows 
you to 
curve 
the 
text in
a 
circle 
or 
semi-
circle.
To 
adjust 



contra
st, 
drag 
the 
inner 
ball 
clockwi
se or 
counte
rclock
wise, 
and to 
adjust 
bright
ness, 
drag it
center 
to 
edge. 
To 
adjust 
color 
intensi
ty, 
drag 
the 
outer 
ball. 
The 
center 
shows 
contra
st and 
bright
ness 
levels. 
To 
restor
e 
previou
s 
setting
s, click
Reset.
To 
adjust 
hue, 
drag 
the 
outer 
ball. 
To 
adjust 
color 



satura
tion, 
drag 
the 
inner 
ball 
clockwi
se or 
counte
rclock
wise, 
and to 
adjust 
bright
ness, 
drag it
center 
to 
edge. 
The 
center 
shows 
your 
startin
g color
and 
how it 
change
s. To 
restor
e 
previou
s 
setting
s, click
Reset.
Drag 
toward
the 
plus 
sign to
increas
e the 
selecte
d 
color, 
or 
toward
the 
minus 
sign to
decrea
se the 
selecte



d 
color.
Drag 
toward
the 
plus 
sign to
increas
e 
transp
arency,
or 
toward
the 
minus 
sign to
decrea
se 
transp
arency.
Drag 
toward
the 
plus 
sign to
increas
e the 
bend 
effect,
or 
toward
the 
minus 
sign to
decrea
se the 
bend 
effect.
Drag 
toward
the 
plus 
sign to
curve 
the 
text 
downw
ard, or
toward
the 
minus 
sign to
curve 



it 
upward
. 
Drag 
toward
the 
plus 
sign to
increas
e the 
compre
ssion 
of a 
JPG 
picture
, or 
toward
the 
minus 
sign to
decrea
se 
compre
ssion.
Drag 
toward
the 
plus 
sign to
increas
e the 
directi
on and 
streng
th of 
the 
distort
ion, or 
toward
the 
minus 
sign to
decrea
se it. 
Drag 
toward
the 
plus 
sign to
increas
e the 
slide 
show 



speed, 
or 
toward
the 
minus 
sign to
decrea
se 
speed.
Drag 
toward
the 
plus 
sign to
increas
e the 
softne
ss 
along 
the 
edge 
of the 
object.
Drag 
toward
the 
plus 
sign to
increas
e the 
effect,
or 
toward
the 
minus 
sign to
decrea
se the 
effect.
Drag 
toward
the 
plus 
sign to
make 
the 
edge 
design 
thicke
r, or 
toward
the 
minus 



sign to
make 
it 
thinner
.
Drag 
toward
the 
plus 
sign to
make 
the 
object 
more 
transp
arent, 
or 
toward
the 
minus 
sign to
make 
it less 
transp
arent.
Drag 
toward
the 
plus 
sign to
make 
the 
picture
sharpe
r, or 
toward
the 
minus 
sign to
make 
it 
blurrie
r. 
Drag 
toward
the 
plus 
sign to
make 
the 
shadow
more 
transp



arent, 
or 
toward
the 
minus 
sign to
make 
it less 
transp
arent.
Drag 
toward
the 
plus 
sign to
soften 
the 
shadow
's 
edge, 
or 
toward
the 
minus 
sign to
harden
the 
shadow
's 
edge.
Each 
ball 
repres
ents a 
differ
ent 
brush 
or 
stamp 
size. 
Each 
ball 
repres
ents a 
differ
ent 
streng
th 
level 
for 
the 
tool 
that 



remove
s dust 
from 
your 
picture
. 
Each 
ball 
repres
ents a 
differ
ent 
width 
for 
the 
tool 
that 
repairs
scratc
hes or 
wrinkle
s on 
your 
picture
. 
Each 
ball 
repres
ents a 
differ
ent 
width 
for 
the 
Edge 
Finder.
Each 
ball 
repres
ents a 
differ
ent 
width 
for 
the 
edge. 
Allows 
you to 
add a 
colore
d 
border
around



the 
edges 
of the 
text.
Fills 
with a 
color 
patter
n and 
style. 
Fills 
with a 
unifor
m color
and 
hue. 
Insert
s a 
picture
to fill 
the 
object.
High 
compre
ssion.
High 
resolut
ion 
(for 
high-
quality 
prints; 
uses 
more 
hard 
disk 
space).
Identi
fies 
your 
scanne
r type 
for 
Picture
It!
If no 
other 
option 
is 
selecte
d, 
Picture



It! 
adds 
your 
picture
s 
based 
on 
their 
curren
t 
locatio
n. 
Moves 
picture
files 
from 
their 
source 
locatio
n to 
anothe
r 
locatio
n in 
your 
Catalo
g. The 
picture
files 
then 
exist 
only in 
the 
destin
ation 
locatio
n. 
If you 
choose
to 
enter 
exact 
propor
tions, 
type a 
crop 
height.
If you 
choose
to 
enter 
exact 
propor
tions, 



type a 
crop 
width.
If you 
have a 
flatbe
d 
scanne
r, this 
automa
tically 
locates
your 
picture
on the 
scanne
r bed, 
scans 
it at 
the 
proper 
resolut
ion, 
crops 
it, and 
levels 
it. 
If you 
select 
Custom
Size, 
type a 
custom
print 
height.
If you 
select 
Custom
Size, 
type a 
custom
print 
width.
If you 

sel
ect
Cus
to
m 
Siz
e, 
typ
e a 



hei
ght
.

If you 
sel
ect
Cus
to
m 
Siz
e, 
typ
e a 
wid
th.

Increa
ses or 
decrea
ses a 
color's
satura
tion 
(purity
) from 
0 to 
100 
percen
t in 
small 
steps.
Increa
ses or 
decrea
ses 
edge 
softne
ss in 
small 
steps.
Increa
ses or 
decrea
ses 
edge 
width 
in 
small 
steps.
Increa
ses or 
decrea
ses 



the 
shadow
's 
transp
arency 
in 
small 
steps.
Increa
ses or 
decrea
ses 
shadow
edge 
softne
ss in 
small 
steps.
Increa
ses or 
decrea
ses 
the 
bright
ness of
the 
picture
from 0
to 100 
percen
t in 
small 
steps.
Increa
ses or 
decrea
ses 
the 
compre
ssion in
small 
steps.
Increa
ses or 
decrea
ses 
the 
crop 
shape 
height 
in 
small 
steps.



Increa
ses or 
decrea
ses 
the 
crop 
shape 
width 
in 
small 
steps.
Increa
ses or 
decrea
ses 
the 
distort
ion in 
small 
steps.
Increa
ses or 
decrea
ses 
the 
numbe
r of 
copies 
that 
will 
print.
Increa
ses or 
decrea
ses 
the 
print 
height.
Increa
ses or 
decrea
ses 
the 
print 
width.
Increa
ses or 
decrea
ses 
the 
sharpn
ess in 
small 



steps.
Increa
ses or 
decrea
ses 
transp
arency 
in 
small 
steps.
Standa
rd 
paper 
textur
es that
change
the 
look of
your 
paint 
or 
stamps
. Click 
the 
arrows
to see 
more. 
Inform
ation 
about 
configu
ration, 
printer
s, 
DLLs, 
fonts, 
filters,
OLE 
setting
s, and 
so on.
Insert 
your 
own 
text 
into 
the 
edge. 
Allows 
you to 
change
the 



text 
color, 
or to 
replac
e the 
color 
with a 
picture
or 
color 
patter
n.
Keeps 
the 
origina
l 
propor
tions 
as you 
adjust 
the 
size.
Leaves
picture
s 
availab
le on 
the 
Filmstr
ip.
You 
can 
apply 
distort
ion. 
You 
can 
trace 
the 
object 
yoursel
f.
Lists 
file 
types 
that 
Picture
It! 
suppor
ts. 
When 
you 
click a 



file 
type, 
only 
files 
of that
type 
appear.
Lists 
print 
resolut
ion 
with 
compar
ative 
print 
time.
Lists 
ready-
to-use 
collage
s.Lists 
ready-
to-use 
backgr
ounds 
for a 
new 
collage
.
Lists 
ready-
to-use 
object
s.
Lists 
the 
availab
le 
compre
ssion 
options
for 
this 
file 
format
.
Lists 
the 
availab
le 
drives 
and 
folder



s. 
Lists 
the 
availab
le 
drives.
Lists 
the 
availab
le 
fonts.
Lists 
the 
camera
s, 
scanne
rs, and
other 
optical
device
s that 
are set
up on 
your 
comput
er.
Lists 
the 
print 
resolut
ion 
options
("Good
" 
prints 
faster)
.
Lists 
the 
print 
size 
options
.
Lists 
the 
print 
size 
units 
(inches
or 
centim
eters).



Lists 
the 
printer
s that 
are set
up on 
your 
comput
er.
The 
catego
ry of 
Picture
Art to 
be 
display
ed in 
the 
previe
w pane.
Lists 
the 
scanne
rs, 
camera
s, and 
other 
optical
device
s that 
are set
up on 
your 
comput
er.
Loads 
picture
s from 
a 
digital 
camera
.
Loads 
picture
s from 
a 
digital 
camera
, using 
the 
softwa
re that
came 



with 
the 
camera
. For 
more 
inform
ation, 
refer 
to your
digital 
camera
docum
entatio
n.
 
Search
es for 
your 
picture
s in 
the My
Picture
s 
catalog
using 
descri
ptions 
and 
dates.
You 
can 
add a 
picture
from 
the 
Filmstr
ip or 
access 
more 
options
for 
openin
g a 
picture
not 
locate
d on 
the 
Filmstr
ip.
Low 
compre
ssion.



Low 
resolut
ion 
(for 
small 
prints; 
saves 
hard 
disk 
space).
Makes 
your 
collage
taller 
than it
is 
wide.
Makes 
your 
collage
wider 
than it
is tall.
You 
can 
manuall
y 
select 
discolo
red 
eyes. 
Mediu
m 
compre
ssion.
Mediu
m 
resolut
ion.
Moves 
or 
copies 
a 
picture
into an
existin
g or a 
new 
folder.
Moves 
or 
resizes



object
s in 
the 
collage
.
No 
compre
ssion.
Not 
implem
ented 
yet
Enter 
numbe
rs 
below 
to 
fine-
tune 
your 
change
s. 
Opens 
a 
picture
stored 
on your
comput
er, a 
networ
k, a 
disk, 
or a 
CD-
ROM.
Opens 
Picture
Art 
stored 
on your
CD-
ROM.
Opens 
the 
selecte
d 
picture
onto 
the 
picture
pane. 
The 



replac
ed 
picture
remain
s on 
the 
Filmstr
ip.
Opens 
the 
slide 
show 
so you 
can 
watch 
it.
Click 
to 
adjust
the 
size or
shape 
of your
cutout.
Starts
Print 
Reprin
ts, 
where 
you 
can 
print 
several
copies 
of your
comple
ted 
projec
t on a 
single 
page.
Starts
Print, 
where 
you 
can 
print 
out 
your 
comple
ted 
projec
t.



Starts
Save, 
where 
you 
can 
save 
your 
comple
ted 
projec
t for 
future 
refere
nce.
Paints 
the 
frame 
a 
neutral
color.
Paints 
the 
frame 
the 
comple
mentar
y color
of the 
picture
's main
color.
Paints 
the 
frame 
the 
main 
color 
in the 
picture
.
Paints 
the 
mat a 
neutral
color.
Paints 
the 
mat 
the 
comple
mentar
y color
of the 



picture
's main
color.
Paints 
the 
mat 
the 
main 
color 
in the 
picture
.
Perman
ently 
remove
s a 
picture
from 
your 
comput
er.
Places 
the 
selecte
d 
picture
on the 
Filmstr
ip (if 
it's 
not 
alread
y 
there) 
and in 
the 
picture
pane. 
If you 
want 
to 
place 
more 
than 
one 
picture
on the 
Filmstr
ip, 
drag 
the 
picture
s 



there, 
and 
then 
click 
Done.
Places 
your 
cutout 
on a 
white 
backgr
ound 
separa
te 
from 
your 
picture
. Click 
to 
remove
the 
check 
mark 
and 
keep 
your 
cutout 
with 
your 
origina
l 
picture
. 
Prints 
a 
layout 
contain
ing a 
mixtur
e of 
picture
s.
Prints 
a 
layout 
contain
ing 
more 
than 
one 
copy 
of the 
same 



picture
.
Prints 
the 
picture
.
Prints 
the 
projec
t on a 
page 
that is 
taller 
than it
is 
wide.
Prints 
the 
projec
t on a 
page 
that is 
wider 
than it
is tall.
Prints 
thumb
nails 
of the 
picture
s 
curren
tly 
open 
on the 
Filmstr
ip.Print
s 
thumb
nails 
of your
picture
s with 
their 
names 
display
ed 
undern
eath. 
Prints 
thumb
nails 
of your



picture
s 
withou
t 
display
ing 
names 
undern
eath.
Type 
the 
text 
you 
want 
to add 
to your
picture
.
Remov
es all 
picture
s from 
the 
Filmstr
ip.
Remov
es dust
or 
spots 
from 
selecte
d 
areas 
of your
picture
.
Remov
es dust
or 
spots 
from 
the 
entire 
picture
.
Remov
es the 
selecte
d 
picture
from 
the 
slide 



show.
Remov
es the 
printe
d 
thumb
nail 
layout 
from 
the 
picture
pane.
Replac
es an 
object 
in the 
collage
.
Replac
es the 
object 
with 
the 
entire 
picture
that 
you 
selecte
d on 
the 
Filmstr
ip.
Replac
es the 
object 
with 
the 
object 
that 
you 
selecte
d on 
the 
Stack.
Reset 
return
s the 
picture
to the 
way it 
looked 
before
you 



starte
d 
changi
ng it. 
The 
Reset 
button 
then 
change
s to 
Redo. 
Redo 
restor
es the 
change
s you 
made.
Retain
s your 
printe
d 
thumb
nail 
layout 
on the 
picture
pane.
Return
s 
setting
s to 
the 
Picture
It! 
defaul
t 
setting
s.
Return

s 
set
tin
gs 
to 
the
ir 
ori
gin
al 
val
ues
.

Return



s the 
last 
selecte
d 
picture
or 
folder 
to the 
previe
w pane.
Return
s the 
picture
to the 
way it 
looked 
before
your 
most 
recent 
action.
Return
s you 
to the 
previou
s task 
pane 
to 
begin a
new 
search.
Return
s your 
picture
to the 
way it 
looked 
before
your 
most 
recent 
action.
Revers
es the 
fill 
color 
patter
n and 
style.
Rotate
s the 
object 
180 



degree
s (the 
top 
becom
es the 
bottom
and 
the 
left 
becom
es the 
right).
Saves 
any 
change
s you 
have 
made 
and 
closes 
the 
task 
pane.
Saves 
hard 
disk 
space.. 
You'll 
need 
to 
recrea
te 
cutout
s if 
you 
want 
to 
move 
or 
change
them 
later. 
Lists 
the 
availab
le 
color 
options
for 
this 
file 
format
.



Keeps 
the 
origina
l 
propor
tions 
as you 
adjust 
the 
size.
Saves 
the 
curren
t 
picture
or 
collage
as your
deskto
p 
wallpap
er.
Saves 
the 
picture
so that
object
s can 
be 
moved 
or 
change
dbut 
uses 
more 
hard 
disk 
space.
Saves 
the 
postca
rd on a
comput
er file 
or to a
disk.
Saves 
the 
slide 
show 
as a 
PSF 
file so 



you 
can 
either 
view it 
in its 
own 
window
or 
insert 
it into 
docum
ents.
Saves 
two 
copies 
of the 
slide 
show, 
one as 
a PSF 
file 
and 
the 
other 
as an 
HTML 
file. 
Both 
files 
are 
linked 
to the 
picture
s (JPG 
files).
Scans 
a 
picture
.
Scans 
new 
picture
s.
Scans 
the 
picture
.
Select 
so that
the 
edge 
expand
s and 



wraps 
to 
show 
more 
of your
picture
.
Select 
the 
month 
or 
months
.
Select 
the 
time 
period.
Select 
the 
year 
for 
your 
calend
ar.
Adjust
s the 
colors 
so that
printou
t 
colors 
approx
imate 
those 
on the 
screen.
Makes 
all the 
text 
bold.
Makes 
all the 
text 
italic.
Underl
ines all
the 
text.
Select 

thi
s 
to 



cho
ose
you
r 
own
wid
th 
and
hei
ght
.

Applies
"trans
parent
" as 
the 
finish 
color.
Applies
"trans
parent
" as 
the 
start 
color.
Create
s a 
thumb
nail in 
My 
Picture
sso you
can 
easily 
access 
and 
view 
your 
picture
s no 
matter
where 
you 
saved 
them.
Select 
to 
custom
ize the
size of
your 
crop 
shape. 



Select
s a 
catego
ry of 
Cool 
Edges. 
Select
s a 
ready-
to-use 
object.
Select
s all 
parts 
of the 
object 
except
what is
curren
tly 
selecte
d.
Select
s one 
of your
own 
picture
s as 
the 
backgr
ound 
of your
new 
collage
.
Select
s one 
of your
own 
picture
s or 
object
s.
Select
s 
picture
s for a
new 
slide 
show.
Select
s 



whatev
er is 
on the 
picture
pane.S
elects 
a white
backgr
ound 
to 
build 
your 
collage
on.
Sets 
the 
locatio
n that 
you 
want 
Picture
It! to 
show 
first 
when 
you 
click 
Get 
Picture
, and 
then 
click 
My 
Picture
.
Sets 
the 
resolut
ion and
compre
ssion 
of 
picture
s when
you 
save 
them 
as 
MIX 
files.
Shows 
the 
curren



t 
direct
ory 
struct
ure. 
Select 
a 
folder 
to see 
the 
files 
that 
are 
either 
listed 
or 
display
ed in 
the 
previe
w 
pane.T
he 
object 
that 
you 
have 
selecte
d to 
place 
in the 
picture
pane.
Stroke
shapes
you 
can use
to 
paint 
on your
picture
. Click 
the 
arrows
to see 
more.
Standa
rd 
brush 
stroke
s you 
can 
use. 
Click 



the 
arrows
to see 
more.
Distor
tion 
effect
s you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa
rd 
edge 
colors 
you 
can 
use. 
Standa
rd 
edge 
shapes
you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa
rd fill 
color 
patter
ns you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa
rd fill 
styles 
you 
can 
use. 
Click 



the 
arrows
to see 
more.
Standa
rd 
kinds 
of 
shadow
s to 
apply. 
Click 
the 
arrows
to see 
more.   
Standa
rd 
shapes
to 
select 
from. 
Click 
the 
arrows
to see 
more.
Standa
rd 
text 
bend 
patter
ns you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa
rd 
text 
styles 
you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa



rd 
tools 
you 
can use
for 
distort
ing. 
Click 
the 
arrows
to see 
more. 
Select
s all 
the 
picture
files 
display
ed so 
they 
can be 
added 
to your
Catalo
g.    
 
#Tech
nical 
suppor
t 
options
.
The 
yellow 
ball 
indicat
es the 
color 
that 
you 
are 
adding 
to or 
removi
ng 
from 
the 
selecte
d 
object.
The 
beginni
ng 



date 
for 
the 
picture
file 
search.
The 
bright
ness 
control
: You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e 
bright
ness.
The 
contra
st 
control
: You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e 
contra
st. 
Color 
Picker 
tool: 
Use 
this to
select 
a color



in your
picture
to use 
as the 
"refer
ence 
color" 
before
adjusti
ng the 
color 
in the 
object.
The 
refere
nce 
color is
the 
color 
that 
change
s to 
match 
the 
color 
you 
click 
on the 
Color 
tool.
The 
richne
ss 
control
: You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e color
intensi
ty.
Catego
ries of
Picture
Art 



within 
the 
main 
catego
ry that
you 
selecte
d.
You 
scan 
using 
the 
softwa
re that
came 
with 
your 
scanne
r. For 
more 
help, 
refer 
to your
scanne
r's 
docum
entatio
n.
Traces
an 
object 
in the 
picture
.
Turns 
on the 
sounds
that 
come 
with 
Picture
It!
Turns 
the 
selecte
d 
object 
on its 
side 
(270 
degree
s) so 
that 



the 
top 
points 
to the 
left.
Turns 
the 
selecte
d 
object 
on its 
side 
(90 
degree
s) so 
that 
the 
top 
points 
to the 
right.
Turns 
the 
selecte
d 
object 
upside 
down 
(180 
degree
s).
Type a 
beginni
ng 
date 
for 
the 
picture
file 
search.
Type a 
messag
e for 
the 
bottom
edge.
Type a 
messag
e for 
the 
left 
edge.



Type a 
messag
e for 
the 
right 
edge.
Type a 
messag
e for 
the 
top 
edge.
Type a 
numbe
r to 
change
the 
distort
ion 
directi
on.
Type 
an 
ending 
date 
for 
the 
picture
file 
search.
Type 
the 
date 
of your
picture
.
Types 
of 
sound 
that 
play 
when 
your 
postca
rd is 
receive
d.
When 
Smart
Task 
Scan is
being 



used, 
this 
option 
will 
attemp
t to 
automa
tically 
correc
t the 
bright
ness 
and 
contra
st of 
your 
picture
. 
When 
the 
flag is 
green, 
clickin
g it 
connec
ts the 
ends 
of your
tracing
, and 
then 
you 
can 
adjust 
the 
lines 
of the 
tracing
. When
the 
flag is 
yellow, 
clickin
g it 
finishe
s the 
tracing
.
When 
you 
click 
Recove
r an 
area, 



whatev
er you 
trace 
next 
will be 
added 
back 
to the 
object.
When 
you 
click 
Trim 
an 
area, 
whatev
er you 
trace 
next 
will be 
remove
d from
the 
object.
You 
can 
custom
ize the
colors 
for 
your 
fill 
color 
patter
n.
You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e 
shadow
transp
arency.
You 



can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e edge 
softne
ss.
You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e 
transp
arency.
You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e 
sharpn
ess.
You 
can 
enter 
numbe
rs 
betwee



n -100 
and 
+100. 
Higher
numbe
rs 
increas
e the 
edge 
softne
ss.
You 
can 
enter 
numbe
rs 
betwee
n -100 
and 
+100. 
Higher
numbe
rs 
increas
e edge 
thickn
ess.
You 
can 
furthe
r 
custom
ize the
cutout 
color 
or fill.
You 
can 
furthe
r 
custom
ize the
shape 
and 
textur
e of 
your 
paintbr
ush.
You 
can 
furthe
r 



custom
ize 
your 
color.
You 
can 
furthe
r 
custom
ize 
your 
colors.
You 
can 
furthe
r 
custom
ize 
your 
edge.
You 
can 
furthe
r 
custom
ize 
your 
gradie
nt 
finish 
color.
You 
can 
furthe
r 
custom
ize 
your 
gradie
nt 
start 
color.
You 
can 
furthe
r 
custom
ize 
your 
shadow
color.
You 



can 
furthe
r 
custom
ize 
your 
text 
shadow
. 
You 
can 
select 
a 
predef
ined 
shape 
for 
your 
object.
Catego
ries of
ready-
to-use 
KODA
K 
IMAG
E 
MAGI
C 
Custom
Creati
ons.
Lists 
the 
sizes 
and 
format
s of 
high-
quality 
prints 
of your
projec
t that 
you 
can 
order 
from 
Kodak.
Makes 
a 5-by-
7-inch 
print.



Makes 
an 11-
by-14-
inch 
print.
Makes 
an 8-
by-10-
inch 
print.
Initiat
es the 
KODA
K 
IMAG
E 
MAGI
C Print
Servic
e 
softwa
re, 
where 
you 
can 
find 
new 
KODA
K 
IMAG
E 
MAGI
C 
Custom
Creati
ons.
Initiat
es the 
KODA
K 
IMAG
E 
MAGI
C Print
Servic
e 
softwa
re, 
where 
you 
can 
order 
your 



photog
raphic-
quality 
prints.
Type 
your 
own 
text to
replac
e 
what's
on the 
KODA
K 
IMAG
E 
MAGI
C 
Custom
Creati
ons 
templa
te.

Resets 
your 
search 
criteria 
to the 
initial 
settings
. The 
Reset 
button 
then 
changes
to 
Redo. 
Redo 
restore
s the 
changes.
Orients 
the 
page 
with the
short 
edge to 
the top.
Orients 
the 
page 
with the
long 



edge to 
the top.
Lists 
availabl
e page 
sizes. 
When 
Custom 
Size has
been 
selected
, you 
can 
increase
or 
decreas
e the 
width of
your 
page in 
small 
steps.
When 
Custom 
Size has
been 
selected
, you 
can 
increase
or 
decreas
e the 
height 
of your 
page in 
small 
steps.
Closes 
the task
pane 
and 
carries 
out the 
comman
d.
Closes 
the task
pane 
and 
cancels 
any 
changes



you 
have 
made.
Proceed
s to the 
next 
task 
pane.Re
turns to
the 
previous
task 
pane. 
Use a 
predesi
gned 
backgro
und for 
a new e-
mail 
postcar
d.
Opens 
an 
existing
e-mail 
postcar
d.
Opens 
the e-
mail 
postcar
d so you
can see 
it.
Click 
this to 
select a 
path.
Initiat
es the 
search.
Each 
ball 
repres
ents a 
differ
ent 
streng
th 
level 
for 



distort
ing 
your 
image. 
Color 
effect
s you 
can 
use. 
Click 
the 
arrows
to see 
more.
Artisti
c 
effect
s you 
can 
use. 
Click 
the 
arrows
to see 
more.
Special
effect
s you 
can 
use. 
Click 
the 
arrows
to see 
more.
Standa
rd 
edge 
resolut
ions to
choose
from.
Opens 
a 
sound 
stored 
on your
comput
er, a 
networ
k, a 
disk, 
or a 



CD-
ROM.
Type 
the 
name 
of the 
file 
you 
want 
to 
find.
Clears 
the 
file 
name 
you 
just 
typed. 
The 
Reset 
button 
then 
change
s to 
Redo. 
Redo 
restor
es the 
file 
name.
Create
s a 
greetin
g card 
that is 
folded 
twice 
vertica
lly. 
Click 
this 
option 
to see 
a 
previe
w.
Create
s a 
greetin
g card 
that is 
folded 
along 



the 
top, 
and 
also 
along 
the 
side. 
Click 
this 
option 
to see 
a 
previe
w.
Click 
to add 
your 
picture
s to 
your 
Catalo
g.
Click 
to 
store 
your 
picture
s 
elsewh
ere on 
your 
comput
er.
Picture
s or 
folder
s you 
have 
selecte
d.
Saves 
your e-
mail 
postca
rd to 
be 
mailed 
later.
Initiat
es a 
search
for 
your 



picture
s in 
the 
folder 
or 
catalog
you've 
selecte
d. 
Enter 
numbe
rs to 
adjust 
the 
positio
n of 
the 
slider 
in 
small 
increm
ents.
Standa
rd 
edge 
design
s you 
can 
use. 
Click 
the 
arrows
to see 
more.
Click 
the 
arrow 
to 
choose
from 
availab
le 
resolut
ions.
Adds 
an 
artisti
c 
effect 
to your
text. 
Adds a
traditi



onal 
look to
your 
text. 
Adds 
an 
exotic 
look to
your 
text.
Text 
effect
s to 
choose
from. 
Click 
the 
arrows
to see 
more.
Change
s the 
color 
of your
text. 
Change
s the 
conten
t of 
your 
text.
Makes 
a new 
cutout 
you 
can 
add.
Display
s 
furthe
r help 
topics 
after 
scannin
g.
Does 
not 
display
furthe
r help 
topics 
after 
scannin



g.
Lists 
the 
availab
le 
folder
s for 
Picture
It! to 
look in 
first 
when 
openin
g 
picture
s. 
Select 
the 
folder 
you 
want, 
and 
then 
click 
OK.
The 
differ
ent 
ways 
you 
can 
apply 
stamps
to your
picture
. 
You 
can 
select 
your 
own 
picture
s or 
cutout
s to 
use as 
stamps
.
Drag 
toward
the 
plus 
sign to



make 
the 
picture
bright
er, or 
toward
the 
minus 
sign to
make 
it 
darker.
Drag 
toward
the 
plus 
sign to
increas
e the 
contra
st, or 
toward
the 
minus 
sign to
reduce
it.
Drag 
toward
the 
plus 
sign to
empha
size 
the 
bright
er 
parts 
of your
picture
, 
causing
the 
shadow
y areas
to 
stand 
out. 
Drag 
to the 
left to 
empha
size 
the 



darker
parts 
of your
picture
, 
causing
the 
shadow
s to 
blend 
into 
the 
picture
.
Flips 
the 
effect 
so that
the 
right 
edge is
on the 
left 
side 
and 
the 
left 
edge is
on the 
right.
Flips 
the 
effect 
so that
the 
top is 
on the 
bottom
and 
the 
bottom
is on 
the 
top.
You 
can 
furthe
r 
custom
ize the
textur
e and 
transp



arency 
of your
stamps
. If 
you're 
using a
simple 
shape, 
you 
can 
also 
change
its 
color.
Use 
the 
colors 
of the 
cutout 
for 
the 
edge.
Adjust
the 
bright
ness 
and 
contra
st of 
your 
picture
so that
it 
appear
s more
crisp 
and 
vivid.
Adjust
the 
colors 
in your
image 
so that
they 
appear
more 
natural
.
Trim 
unwant
ed 
edges 



from 
your 
picture
.
Reorie
nt the 
picture
if it's 
crooke
d, 
upside 
down, 
or in 
its 
side.
Correc
t red 
eye, 
caused
by 
flash 
photog
raphy.
Lighte
n or 
darken
areas 
in your
picture
by 
using 
your 
mouse 
as a 
paintbr
ush.
Change
the 
color 
of 
areas 
in your
picture
by 
using 
your 
mouse 
as a 
paintbr
ush.
Adjust
the 
colors 



in 
areas 
of your
picture
so 
they 
appear
more 
natural
by 
using 
your 
mouse 
as a 
paintbr
ush.
Make 
areas 
of your
picture
more 
or less 
transp
arent 
by 
using 
your 
mouse 
as a 
paintbr
ush.
Click 
to 
smooth
ly 
blend 
the 
edges 
that 
you 
touche
d up 
with 
the 
area 
that 
you 
left 
unchan
ged.
Click 
to 
show a 



distinc
t edge 
betwee
n the 
area 
that 
you 
touche
d up 
and 
the 
area 
that 
you 
left 
unchan
ged.
Autom
atically
deter
mines 
the 
best 
adjust
ments 
needed
to 
restor
e your 
damag
ed 
photo.
Click 
to 
create 
a 
thumb
nail-
sized 
picture
. These
picture
s can 
serve 
as 
refere
nces or
navigat
ional 
cues to
other 
pages 
or 
picture



s on 
your 
web 
site.
Click 
to 
create 
a 
mediu
m-
sized 
picture
. These
picture
s may 
lose 
some 
detail 
but will
downlo
ad 
more 
quickly
than 
the 
larger 
size.
Click 
to 
create 
a large
picture
. These
picture
s will 
take 
longer 
to 
downlo
ad but 
contain
the 
best 
detail. 
This 
size 
picture
is not 
always 
ideal 
for 
the 
Web 
becaus



e it 
may 
require
the 
viewer 
to 
scroll 
to see 
the 
entire 
picture
.
Click 
the 
arrow 
to 
select 
the 
modem
speed 
you 
expect
people 
to use 
when 
viewing
your 
Web 
page.
Click 
the 
arrow 
to 
select 
the 
desire
d 
quality 
for 
your 
image. 
Better
quality 
images
are 
more 
consist
ent to 
their 
origina
l 
source
s but 
can 



take 
much 
longer 
to 
appear
on 
other 
comput
ers.
Click if
you 
want 
the 
backgr
ound 
of your
Web 
page 
to 
show 
behind
the 
cutout.
Click if
you 
want 
to 
replac
e the 
transp
arent 
area 
with a 
solid 
color.
The 
differ
ent 
catego
ries of
album 
pages 
availab
le for 
you to 
choose
from.
Click 
to 
select 
anothe
r 
templa



te for 
creatin
g more
album 
pages.
Autom
atically
restor
e your 
picture
so it 
looks 
like a 
freshly
develo
ped 
black 
and 
white 
picture
.
Click 
to 
place 
the 
object 
you've 
selecte
d in 
the 
picture
on the 
picture
pane 
into 
the 
collage
.
Click 
to cut 
a 
section
out of 
the 
picture
in the 
picture
pane 
that 
you 
want 
to add 
to the 



collage
Apply 
side-
by-
side 
stamps
to your
picture
.
Apply 
stamps
that 
have 
slightl
y 
overlap
ping 
edges 
to your
picture
.
Apply 
stamps
that 
are 
solid 
colore
d 
shapes
to your
picture
.
Use 
Picture
Art 
from 
the 
Picture
It! CD 
to 
create 
a 
stamp.
Click 
to 
accept 
the 
charac
teristi
cs of 
the 
picture
as 



they 
are 
descri
bed in 
the 
task 
pane.
Autom
atically
adjust
s the 
printer
setting
s to 
accom
modat
e the 
picture
that is 
being 
printe
d.
Soft 
edges 
blur 
the 
border
of the 
area 
that 
you 
touch 
up, so 
the 
touchu
p 
blends 
into 
the 
rest of
your 
picture
.
Hard 
edges 
have a 
distinc
t 
border
that 
helps 
to 
separa



te the 
area 
that 
you 
touchu
p from
the 
rest of
your 
picture
.
Select 
which 
day 
you 
want 
to 
begin 
each 
week 
with.
Create
a new 
roll of 
your 
favorit
e 
picture
s to 
store 
at 
Kodak 
Photo
Net.
Place 
all the 
picture
s in 
the 
selecte
d roll 
on the 
Filmstr
ip.
Save 
the 
picture
s on 
the 
Filmstr
ip to a 
roll 
that is 



alread
y 
stored 
on 
Kodak 
Photo
Net.
Click 
to add 
an 
Alignm
ent 
Guide 
that 
runs 
from 
left to 
right 
across 
the 
picture
pane.
Click 
to add 
an 
Alignm
ent 
Guide 
that 
runs 
form 
top to 
bottom
across 
the 
picture
pane.
Click 
select 
an 
Alignm
ent 
guide 
to 
remove
from 
the 
picture
pane.
Click 
to 
remove
all 



Alignm
ent 
Guides 
from 
the 
picture
pane.
Click 
to 
remove
the 
picture
in the 
picture
pane 
from 
the 
Filmstr
ip. If 
you've 
made 
change
s to 
the 
picture
, you'll 
be 
asked 
if you 
want 
to save
them 
before
closing.
Send 
only 
the 
picture
in the 
picture
pane 
to be 
printe
d at an
online 
service
Send 
all the 
picture
s on 
the 
Filmstr
ip to 



be 
printe
d at an
online 
service
Place 
other 
picture
s onto 
the 
Filmstr
ip by 
openin
g, 
scannin
g, or 
downlo
ading 
them 
from a 
digital 
camera
.    You 
can 
also 
close 
picture
s 
curren
tly 
open 
on the 
Filmstr
ip.
You 
can 
create 
an 
object 
by 
using 
its 
colors.
You 
can 
select 
more 
colors 
to cut 
out of 
the 
picture
.



You 
can 
remove
some 
of the 
selecte
d 
colors 
from 
the 
cutout.
Only 
cut out
areas 
with 
similar 
colors 
if they
are 
connec
ted to 
where 
you 
click.
Cut 
out all 
areas 
in the 
picture
that 
contain
the 
colors 
you 
select.
Click 
or 
drag 
over 
the 
picture
to 
select 
the 
colors 
you 
want 
to cut 
out.
Drag 
toward
the 
plus 



sign to
select 
a 
larger 
range 
of 
similar 
colors, 
or 
toward
the 
minus 
sign to
select 
a 
smaller
range.
Increa
ses or 
decrea
ses 
the 
range 
of 
colors 
to 
select 
in 
small 
steps.
Differ
ent 
ways 
you 
can 
make 
the 
selecte
d 
object 
stand 
out 
from 
the 
rest of
your 
picture
. Click 
the 
arrows
to see 
more.
Conver



t your 
picture
into a 
black 
and 
white 
picture
.
Design 
your 
own e-
mail 
postca
rd by 
using 
your 
own 
picture
s.
Resize 
the 
picture
so it's 
best 
suited 
for 
viewing
onscre
en.
Resize 
the 
picture
so it's 
well 
suited 
for 
printin
g and 
viewing
onscre
en.
Send 
the 
picture
by 
using 
its 
curren
t 
dimens
ions.
Have 
Picture



It! 
create 
an e-
mail 
messag
e and 
attach 
the 
picture
for 
you.
Save 
the 
picture
to your
hard 
disk, 
so you 
can 
create 
an e-
mail 
messag
e and 
attach 
the 
image 
file 
yoursel
f.
Remov
e 
stamps
from 
the 
list of 
availab
le 
stamps
.
Remov
e the 
selecte
d 
picture
from 
your 
comput
er.
Differ
ent 
button
s you 



can use
for 
your e-
mail 
postca
rd. 
Click 
the 
arrows
to see 
more.
Click 
to stop
playing
the 
sound 
you've 
selecte
d.
Special
effect
s you 
can use
to 
empha
size 
the 
selecte
d 
object.
Starts
your 
Intern
et 
browse
r and 
goes to
the 
Web 
site 
for 
Fujifil
m.Net.
Change
the 
locatio
n in 
your 
picture
that 
you 
want 
to 



start 
cloning
from.
Shows 
the 
rolls of
picture
s you 
have 
stored 
online. 
Select 
a roll 
to see 
its 
conten
ts in 
the 
picture
pane.
Saves 
the 
slide 
show, 
so it 
can be 
display
ed on 
comput
ers 
that 
don't 
have 
Picture
It! 
installe
d on 
them.
Erase 
some 
of the 
stamps
you 
just 
stampe
d. (You
cannot 
return 
to 
erase 
stamps
if 
you've 



comple
ted a 
differ
ent 
task 
after 
the 
Stampi
ng 
task.)
Select 
if you 
experi
ence 
difficu
lty 
scannin
g or 
downlo
ading 
from 
your 
digital 
camera
.
Select 
to 
enhanc
e 
memor
y 
usage 
when 
scannin
g or 
downlo
ading 
picture
s from 
your 
digital 
camera
. 
Enhanc
ed 
perfor
mance 
also 
improv
es the 
way 
your 
comput
er uses



memor
y 
during 
these 
activiti
es.
Change
s your 
scanne
r and 
digital 
camera
softwa
re 
perfor
mance 
setting
s. (Bug 
1794)
Select
s all 
the 
picture
s in 
the 
curren
t 
catalog
for 
printin
g 
Differ
ent 
stamps
or 
shapes
that 
you 
can 
use. 
Click 
the 
arrows
to see 
more
Use 
with 
vertica
l fonts 
to 
align 
text 
across 



the 
top. 
Text 
will 
flow 
from 
top to 
bottom
, left 
to 
right.
Use 
with 
vertica
l fonts 
to 
center 
text 
vertica
lly. 
Text 
will 
flow 
from 
top to 
bottom
, left 
to 
right.
Use 
with 
vertica
l fonts 
to 
align 
text 
along 
the 
bottom
. Text 
will 
flow 
from 
top to 
bottom
, left 
to 
right.
Additi
onal 
control
s for 
changi



ng or 
shiftin
g the 
colors 
in the 
text. 
Enter 
your 
name.
Enter 
your 
phone 
numbe
r. 
Remem
ber to 
include
your 
area 
code. 
If you 
live 
outsid
e the 
United
States
, be 
sure to
include
your 
countr
y code.
Enter 
your e-
mail 
addres
s.
Enter 
your 
street 
addres
s as it 
appear
s on 
the bill
for 
the 
credit 
card 
you're 
using 
for 
this 



transa
ction.
Enter 
your 
city as 
it 
appear
s on 
the bill
for 
the 
credit 
card 
you're 
using 
for 
this 
transa
ction.
Enter 
your 
state 
as it 
appear
s on 
the bill
for 
the 
credit 
card 
you're 
using 
for 
this 
transa
ction.
Enter 
your 
zip 
code 
as it 
appear
s on 
the bill
for 
the 
credit 
card 
you're 
using 
for 
this 
transa



ction.
Enter 
your 
countr
y as it 
appear
s on 
the bill
for 
the 
credit 
card 
you're 
using 
for 
this 
transa
ction.
Enter 
your 
credit 
card 
numbe
r 
exactl
y as it 
appear
s on 
your 
credit 
card.
Enter 
the 
month 
and 
year 
on 
which 
your 
credit 
card 
expire
s.
Check 
to 
retain 
the 
inform
ation 
entere
d in 
this 
dialog 



box 
for 
future 
orders.
Clear 
to re-
enter 
billing 
inform
ation 
each 
time 
you 
conduc
t a 
transa
ction 
at 
Kodak 
Photo
Net in 
Picture
It!
Select 
a roll 
of 
picture
s that 
you 
alread
y 
saved 
at 
Kodak 
Photo
Net.
Type 
the 
film 
ID 
numbe
r for 
the 
roll of 
film 
you 
want 
to add 
to the 
View 
an 
existin
g roll 
list. 



Con
necti
ng 
to 
the 
Micr
osof
t 
Pict
ure 
It! 
Hom
e 
Page
You 
can 
downlo
ad 
free 
templa
tes, 
learn 
tips 
and 
tricks 
for 
workin
g with 
Picture
It!, 
share 
your 
own 
creatio
ns, and
more 
on the 
Picture
It! 
Home 
Page. 
To 
access 
this 
site, 
you 
need 
to be 
able to
connec
t to 
the 
Intern
et 



using a
Web 
browse
r such 
as 
Micros
oft 
Intern
et 
Explor
er, and
an 
online 
service
or 
Intern
et 
service
provid
er 
such as
the 
Micros
oft 
Netwo
rk.
1

Clic
k 
the
Pro
jec
ts 
tab
.

2

Clic
k 
Go 
Onl
ine
, 
and
the
n 
clic
k 
Mic
ros
oft
Pic
tur



e 
It! 
Ho
me
Pag
e.

Chan
ging 
the 
defa
ult 
path
to 
your
pict
ures 
in 
Pict
ure 
It!
If you 
keep 
your 
freque
ntly 
used 
picture
s in a 
folder 
that is 
not 
the My
Picture
s 
folder,
you 
can 
instruc
t 
Picture
It! to 
look in 
that 
folder 
first:
1 On 

the
Vie
w 
me
nu,



clic
k 
Op
tio
ns.

1 In 
the
Pat
h 
to 
my
pic
tur
es 
bo
x, 
typ
e 
the
co
mpl
ete
pat
h 
for
the
de
sir
ed 
fol
de
r, 
an
d 
the
n 
clic
k 
OK
.

Note: 
If you 
installe
d 
Micros
oft 
Meda 
Manag
er, and
the 
folder 
you 
specifi



ed is 
not 
alread
y a 
Catalo
g 
folder,
Picture
It! may
ask if 
you 
want 
to 
conver
t it to 
one. 
Click 
Yes.

            
Tell me 
more 
about 
Microsof
t Media 
Manager

I 
can't
conv
ert a
fold
er 
that 
cont
ains 
my 
pict
ures 
into 
a 
catal
og
If you 
can't 
create 
catalog
s from 
folder
s that 
contain
picture
s, it's 
possibl



e that 
you 
didn't 
install 
Micros
oft 
Media 
Manag
er, or 
that a 
necess
ary 
file 
was 
accide
ntally 
delete
d from
your 
comput
er. You
can fix
this 
proble
m by 
installi
ng 
Media 
Manag
er.
Note: 
If you 
deliber
ately 
delete
d or 
didn't 
install 
Media 
Manag
er on 
your 
system
, 
Picture
It! 
can't 
create 
catalog
s.

            
Installing
Microsof



t Media 
Manager

Insta
lling 
Micr
osof
t 
Medi
a 
Man
ager
1

Clo
se 
all 
ope
n 
pro
gra
ms.

2

Ins
ert
you
r 
Pic
tur
e 
It! 
pro
gra
m 
CD 
int
o 
you
r 
CD 
RO
M 
Dri
ve.

3 On 
the
De
skt
op, 
dou
ble
-



clic
k 
My 
Co
mp
ute
r, 
and
the
n 
dou
ble
-
clic
k 
you
r 
CD-
RO
M 
dri
ve 
ico
n.

4

Clic
k 
Set
up.

5 In 
the
Pic
tur
e 
It 
Set
up 
scr
een
, 
clic
k 
Ins
tall
Me
dia
Ma
nag
er 
Cat
alo
gin



g.
6

Foll
ow 
the
ons
cre
en 
ins
tru
cti
ons
.

Crea
ting 
my 
own 
stam
p
You 
can use
any 
picture
you 
want 
to as a 
stamp. 
For 
best 
results
, use 
simple 
cutout
s that 
will 
retain 
their 
detail 
when 
they'r
e 
reduce
d. 
After 
you 
create 
a 
stamp, 
it will 
always 
be 
availab



le for 
you to 
use 
with 
Picture
It!
1 In 

ste
p 2 
of 
the
Sta
mpi
ng 
tas
k 
pan
e, 
clic
k 
Ma
ke 
my
own
sta
mp.

2

Sel
ect
the
me
tho
d 
for
loa
din
g 
the
pic
tur
e 
you
wan
t 
to 
ma
ke 
int
o a 
sta
mp.

3



Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.
No
te:
If 
you
sel
ect
a 
Pic
tur
e 
It! 
pic
tur
e 
tha
t 
has
mo
re 
tha
n 
one
obj
ect
in 
it, 
Pic
tur
e 
It! 
aut
om
ati
call
y 
co
mbi
nes
all 
the



obj
ect
s 
int
o 
one
for
the
sta
mp.

            
What if I
want to 
delete a 
stamp I 
created?

Sta
mpin
g 
the 
edge
s of 
an 
obje
ct
1 On 

the
Sta
ck, 
clic
k 
the
obj
ect
you
wan
t 
to 
add
a 
sta
mp
ed 
edg
e 
to.

            I   
haven't 
yet cut 
out the 
object I 



want to 
change

            
Where's 
the 
Stack?

2

Clic
k 
the
Wo
rkb
enc
h 
tab
.

3

Clic
k 
Edg
e 
Eff
ect
s, 
and
the
n 
clic
k 
Sta
mp
ed 
Edg
es.

4

Foll
ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.



Tips

            
What if I
want to 
use my 
own 
stamp?
Troubl
eshoot
ing

            
What if I
change 
my mind?

Use 
align
men
t 
guid
es to
arra
nge 
obje
cts
Alignm
ent 
guides 
are 
non-
printin
g 
horizo
ntal or 
vertica
l lines 
that 
you 
can 
place 
over 
your 
picture
s while
you 
align 
or 
place 
object
s. 
When 



you 
drag 
the 
edge 
of an 
object 
near an
alignm
ent 
guide, 
it 
snaps 
to the 
guide 
for 
precise
placem
ent.
1

Clic
k 
the
Wo
rkb
enc
h 
tab
.

2

Clic
k 
Siz
e &
Pos
itio
n, 
and
the
n 
clic
k 
Ali
gn
me
nt 
Gui
des
.

3

Foll



ow 
the
ins
tru
cti
ons
in 
the
tas
k 
pan
e.

To move 
an 
existing 
guide, 
place 
your 
mouse 
over the 
guide, 
and then 
drag the 
guide to 
the 
desired 
location.
Tip:    
You 
can 
hide 
and 
show 
guides 
by 
clickin
g 
Alignm
ent 
Guides
on the 
View 
menu.
Wha
t file
form
ats 
can 
Pict



ure 
It! 
open
?
Here 
is a list
of the 
file 
format
s 
(along 
with 
progra
ms 
that 
work 
with 
them) 
that 
Picture
It! can 
open.
File 
extension

.bmp Microsoft 
Windows 
operating 
system 
bitmap

Most Microsoft
Windows image 
editing 
programs

.fpx Flashpix Newer image 
editing 
programs

.jpg JPEG 
(Joint 
Photo-      
graphic 
Expert 
Group)

Most image 
editing 
programs, 
especially those
designed for 
the Web

.png Portable 
Network 
Graphics

Newer 
Microsoft 
Windows image 
editing 
programs.

.tif Tagged 
Image File 
Format

Most image 
editing 
programs

.gif Graphics 
Interchang
e Format

Most image 
editing 
programs, 
especially those
designed for 
the Web

.pcx PC 
Paintbrush

Most Microsoft
Windows image 
editing 



programs
.tga Targa Most Microsoft

Windows image 
editing 
programs

.dxf AutoCAD 
Format 2-
D

AutoCad. But 
Picture It! 
can't open .dxf 
files that use 
wireframes or 
other 3-D 
modeling 
features

.cdr CorelDraw CorelDraw. But 
Picture It! 
doesn't 
preserve the 
layers created 
in CorelDraw

.eps Encapsulat
ed 
PostScript

Most desktop 
graphics 
programs used 
for desktop 
publishing. 
Picture It! can 
only open .eps 
files that 
contain preview
information in 
the header

.emf Enhanced 
Metafile

Common format
for clipart

.pcd Kodak 
Picture CD

Kodak 
proprietary. 
Used in older 
Kodak photo 
CDs

.pct Macintosh 
Picture

Most graphics 
programs for 
Apple 
computers

.drw Micrografx
Designer

Micrographx 
graphics 
programs

.wmf Microsoft 
Windows 
Metafile

Common format
for clipart

.wpg WordPerfe
ct Graphics

WordPerfect

Finding pictures to combine with my own
If you need a special image to use as a prop or background and cannot find something on the 
Picture It! CD, a good place to look is the World Wide Web. If you’re able to connect to the 
Internet by using a Web browser, such as Internet Explorer you can download pictures from lots
of Web sites. Usually, these sites charge a fee to let you use the pictures they offer. If you 
have the North American English version of Picture It!, Picture It! can help you start your 



search:
1 Click the Projects Tab.
2 Click Go Online, and then click Shop for Pictures.
Note: As a registered Picture It! user, if you use the pictures on these pages, you may be eligible
for discounts and other benefits. 



How do I cut out by colors?
To create a cutout consisting only of parts of your picture that contain the same or similar 
colors, click By color selection. This is a good way to select the sky if you want to make it bluer 
or to change the color of a person's shirt without affecting skin tones.

Click your mouse over the colors in the picture that you want to cut out.
If you've selected too much of the picture, click Remove from cutout to remove part of 

the selection. To select more of the picture to include in the cutout, click Add to cutout.
If areas you want to cut out are separated by other parts of the picture--for example, if 

the sky that you want to recolor is interrupted by tall trees--you can select all areas at once by 
clicking All similar areas. 

To restrict the area you cut out to parts that are connected by where you drag your mouse, 
click Connected to where I click.

If you want to decrease the range of similar colors to include in the object, drag the slider 
all the way to the left to select only the parts of the picture that are the exact same color as the 
area you dragged your mouse over. To increase the range of colors, drag the slider to the right to 
increase the range of similar colors to include.



How do I cut out by colors?
1 Click the Workbench tab.
2 Click Pictures and Cutouts, and then click Cut Out of Picture.
3 In the task pane, click By color selection.
4 Click your mouse over the colors in the picture that you want to cut out.

If you've selected too much of the picture, click Remove from cutout to remove part of 
the selection. To select more of the picture to include in the cutout, click Add to cutout.

If areas you want to cut out are separated by other parts of the picture--for example, if 
the sky that you want to recolor is interrupted by tall trees--you can select all areas at once by 
clicking All similar areas. 

To restrict the area you cut out to parts that are connected by where you drag your mouse, 
click Connected to where I click.

To decrease the range of colors to include in the object, drag the slider all the way to the 
left to select only the parts of the picture that are the exact same color as the area you dragged 
your mouse over.



Paint to correct the tint 
1 On the Stack, click the object you want to change.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Touchup Painting.
4 In the task pane, click Correct Tint.
5 Select a brush size and style.
6 On the outer ring of the Color tool, click the color you want.
7 To increase the intensity of the color you selected, drag the slider to the right (+). To reduce

it, drag the slider to the left (-).
8 Drag the mouse over the object to paint.
            How?  
Tip:    Use the Color tool to create a cutout of the part of your picture that you want to adjust.
            How?  
Troubleshooting
            What if I change my mind?  



Paint to change the brightness and contrast
1 On the Stack, click the object that you want to change.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Touchup Painting.
4 In the task pane, click Brightness & Contrast.
5 Select a brush size and style.
6 To make the colors brighter, drag the upper slider to the right (+). To make them darker, 

drag it to the left (-).
7 To increase the contrast between the lighter and darker areas in the cutout, drag the lower 

slider to the right (+). To reduce the contrast, drag it to the left (-).
8 Drag the mouse over the object to paint. 
            How?  
Tip:    Use the Color tool to create a cutout of the part of your picture that you want to adjust.
            How?  
Troubleshooting
            What if I change my mind?  



Paint to change the color
1 On the Stack, click the object you want to change.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Touchup Painting.
4 In the task pane, click Colorize.
5 Select a brush size and style.
6 Select the color you want to add to the cutout.
7 Drag the mouse over the object to paint.
            How?  
Tip:    Use the Color tool to create a cutout of the part of your picture that you want to adjust.
            How?  
Troubleshooting
            What if I change my mind?  



Paint to change the transparency 
1 On the Stack, click the object you want to change.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Touchup Painting.
4 In the task pane, click Transparency, and then click Done.
5 Select a brush size and style.
6 To increase the transparency, drag the transparency slider to the right (+).
8 Drag the mouse over the object to paint.
            How?  
Tip:    Use the Color tool to create a cutout of the part of your picture that you want to adjust.
            How?  
Troubleshooting
            What if I change my mind?  



What is a start position?
The start position is the point on the selected cutout that you click to use as a reference when 
you clone-paint. It identifies the area of the picture that you are going to copy from. After you 
set the start position, the reference point moves with the mouse until you set a new starting 
position or end the task.
For example, if you set the start position 1-inch from where you want to clone-paint, the 
reference point will remain 1-inch from where you paint until you set a new starting point.



Paint by cloning
Clone from one place in your picture to another to hide unwanted backgrounds or add small 
elements to your picture.
1 On the Stack, click the object you want to clone.
            Where's the Stack?  
2 Click the Workbench tab
3 Click Touchup, and then click Clone Painting.
4 Select a brush size.
5 Click the area you want to clone from. This is your start position.
            What is a start position?  
6 You can change the brush shape, transparency setting, and texture by clicking Customize 

settings...
7 To paint by dragging, follow the instructions in the task pane.
8 If you stop painting and want to change the start position before resuming, click Set new 

start position. Then resume this procedure from step 4.



Why clone?
You can replace a small feature in your original picture with a natural background. For example, in
this picture, the people in the poolside chairs make this intimate scene a little less private. By 
cloning empty poolside chairs and the sky in between them, the couple has the pool to themselves.

B
e
f
o
r
e

A
f
t
e
r

Should I let the Web page show through my picture or fill the 
transparent area with a solid color?

If you Click Then

Let the Web
page 
background 
show 
through

Picture It! will save 
your picture using 
the GIF (Graphics 
Interchange Format)
file format, so that 
the background of 
your Web page 
shows through 
designated areas of 
your picture. 
Remember that 
pictures created in 
GIF file format can 
only contain a limited
number of colors, 
and sometimes 
photographs 
sometimes don't look
as good when the the
number of colors 
they contain is 
reduced. 

Fill the 
transparent 
areas with a 

Picture It! will save 
your picture using 
the JPEG (Joint 



solid color Photographic Expert 
Group) file format. 
Pictures created in 
JPEG file format are
popular for the Web 
because they 
compress well and 
can contain over 16-
million colors. You 
can't designate 
transparent areas in 
pictures create in 
JPEG file format for
a Web page, but by 
filling the 
transparent area 
with a color similar 
to your Web page's 
background, you can 
simulate 
transparency.

Deleting unwanted stamps from my computer
Picture It! saves every stamp you create. Deleting stamps you no longer need frees up disk space 
and makes your stamp list more manageable.
1 Make sure a picture is open in the picture pane.
2 Click the Workbench tab.
3 Click Paint & Color Effects, and then click Stamping.
4 In step 2 of the task pane, click Make my own stamp.
5 In the task pane, click Delete stamps.
6 Follow the instructions in the task pane.



What if I want a transparent area in a picture created in JPEG 
format?
You can't make pictures created in JPEG file format transparent, but if the background in your 
Web page is very simple, you can create an illusion of transparency: Replace the area you want to 
look transparent with a solid color that is close to the background color in your Web page.



What if the background of my Web page is more than one color?
Estimate which color is the most predominant, then choose that color as the approximate 
background color for the Web page. If the background is dark, make sure that the color you 
choose is dark. If the background is bright, make sure that the color you choose is bright. If the
background color is between dark and bright, try using gray. If the color you choose for your 
background is not close to that of your Web page, you might create a "halo" around your image 
when it appears in a Web browser. Halos are caused by strong differences between colors around
the edges of your picture and the background. 



Sample instructions for viewing a Picture It! file attached to an e-
mail message
To copy the sample message:
1 Click anywhere to close this message. Then right click the window where the sample message 

appears and click copy. 
2 Paste the message into the body of your e-mail. You may edit it if you wish.



I'm sending you a slide show of some of my favorite pictures that I created using Microsoft 
Picture It! You won't believe how much fun I had doing it. I started with a few photos, and then 
used Picture It! to fix the colors, combine the pictures, and add text and special effects. 

To view the slide show, copy the attached file to a folder on your hard disk, and then double-click
the file. (Some e-mail programs, such as Microsoft Exchange and Outlook, let you double-click 
the slideshow right in the message.) The slide show will run automatically, but you can also 
control it manually by clicking the controls at the bottom of the window.

I hope you enjoy my pictures. Write back and let me know!

PS If you want to find out more about Picture It!, you can read about it on the Web at 
http://www.microsoft.com/pictureit. 



I'm sending you an e-mail postcard that I created using Microsoft Picture It! You won't believe 
how much fun it was. I started with a few photos, and then used Picture It! to fix the colors, 
combine the pictures, and add text and special effects. I can even add sound effects!

To view the postcard, copy the attached file to a folder on your hard disk and then double-click 
it. (Some e-mail programs, such as Microsoft Exchange and Outlook, let you double-click the 
postcard right in the message.) The postcard will appear automatically. Click "View Back of 
Postcard" to see the opposite side of the card.

I hope you enjoy the postcard. Write back and let me know!

PS If you want to find out more about Picture It!, you can read about it on the Web at 
http://www.microsoft.com/pictureit. 



I'm sending you a collage of some of my favorite pictures that I created using Microsoft Picture 
It! You won't believe how much fun it was. I started with a few photos, and then used Picture It! 
to fix the colors, combine the pictures, and add text and special effects.

To view the collage that is in the attached file, copy the file to a folder on your hard disk, and 
then double-click it. The picture should open in your Web browser or in one of your image viewing
programs. If it doesn't open, you may need to associate the file to your browser. Refer to the 
instructions that came with your browser to learn how to do this.

I hope you enjoy my pictures. Write back and let me know!

PS If you want to find out more about Picture It!, you can read about it on the Web at 
http://www.microsoft.com/pictureit.



Viewing a slide show I saved
You can view a saved slide show without ever starting Picture It! Just double-click the slide show
file in Microsoft Windows Explorer. If you save your slide shows in the location that Picture It! 
recommends, all your slide shows will be in the My Documents\For E-mailing from Picture It! 
folder on your computer.
1 On the desktop, double-click My Computer.
2 If you installed Picture It! by using the suggestions from the Setup program, double click 

these items: drive C, then Program Files, then Microsoft Picture It!, and then Slide Shows.
3 All of the slide shows that you created will appear as icons in Microsoft Windows Explorer. 

Double-click the one you want to view.



Creating new templates
You can create your own templates, and then come back repeatedly to edit them. To learn which 
features belong in each type of template, open an existing template from the CD and look at the 
stack.
1 Open the picture you want to use as the background into the picture pane.
2 Add text placeholders by adding sample text to the picture. Apply any text effects you want 

to preserve in the template.
            How?  
3 Add picture placeholders by clicking Pictures and Cutouts and then

clicking Add a Picture or Cutout to use a sample picture as a placeholder.
--or--

clicking Add a Colored Shape to use a colored shape as a placeholder.
Tip:    You can apply certain effects to the placeholders that can be preserved in the 
template.

            What effects can I apply to placeholders?  
5 Save each picture placeholder by applying at least one of these effects to it:

Crop (Preserves the size and shape of the placeholder)
Cool Edges (Preserves the size and shape of the placeholder)
Soft Edges (Does not preserve the size and shape of the placeholder but allows you to 

replace placeholders with different shaped objects)
Note:    Step 5 is essential, if you do not apply at least one of these effects, the Picture It! 
will not recognize the added object as a placeholder.

6 Save your template in the appropriate folder on your hard disk, so that you can retrieve it 
from Projects (see the list below). If you installed Picture It! using the recommended 
settings, the starting point for placing templates on your hard disk is C:\Program Files\
Microsoft Picture It!\Content\Projects. Here is a list of the templates that you can create 
along with their required locations in the Projects folder:

Project Folder
Albums Album
Note: Create a new folder under 
the Album folder to create a new 
set of Album templates

Business Cards Bizcards
Certificates Certif
Collages Collages
Greeting Cards:
Four-panel

Cards\Fourfold

Flyers Flyers
Funny Money Funmoney
Greeting Cards:
Side-fold 

Cards\Sidefold

Greeting Cards:
Three-panel 

Cards\Threfold

Greeting Cards:
Top-fold 

Cards\Topfold



Head Swap Headswap
Invitations Invites
Kids Ids Kids_ids
Magazine 
Covers

Magcovrs

Postcards Postcard
Stickers Stickers
Trading Cards Tradecrd

How do I repair a wrinkle in my picture?
1 Click the Zoom In indicator ("A" below) as many times as needed to get a good look at the 

object that you want to repair. Then move the Scroll box ("C" below) until it is over an area of
your picture that contains the scratch.

2 Center the pointer over one end of the wrinkle or scratch. Click where a wrinkle or scratch 
begins, and then click where it ends. The repair box should completely cover the scratch. 
Repeat for each wrinkle you want to repair.

Note: If you're having trouble removing the entire wrinkle or scratch at one time, click a larger 
ball in Zoom In indicator. The scratch repair box should be only a little wider than the scratch 
itself.



Why install the cataloging features?
The cataloging features of Microsoft Media Manager make it easier to find and keep track of 
the pictures and projects that you work on in Picture It! With the cataloging features you can:

Create and organize catalogs to group similar pictures for easy identification.
Assign key words and descriptions to the files you create.
View your pictures as thumbnail images before you open them.
Search your system for pictures based upon keywords, descriptions, or dates.

Related topics
            Installing Microsoft Media Manager  



How do I send pictures if my e-mail program does not support 
MAPI?
You can send your pictures to others even if your e-mail program doesn't support MAPI 
(Messaging Application Programming Interface). Just attach pictures to the e-mail messages 
that you compose in your e-mail program. Here are the basic steps. For more information, refer 
to the instructions that came with your e-mail program.
Do you want to send
            A picture from the workbench?  
            A slide show?  
            An email postcard?  



Sending a picture from the workbench
1 Click the Workbench tab.
2 Click Save & Send, and then click Send Via E-Mail.
3 In step 1 of the task pane, click the size you want. Then, in step 2, click Save the picture for

e-mailing later and then click Done.
4 In step 1 of the Save As task pane, click the folder where you want to store your picture. 

Then in step 3, type a name for your folder and then click Save.
5 Start your e-mail program and compose a message to your intended recipient.
            What should I put in my e-mail message?  
6 Follow the instructions in your e-mail program to attach the file you saved to the e-mail 

message you are sending.
Troubleshooting
            People are not receiving the pictures I send  



Sending a slide show
1 Click the Projects tab.
2 Click Active E-mail, and then click Slide Show.
3 Follow the steps for creating the slide show. When you get to step 5, click A slide show only.
4 In step 1 of the Save As task pane, click the folder on your hard disk where you want to 

store your slide show. In step 3, type a name for your slide show. Then click Save.
5 In the task pane, click Save it as a self-extracting slide show to send in e-mail later.
6 In step 1 of the Save As task pane, click the folder on your hard disk where you want to 

store your slideshow. Then, in step 3, type a name for your slide show. Then click Save and 
then click Done.

7 Start your e-mail program and compose a message to your intended recipient.
            What should I put in my e-mail message?  
8 Follow the instructions in your e-mail program to attach the file you saved to the e-mail 

message you are sending.
Troubleshooting
            People are not receiving the pictures I send  



Sending an e-mail postcard
1 Click the Projects tab.
2 Click Active E-Mail, and then click E-mail Postcard.
3 Follow the steps for creating the postcard. When you get to step 9, click Save It for e-

mailing later.
4 In step 1 of the Save As task pane, click the folder on your hard disk where you want to save 

your postcard. Then, in step 3, type a name for the postcard.
5 Click Save, and then click Done.
6 Start your e-mail program and compose a message to your intended recipient.
            What should I put in my e-mail message?  
7 Follow the instructions in your e-mail program to attach the file you saved to the e-mail 

message you’re sending.
Troubleshooting
            People are not receiving the pictures I send  



People are not receiving the pictures I send
Some IPSs (Internet Service Providers) have security features that are designed to protect 
themselves and their subscribers from receiving files that could damage their computers. 
Sometimes these protective measures prevent Picture It! pictures, slideshows, or e-mail postcards
from being transmitted to the intended recipient's computer. If you send a picture to someone 
who experiences this problem, you can either:

Post pictures to a Web page, and invite people to view them by using a browser.
Have your intended recipient contact their ISP to find out how to bypass the protections.



What effects can I apply to placeholders?
You can apply these effects to placeholders when creating your own templates:

Distort (Only effects that distort the whole object automatically)
Shadow
Make Transparent
Any edge effect
Rotate
Skew
Flip
Crop



Removing a wrinkle
1 On the Stack, click the object you want to repair.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Touchup, and then click Remove Wrinkle.
4 Zoom in for a closer look at the wrinkle.
            How?  
5 Follow the instructions in the task pane. 
Troubleshooting
            What if I change my mind?  



Making a Photo Album page using a template
1 Click the Projects tab.
2 Click Collages, and then click Photo Album Pages.
3 Follow the instructions in the task pane. 
Tips
            How can I keep my pictures a standard size?  



Learning about the different parts of the Picture It! screen
What do you want to learn about? 
            The Stack  
            The Retriever  
            The Filmstrip  
            The Zoom & Scroll tool  



Solving problems
What kind of problem are you having? 
            I'm not getting the results I expected  
            I'm having trouble with my scanner  
            I'm having trouble with my digital camera  
            I'm having trouble printing  
            I'm having other problems  



I'm not getting the results I expected
What problem are you having? 
            I want to undo a change  
            The shadow I added to an object does not show  
            The edge I added to an object does not show  
            I can't find the picture I am looking for  
            There are no pictures for me to open in the picture pane  



General problems
What problem are you having? 
            My computer is out of storage space  
            Picture It! won't start  
            My computer is running out of memory  
            I saw a No Write Access message  
            I saw a Device Not Available message  
            People are not receiving the pictures I send by e-mail  
            I want to delete a stamp I created from my computer  



Tips on sending e-mail
Here are some things to consider when you send pictures to friends by e-mail.

To use Picture It! to send a picture, your e-mail program must support MAPI (Messaging 
Application Programming Interface).    
            What if my e-mail program does not support MAPI?  

Only send one file with each e-mail message. Some e-mail programs, cannot accept more 
than one attachment in a single message.

Try to keep the total size of your message and any attached file below 2 MB. Larger files 
take longer to download, and some Internet services limit the amount of disk space their 
subscribers can use or the size of incoming messages.    



My pictures don't look good on other computers
Pictures created in Picture It! look best when viewed on computers set for 16-bit color (greater 
than 64K colors) or better. Some computers are set to show only 256- or 16 colors at one time. 
By changing the display settings to allow more colors to show at one time, your pictures will look 
their best. In Microsoft Windows 95 or 98, or NT Workstation 4.0 or later, here’s how to do it:
1 Save any open documents and close all open programs.
2 On the Start Menu, point to Settings, and then click Control Panel.
3 Double-click Display.
4 In the Display Properties dialog box, click the Settings tab.
5 In the Color Palette list, click any choice higher than 256 colors. 
6 Accept the changes and restart your computer, if necessary.
If you send your pictures to people who use computers with a different operating system, ask 
them to check their documentation to learn how to change display settings.



How do I close a picture?
If the picture you want to close is not currently in the picture pane, you need to put it there.
1 On the Filmstrip, double-click the picture you want to close.

The picture will appear in the picture pane. 
2 Click Close the current picture.



Making business materials
1 Click the Projects tab.
2 Click Business, and then double-click the project you want to make.
3 Follow the instructions in the task pane. 



Making an e-mail postcard
1 Click the Projects tab.
2 Click Active E-mail, and then click the project you want to make.
3 Follow the instructions in the task pane. 



Tell me more about Microsoft Media Manager
Microsoft Media Manager is a program that works with Microsoft Windows Explorer to help you 
manage media files on your computer. In Picture It!, you can then include descriptions of your 
pictures with their files, making it easier for you to remember important details about your 
pictures. Media Manager also helps you to find the pictures you want by providing you with tools 
to search for pictures by key words.
Related Topics
            Opening the Microsoft Media Manager Help  
            Installing Microsoft Media Manager  



Opening the Microsoft Media Manager Help
1 Click the Microsoft Windows Start button.
2 Point to Find, and then click Files or Folders in Media Manager.
3 On the Help menu in the Media Manager Find dialog box, click Microsoft Media Manager 

Help Topics.



Change a color picture to black and white
1 On the Stack, click the object you want to change.
            I haven't yet cut out the object  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Paint & Color Effects, and then click Black & White.
4 Follow the instructions in the task pane.



How do I touchup paint by dragging?
Click the spot where you want to start, then drag your pointer acrosss the area where you want 
to paint. For best results, try to complete your painting without releasing the mouse    button. 

If you paint over an area more than once, without releasing the mouse button, it will look as 
if you painted over that area once.

If you release the mouse button and then start painting over an area you touched up earlier,
it will look as if you painted more than once. 



Which collage method should I choose?
Choose Collage with a Template to quickly make a collage using a ready-made Picture It! 

layout. Just open the template, drop in your pictures, type your own words, and you're done.
Choose Photo Album Page to quickly make more than one collage by using a common theme. 

Select the theme you want, and then select the template to use. By creating Photo Album Pages, you
can create a whole book of your pictures.

Choose Create on My Own to start with a blank canvas and design your own collage.



Skewing an object
1 On the Stack, click the object you want to skew.
            I haven't yet cut out the object I want to change  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Size & Position, and then click Skew.
4 In the picture pane, drag the side selection handles ("D" below) horizontally or vertically for 

the shape you want.

Troubleshooting
            What if I change my mind?  



Restoring an old or faded picture
1 On the Stack, click the object you want to restore.
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Old to New.
4 Follow the instructions in the task pane. 
Troubleshooting
            What if I change my mind?  



Making an object stand out from the rest of the picture
1 On the Stack, click the object you want to emphasize.
            I haven't yet cut out the object  
            Where's the Stack?  
2 Click the Workbench tab.
3 Click Special Effects, and then click Emphasize.
4 Follow the instructions in the task pane.



Saving pictures to put on Web pages
1 On the Filmstrip, double-click the picture you want to save.
            My picture is not in the Filmstrip  
2 Click the Workbench tab.
3 Click Save & Send, and then click Save for the Web.
4 Follow the instructions in the task pane



Changing the order of my pictures in a slide show
Slide shows display pictures in the same order that they appear in the Filmstrip, from left to 
right. To change the sequence for pictures in the slide show, drag the pictures in the Filmstrip to
the desired locations.



What is a self-extracting slide show?
A self-extracting slide show can be shown on computers that do not have Picture It! installed on 
them and is ideal for sending as an attachment in e-mail. To view a self-extracting slide show, the
recipient needs to have Microsoft Windows 95 or98, or NT Workstation 4.0 or later.



What does changing scanner and digital camera performance do?
Newer scanners and digital cameras have special programs that allow them to make better use of
your computer's memory when downloading or scanning pictures. This usually results in faster 
performance and more available memory for working on your projects. Selecting Enhanced 
(recommended) allows you to take advantage of these features.
If you experience problems downloading or scanning, switch to Normal. This may slow down your 
computer while scanning or downloading.



What should I do when I get a TWAIN message?
Here are some things to try if you have problems loading pictures into Picture It! with your 
scanner or digital camera.

Sometimes there’s just a minor problem in your system that prevents Picture It! from 
communicating with your scanner or camera. Make sure that your scanner or camera is turned on 
and properly connected to your computer, then try to load again. You might also want to close all 
your programs and restart your computer. 

If Picture It! was not packaged with your scanner or camera, it’s possible that the drivers 
you have are not the right ones to use with Picture It! Contact the manufacturer for updated 
software.
            Can I look them up on the web?  

On the View Menu, click Options, and then in Scanner/Camera options, select Normal.
Check to see if your scanner or camera is one of the types that has been known to have 

compatibility problems with Picture It!
            What devices have documented problems?  



Finding scanner and digital camera manufacturers on the WWW
Most scanner and digital camera manufacturers offer the latest drivers for their products as 
free downloads from their Web sites. Here are the Web addresses of some companies. Click the 
company you’re interested in to go to their Web site.

          Agfa:    (www.agfahome.com)  
          Canon Computer Systems, Inc. (USA):    (www.ccsi.canon.com)  

            Casio    (www.casio.com)  
            Envisions:    (www.envisions.com)  
            Epson:    (www.epson.com)  
            HP:    (www.hp.com)  
            Kodak:    (www.kodak.com)  
            Logitech:    (www.logitech.com)  
            Microtek:    (www.microtekusa.com)  
            Mustek:    (www.mustek.com)  
            Plustek:    (www.plustek.com)  
            Polaroid:    (www.polaroid.com)  
            Relisys:    (www.relisys.com)  
            Ricoh:    (www.ricoh.com)  
            Sony:    (www.sony.com)  
            Spot Technologies    (www.spotinc.com)  
            Storm Software:    (www.easyphoto.com/storm/index.html)  
            Tamarack Technologies:    (www.tamarack.net)  
            UMAX:    (www.umax.com)  
Note If the company you’re looking for is not listed here, check your documentation for 
information on how to contact them.



What scanners or digital cameras are known to have problems 
with Picture It!
Here is a list of scanners and digital cameras that have been known to have compatibility 
problems with Picture It! Click below to see if the problem you are having has been solved. 
            Agfa StudioScan?  
            Canon scanners  
            Casio digital cameras  
            Envisions scanners  
            Epson scanners  
            Microtek scanners  
            Mustek scanners  
            Sony digital cameras  
            Spot Technologies  
            Storm EasyPhoto Reader  
            UMAX scanners  
If you can't find the information you need from this list, check the Picture It! Read Me, or 
contact the manufacturer to see if a solution has been found since this help was written.
            Picture It! Readme  
            Scanner and Digital Camera companies on the WWW  



Why doesn't Picture It! support my version of TWAIN?
If you added a new scanner or digital camera after you installed Picture It!, the scanner’s or 
camera’s installation program might have overwritten an essential file. Try reinstalling Picture It!
to get the file back.
Related topics
            General scanner and camera information  
            Check the list of documented scanner or digital camera problems.  



Why is my picture too large?
The larger a picture is, the longer it takes to scan, and the more memory your computer needs to 
work on it. For this reason, Picture It! limits the length and width of pictures you can scan to less
than 3968 x 3968 pixels. 

Scan at a lower resolution or scan a smaller portion of the picture.
Try using the Smart Task Scan feature if your scanner supports it.

To find out more about controlling the height and width of your picture, refer to your scanner 
hardware documentation.
Related topics
            General scanner and camera information  



My scanner or digital camera does not show up in the task pane
Your scanner or digital camera uses special programs (drivers), called TWAIN, to communicate 
with Picture It! For some reason, those programs are either missing from your computer, or they 
weren't installed correctly. Check the documentation that came with your scanner or camera to 
make sure that you correctly installed the programs on your computer. 
Note:    If your copy of Picture It! was packaged with your scanner or digital camera, check the 
box for another diskette or CD that contain the other programs.
            I can't connect my camera to my computer  
Related topics
            General scanner and camera information  



Smart Task Scan does not work
Even if you just bought your scanner, it could have been manufactured and delivered to the store
you bought it from before the scanning technology required to support SmartScan was 
perfected. The company that manufactured your scanner might have since updated the drivers to
support SmartScan. If they did, you can probably get the required files free of charge by 
contacting the scanner manufacturer directly or by checking their Web site.
            Finding scanner and digital camera manufacturers on the Web  
If you can't find a newer driver, or if you still have problems after you update the driver, the 
problem might be that your scanner does not support the Smart Task Scanning features in 
Picture It! Try scanning using the Your scanner software option in the Scan task. 
Related topics
            General scanner and camera information  



General scanner and camera information 
Follow these steps to solve general problems associated with scanning or downloading pictures.

Make sure your scanner or camera is turned on and properly connected to the computer. If 
any conections are loose, or if your scanner or camera was off, correct the problem and then 
restart your computer. 

Make sure you have the latest drivers for your scanner or digital camera, and that they’re 
properly installed.
            How can I check whether the drivers are properly installed?  
            Finding scanner and digital camera manufacturers on the Web  

On the View Menu, click Options, click Scanner/Camera Options, and click Normal.
If you clicked Smart Task Scan when you last scanned, click Your scanner software 

instead.
Reinstall Picture It!

Related topics
            What scanners and digital cameras are documented to have problems working with Picture   

It!



Agfa StudioScan
FotoLook software    To scan pictures into Picture It!, Microsoft Windows 95 needs to use 
FotoLook version 2.08 or later. 
PNR SCSI card drivers    If you’re using a SCSI card that came with your Agfa scanner (for 
example, the PNR SCSI card), you might not be able to scan by using the 32-bit driver. Instead, 
use the 16-bit driver. In the Scan Picture task pane, two scanner drivers should be listed:

FotoLook 16 V2.08 - TWAIN
FotoLook 95 V2.08 - TWAIN.

Select FotoLook 16 V2.08. If you would like to use the 32-bit driver, you will need to get an 
Adaptec-compatible SCSI card. You can contact Agfa for technical support information at 
http://www.agfahome.com.



Canon scanners
If you use a Canon scanner and have problems with the Picture It! Smart Task Scan feature, you 
might need to get the latest version of Cannon's scanning software. You should be using 
ScanCraft 3.1 or later.
You can contact Canon for software update information at the following telephone numbers and 
home page addresses:

Area Addresses and 
Phone Numbers

Worldwid
e: 

www.canon.com

United 
States: 

Canon Computer 
Systems, Inc. (USA)
800-423-2366
www.ccsi.canon.com

Canada: Canon Canada, Inc.
800-263-1121

Envisions scanners
Scan quality    If you use an Envisions scanner and DynaScan software, improper settings in 
DynaScan Auto Pilot feature might interfere with Smart Task Scan, producing images that are 
mostly black and white and of poor quality.
To correct the problem, try the following steps:
1 Click Get Picture, and then click Scan Picture.
2 In the Click a scanner box, select the Envisions scanner.
3 Near the bottom of the task pane, click Custom Scan, and then click Scan. 
4 In the DynaScan window, click the Settings menu, and then select Reset Settings.
5 Verify the change that you made in step 4 by clicking the R, G, and B buttons so that the 

Shadow setting of each button is close to zero (the closer the better).
6 Make sure that the Auto Pilot feature is turned off (the check box should be empty).
7 Click the Scan button to save the settings. This step is essential--exiting DynaScan without 

scanning the picture resets the scanner to its original settings.
8 Click Get Picture, and then click Scan Picture.
9 In the Click a scanner box, select the Envisions scanner.
10 Near the bottom of the task pane, click Smart Task Scan, and then click Scan. 
Cropping and rotation problems    If you use Envisions DynaScan software, then when you use 
Picture It! Smart Task Scan, you might have trouble getting pictures that are properly cropped. 
This problem occurs when you use the Picture It! Custom Scan feature, and then select the image
rotation in the DynaScan software. One symptom of this problem is that in the preview scan you 
might see a correctly cropped image, but in the final scan, you see a rotated and incorrectly 
cropped picture. DynaScan software rotates the image but does not communicate the rotation to 
the Smart Task Scan. Correct this problem by following this procedure:
1 On the Workbench, click Get Picture, and then click Scan Picture.
2 In the Click a Scanner box, select the Envisions scanner.
3 Near the bottom of the task pane, click Custom Scan.



4 Click Scan.
5 In the DynaScan window, look for a button with a capital "R" that is surrounded by four 

arrows. Click this button until the R is in the upright position (not rotated).
6 Save the settings by clicking Scan. This step is essential--exiting DynaScan without scanning 

the picture resets the scanner to its original settings.
7 Click Get Picture, and then click Scan Picture.
8 In the Click a scanner box, select the Envisions scanner.
9 Near the bottom of the task pane, click Smart Task Scan, and then click Scan. 



Epson scanners
If you use an Epson ActionScanner II scanner, then when you use the 16-bit Epson driver, you 
can’t use the Picture It! Custom Scan feature.
If you have a recent model Epson scanner, you'll see both 16-bit and 32-bit drivers listed in the 
SCAN PICTURE task pane. Be sure to choose the 32-bit driver--"EPSON Scanners (32 bit)."    
If your scanner doesn't have a 32-bit driver, you'll see only the 16-bit driver--"EPSON Scanners
(16 bit)" - listed in the SCAN PICTURE task pane. To use Custom Scan, you can download the 
latest 32-bit drivers by contacting Epson at www.epson.com.



Microtek scanners
“Picture is too large”
If you set the scaling factor at 100% in ScanWizard, and scan with a Microtek scanner, then 
when you use the Smart Task Scan feature, you'll probably receive an alert message telling you 
the "Picture Is Too Large." This problem has been found in ScanWizard versions 2.38 and earlier.
It has been fixed in version 2.39. If you don't have the newer version, you can try the following 
steps:
1 Launch Picture It!
2 Start the Scan task 
            How  
3 Select the Microtek scanner.
4 Select the Your scanner software button.
5 Click the Scan button.
6 When the ScanWizard application appears, set the scaling to 100%, and then turn off the 
Auto Contrast checkbox. Refer to your Microtek scanner manual for details.
7 Close the ScanWizard software.
You should be able to scan correctly now.
Scanner turned off
Always make sure that your Microtek scanner is turned on before you scan. If you try to scan 
with your Microtek scanner turned off, you could close Picture It! without saving changes to any 
currently open pictures. This problem exists on ScanWizard version 2.38 and earlier. It might be 
fixed in future versions of ScanWizard. Contact Microtek at www.microtekusa.com for software 
update information.



Mustek scanners
The Picture It! Smart Task Scan feature might not work with Mustek scanners. Mustek might 
have fixed the driver error in their updated scanning software. Contact Mustek at 
www.mustek.com for software update information. 
If updating the scanning software does not fix the problem, you'll need to scan using the Custom 
Scan feature.



Spot technologies 
If you're using a driver that is older than V 1.16, then the ScanTek-2c scanner might lock up 
during scanning. The updated driver is available on the ScanTek Web page at www.spotinc.com.



Storm EasyPhoto Reader
To scan pictures into Picture It! with a Storm EasyPhoto Reader, you need to use EasyPhoto 
version 2.112 or later. If your scanner uses version 2.0, contact Storm for software update 
information at www.easyphoto.com/storm/index.html.



UMAX scanners
Some versions of UMAX VistaScan software won’t scan if you've selected Print at Kodak 
PhotoNet--the system might close unexpectedly. Until a newer version of UMAX VistaScan 
software comes out, avoid scanning when you upload images to Kodak. Contact UMAX Systems at 
www.umax.com for software update information.



Casio digital cameras
Canceling downloads fails in Casio digital cameras. 
You might encounter a problem canceling image downloads from Casio digital cameras. This 
problem doesn’t cause Picture It! to close unexpectedly, nor does it cause any other serious 
problems. It might be fixed in a later version of the Casio software. Contact Casio at 
www.casio.com for software update information.



Sony cameras 
If you're using version 1.0 of the Sony DSC-F1 digital camera software, you might notice that 
you can't download more than one picture at a time. Downloading multiple pictures could close 
Picture It! without saving changes to any currently open pictures. This problem has been fixed in 
newer versions of the digital camera software. You can download an updated version of this 
software from Sony's web site at www.sony.com.



TWAIN Internal Error
Picture It! can't communicate with your scanner or digital camera because of other programs 
that are open or were opened earlier, or because of a loose connection between your computer 
and the scanner or digital camera. Try these suggestions to fix the problem:

Check to see if the drivers for your scanner or digital camera have documented problems 
working with Picture It!
            What devices have documented problems?  

Close Picture It!, start it again, and then try scanning or downloading your picture.
Close all programs, and then turn off your computer and your scanner or digital camera. 

Check to make sure that all cables are properly attached, wait a minute before starting everything, 
then try again. .

If you obtained Picture It! after you got your scanner or digital camera, check to see if 
there is a new driver available. If there is, install that driver, and then try again. 
            What is the web address of my scanner or digital camera manufacturer?  



I can't see the pictures from my digital camera
Some digital cameras save their pictures to a removable disk that you can insert in the disk drive
of your computer. If your camera is one of these, then you can load pictures into Picture It! the 
same way that you open other previously saved pictures.
            Open a picture  
If your camera requires you to download pictures into Picture It!, first make sure that your 
camera is properly connected to your computer.
1 Close all the programs on your computer, and then quit Microsoft Windows.
2 When it's safe to turn off your computer, turn it off, and then wait for about one minute.
3 Make sure that your camera is turned on and still connected to your computer.
4 Start your computer, and then start Picture It!.
5 Try to download your pictures again.
            What if I can't connect my camera to my computer?  



I can't connect my camera to my computer
Some digital cameras are not designed to connect to a PC. Instead, they save images to a 
diskette or some other removable storage device, such as a PCMCIA card. 
If your digital camera stores images on a floppy disk, here's how to retrieve the images:
1 Put the disk in your disk drive
2 On the Workbench, click Get Picture, and then click My Picture.
3 In the task pane, go to the Click a folder box, and then select your disk drive.
Related topics
            General scanner and camera information  



I still can't download
Try downloading pictures to you camera using the digital camera's software instead of using 
Picture It! If you still have problems, contact the manufacturer.
            I was able to download when I did not use Picture It!  



Connecting to the Kodak PhotoNet Web page
You can use the Internet to store, view, print, and share your pictures with friends at Kodak 
PhotoNet. The Kodak PhotoNet web site contains nore information about the services that are 
available. To access this site, you need to be able to connect to the Internet by using a Web 
browser, such as Microsoft Internet Explorer, and an online service or Internet service provider,
such as the Microsoft Network.
1 Click the Projects tab.
2 Click Go Online, and then click Kodak PhotoNet.



What can I print at Kodak PhotoNet?
You can print high-quality reprints in a variety of standard photographic sizes.
To get the quality results you want, the projects you send to Kodak PhotoNet for printing should 
include only high-resolution photographs. If you use low-resolution pictures, digital camera 
images, or clip art, you may be dissatisfied with the results.



How much does it cost to print at Kodak PhotoNet?
When printing at Kodak PhotoNet, you pay for your print, shipping, and, depending on your 
Internet service provider, you may also have to pay for the online connect time.
Charges by Kodak PhotoNet are specified on the Kodak PhotoNet Website. You always have the 
opportunity to review, accept, or decline the charges before finalizing a transaction..



Copyrights and Kodak PhotoNet
Before ordering from Kodak PhotoNet, you need to make sure you have the rights to reproduce 
the photographs that you’re sending.
You may not use Kodak PhotoNet to distribute material that infringes on or violates the rights of
others, or that may be viewed as defamatory, deceptive, misleading, offensive, or indecent.
It is illegal to reproduce photographs taken by a professional photographer or to reproduce 
other copyrighted material without the permission of the copyright owner. To help determine 
whether the copyright to a photograph is owned by someone else, consider whether any of the 
following is true. Please note that this is not a complete list.

· A photographer was paid to take the photograph.
· The photograph is a formal wedding or school photograph.
· The photograph was taken in a studio setting.
· The photograph appears in a book, magazine, newspaper, or advertisement.
· The photograph has the name of the photographer or studio on it.
· The photograph has a copyright notice on it (for example, Copyright 1997).
If one of the preceding statements applies to your photograph, you may not own the copyright 
and therefore you must have written permission from the photographer to copy it. 



Kodak PhotoNet technical help
For up-to-date Kodak PhotoNet technical help, customer service information, and answers to 
frequently asked questions, visit the Kodak PhotoNet Web site located at: 
http://home.photonet.com/
You can also contact Kodak technical support by using the following methods:

Phone number:    1-888-FUN-PICS (1-888-386-7427)
E-mail: netpics@photonet.com
FAQ web page: http://home.photonet.com/faq/



Printing at Kodak PhotoNet
1 Click the Workbench tab.
2 Click Print, and then click Print at Kodak PhotoNet.
3 Follow the instructions in the task pane.
Note: You may print up to 40 pictures to Kodak PhotoNet in a single session.
Tips
            What can I print at Kodak PhotoNet?  
            The cost of printing at Kodak PhotoNet  
            More about printing at Kodak PhotoNet  
            Copyrights and the Kodak PhotoNet print Service  
            Kodak PhotoNet technical help  



Tell me more about printing at Kodak PhotoNet
With Kodak PhotoNet, you can order high-quality prints and photo gift items over the Internet.
To order from Kodak PhotoNet, you need to be able to connect to the Internet using a 
compatible Web browser, such as Microsoft Internet Explorer, and an online service or Internet 
service provider. Then you can open up to 40 pictures at one time into the Filmstrip to print at 
Kodak PhotoNet.
There may be charges for items ordered through Kodak PhotoNet. You can view the charges 
before submitting your order. Prices vary depending on the items, sizes, and quantities you order.
You need to pay for your order with a credit card at the time of purchase. Your credit card 
information is secured using advanced encryption technology.



What does selecting a print size do?
The print size and orientation you choose tells how to print your picture.
From the list of standard photographic reprint choices, click the dimensions and orientation you 
want for your picture 
Note:    Landscape prints are wider than they are tall, and portrait prints are taller than they are 
wide.



Printing a picture
What do you want to do? 
            Print a picture on my own printer  
            Print more than one picture on a page  
            Print my picture at Kodak PhotoNet  
            Print my picture at Fujifilm  



Opening, scanning, or downloading a picture
What do you want to do? 
            Open a picture  
            Scan a picture  
            Get a picture from the Picture It! CD-ROM  
            Download a picture from a digital camera  
            Download a picture from Kodak PhotoNet  



Saving and organizing my pictures and projects
What do you want to do? 
            Save a picture  
            Close a picture  
            Save a picture as wallpaper  
            Organize my pictures in a Picture It! Catalog  
            What's a Catalog?  
            Store pictures at Kodak PhotoNet  



Tell me about printing at Fujifilm
Print at Fujifilm offers you a great and easy way to order high quality prints and gift items using
your pictures from Picture It! Right from your computer, you can order photograph-quality prints
of your images. You can also use your favorite pictures on great gift items.
Here's how to learn more about the services Fujifilm offers in your country.
1 Click the Projects tab.
2 Click Go Online, and then click Fujifilm.



Printing at Fujifilm
1 Click the Workbench tab.
2 Click Print, and then click Print at Fujifilm.
3 Follow the instructions in the task pane.
Tips
            Tell me about printing at Fujifilm  



Should I continue to upload?
The last time you tried to upload to Fujifilm using Print at Fujifilm, something happened that 
prevented your order from being uploaded. Before Picture It! can print anything else at Fujifilm, 
you need to complete or cancel your previous order. 

Click If you want to

Upload 
Now

Try to upload your last 
order again.

Cancel 
the 
Order

Cancel your last order and 
start a new one.



Downloading pictures from a new roll of film at Kodak PhotoNet
Any roll of film that you haven't viewed in Picture It! is considered a new roll, even if you've 
viewed it several times by using other tools.
1 Click the Workbench tab.
2 Click Get Picture, and then click Open from Kodak PhotoNet.
3 In step 1, click View a new roll. 

A dialog box opens for you to identify yourself and the role of film you want to add.
4 If you aren't currently connected to the Internet, your Internet service provider login 

screen will appear for you to establish the connection.
5 In the Name box, type your name, and in the Film Id box, type the film identification 

number you received from Kodak PhotoNet.
6 To specify the resolution you'll use to download your picture, click the small arrow to the 

right of Picture quality, and then click Low, Medium, or High.
Note: Kodak PhotoNet may charge an additional download fee, depending on the size and 
number od pictures you download.

            How can I reduce my Kodak PhotoNet charges?  
7 To select a picture to download onto your computer, click the thumbnail you want, and then 

drag it onto the Filmstrip.
Tip: To download more than one picture at a time, hold down CTRL and drag the thumbnails 
onto the Filmstrip.

8 If you're not being billed for the download, and you see your picture on the Filmstrip, skip to 
step 11.
--or--
In the "OK to Bill?" message, click OK to proceed with downloading your picture to your 
computer.

9 In the Billing Information Screen, type your name, address, telephone number, e-mail 
address, major credit card number, and credit card expiration date. If you want your credit 
card information to automatically appear next time you use Kodak PhotoNet, click Remember 
Credit Card Information.

10 To process your billing information, submit a charge to your credit card, and download your 
picture onto your computer, click OK.

11 Click Done, then in the Internet logoff reminder message, click OK.
Note: Picture It! will not log off your Internet service provider for you.

Troubleshooting
            Kodak PhotoNet problems  
Tips
            What is Kodak PhotoNet?  
            What do I need to use Kodak PhotoNet's services?  
            Tips on reducing Kodak PhotoNet charges  



Downloading pictures from a roll of film that you've already 
viewed at Kodak PhotoNet
1 Click the Workbench tab.
2 Click Get Picture, and then click Open form Kodak PhotoNet.
3 Click the film identification number you want, and then in the Internet message that appears,

click OK.
4 If you're not currently connected to the Internet, your Internet service provider login 

screen will appear for you to establish the connection.
5 To specify the resolution you'll use to download your picture, click the small arrow to the 

right of Picture quality, and click Low, Medium, or High.
Note: Kodak PhotoNet may charge an additional download fee, depending on the size and 
number of pictures you download.

            How can I reduce my Kodak PhotoNet charges?  
6 To select a picture to download onto your computer, click the thumbnail you want, and then 

drag it onto the Filmstrip.
Tip: To download more than one picture at a time, press CTRL and drag the thumbnails onto 
the Filmstrip.

7 In the "OK to Bill?" message, click OK to proceed with downloading your picture to your 
computer. If you do not see an OK to bill message, skip to step 10.

8 In the Billing Information Screen, type your name, address, telephone number, e-mail 
address, major credit card number, and credit card expiration date. If you want your credit 
card information removed from the screen when you're done, click Remember Credit Card 
Information to remove the check mark.

9 To process your billing information, submit a charge to your credit card, and download your 
picture onto your computer, click OK.

10 Click Done, and in the Internet logoff reminder message, click OK.
Note: Picture It! will not log off your Internet service provider for you.

Troubleshooting
            Kodak PhotoNet problems  
Tips
            What is Kodak PhotoNet?  
            What do I need to use Kodak PhotoNet's services?  
            Tips on reducing Kodak PhotoNet download charges  



Saving your picture at Kodak PhotoNet
To save your pictures at Kodak PhotoNet, make sure that the picture you want to save is in the 
picture pane. To save more than one picture, repeat this procedure.
1 On the Filmstrip, double-click the picture you want to save.
            My picture is not in the Filmstrip  
1 Click the Workbench tab.
2 Click Save & Send, and then click Save to Kodak PhotoNet.
3 If you're saving your picture to an existing roll of film, click An existing roll, and then choose

the roll you want.
--or--
Click A new roll.

4 In the Internet message that appears, click OK.
If you're not currently connected to the Internet, your Internet service provider login 
screen will appear for you to establish the connection.

5 Click Save.
6 Type your name, telephone number, and e-mail address where indicated, and then click OK.
7 If you're not being billed for the upload, and you see your picture in the picture pane, in the 

Images Remaining message click OK, and then skip to step 10.
--or--
In the "OK to Bill?" message, click OK to proceed with uploading your picture to Kodak 
PhotoNet.
Note: Kodak PhotoNet charges an upload fee for the first picture you save to an existing roll 
of film at Kodak PhotoNet. For 30 days thereafter, you can save up to 35 more pictures to 
the same roll of film at no charge.

8 In the Billing Information Screen, type your name, address, telephone number, e-mail 
address, major credit card number, and credit card expiration date. If you want your credit 
card information removed from the screen when you're done, click Remember Credit Card 
Information to remove the check mark.

9 To process your billing information, submit a charge to your credit card, and upload your 
picture to Kodak PhotoNet, and then click OK.

10 In the Internet logoff reminder message, click OK, and then disconnect your computer from 
the Internet.

Troubleshooting
            Kodak PhotoNet problems  
Tips
            What is Kodak PhotoNet?  
            What do I need to use Kodak PhotoNet's services?  



Contacting Kodak PhotoNet
For assistance, you can contact Kodak PhotoNet at:

Phone number:    1-888-FUN-PICS (1-888-386-7427)
E-mail: netpics@photonet.com
FAQ web page: http://home.photonet.com/faq/



I can't find my roll of film or forgot its ID number
Rolls of film that you store on Kodak PhotoNet will not appear in Picture It! until you add them to
the program. If you do not see the roll of film you want in Picture It!, try adding it as a new roll. 
Make sure to type the film identification number Kodak PhotoNet sent you exactly as it appears. 
If you still have problems, or cannot find the film ID number, call or write Kodak PhotoNet. 

Phone number:    1-888-FUN-PICS (1-888-386-7427)
E-mail: netpics@photonet.com



I can't log on to Kodak PhotoNet
If you are connecting to the Kodak PhotoNet site with an external modem, make sure it is 

turned on, and all the cables are completely plugged into the correct outlets. 
If you are using an internal modem to connect, make sure the telephone line is securely 

plugged into the correct outlet.
If the Kodak PhotoNet site on the Internet is temporarily unavailable, try logging on again 

later.
Quit Picture It!, start Picture It! a second time, and try logging on to Kodak PhotoNet again.



Missing or incorrect billing information
Verify that you have typed correct information in the name, address, and credit card information
areas.



What is Kodak PhotoNet?
Kodak PhotoNet provides one more method for you to get your pictures into Picture It! and then 
share them with your friends and family members. 
Kodak PhotoNet digitizes the photographs on your rolls of film, and then stores these high-
resolution images on the Internet. Many photofinishing companies now offer Kodak PhotoNet's 
service.
After Kodak PhotoNet has processed your pictures, you will receive an e-mail message with a 
unique film identification number. With this number, you can:

View your pictures.
Download some or all of the pictures to your computer.
Send e-mail to a friend telling them how to view or download your pictures to their 

computer.
Store other pictures from Picture It! on this roll of film on the Internet.

For more information visit the Kodak PhotoNet Web site at:
http://www.photonet.com
Tips
            What do I need to use Kodak PhotoNet's services?  



What do I need to use Kodak PhotoNet's services?
To use the Kodak PhotoNet features in Picture It!, you need the following:

A modem or network connection to the Internet.
An Internet service provider (ISP), such as MSN.
A major credit card for the billing charges. Kodak PhotoNet accepts VISA, MasterCard, 

American Express, and Diner's Club.



Tips on Kodak PhotoNet's charges
In addition to the processing fee, Kodak PhotoNet may chargea for downloading pictures to your 
computer.
Each time you download a high-resolution picture from Kodak PhotoNet, you may be charged a 
download fee..
To reduce the cost of using Kodak PhotoNet, try:

Using medium or low resolution whenever possible
Experimenting to see how many pictures you can download at one time, and still stay within 

the basic charge. To find the maximum number of images you can download, click a single thumbnail 
in the preview pane, click Open, note the basic charge, and then click Cancel. Repeat this 
procedure, only this time hold down the CTRL and click two thumbnails to download. Continue in this 
manner, adding one more picture each time, until the billing charge increases.
The first time you add a picture to an existing roll of your film or create a new roll of film at 
Kodak PhotoNet, you are charged a minimum fee. You can then upload up to 35 more pictures 
without charge.
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How do I stamp by dragging in the picture pane?
Use your mouse to apply any combination of strokes for the effect you want. 
Click on the spot where you want to start, and drag to where you want to paint or stamp. If you 
only want a single stamp, click where you want to place the stamp.
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System requirements
Microsoft Picture It! requires:

Pentium PC 
Windows 95 or 98 or Windows NT 4.0 or later
16 meg of RAM
90 megabytes of hard drive space

NT users using DBCS folder names should have NT Service Pack 2 or above installed.



Out of memory / Disk space messages
When you work in Microsoft Picture It!, large amounts of image data are stored in temporary files 
that use space on your hard drive. Picture It! uses the system's Temporary drive setting to 
determine where these temporary files should be stored. These temporary files are removed when 
Picture It! closes. Picture It! checks and warns when less than 30 megabytes of free disk space is 
available. If you receive "Out of memory/disk space" errors when using Microsoft Windows 95 or 
98, and you have space available on another hard drive, alter your default setting as follows:

1 From the Start menu, click Run, and then type "SYSEDIT". Press ENTER.

2 Select the Autoexec.bat window 

3 Look for a line that indicates TMP= or TEMP=. If there is such a line, check that the drive 
letter and the location it points to has free space, or change the drive letter to indicate a 
drive with free space.

4 If there is not a line with TMP= or TEMP=, the default will be the TEMP folder in your 
Windows directory. If you want to set Microsoft Windows to use another drive for its 
temporary space, add a the following line to the AUTOEXEC.BAT window and then click Save 
on the File menu.

SET TMP= D:\TEMP    (e.g. drive and path of new temporary location)

Note:    All programs that use temporary files will now write to this new location.    

It is also a good idea to periodically check and delete old files in the temporary folder (e.g. \
WINDOWS\TEMP), especially if applications have terminated abnormally. 



Performance
When Microsoft Picture It! applies effects and manipulates images, it usually operates on a 
significant amount of data. Improve performance by adding memory and turning on "Virtual 
Memory." 

To be sure you have virtual memory turned on, do the following:

1 Right click My Computer.

2 Click Properties.

3 Click the Performance tab.

4 Click Virtual Memory.

5 Be sure the Let Windows manage my virtual memory settings option is checked.

Some tasks, such as Illusions and Remove Dust & Blemish will still be slow because of the complexity
of the work they do. 



Turning sound on and off
If you’re having trouble with sound in Microsoft Picture It!,    make sure your sound card is installed 
correctly and your volume is turned up.

Try to play a sound in another Microsoft Windows application to confirm that your sound is working.
If it is, check Options on the View menu in Picture It! to be sure the Play Picture It! sounds box is 
checked.

If that doesn’t work, you may not have audio compression installed for your sound card. To install 
audio compression:

1 In Microsoft Windows, click the Start button, point to Settings, and then click Control Panel.

2 Double-click Add/Remove Programs, and click the Windows Setup tab. 

3 From the Components list, click Multimedia, and then click the Details button. 

4 Click the Audio Compression box, and then click OK. 

5 Click OK again to exit the Control Panel. You may be prompted for your Windows 95 or 98 CD.



Display optimization problems
If you reset your display settings after receiving a “Display Not Optimized” alert message, you 
might see another alert message that reads, "There is a problem with your display settings…", along 
with the Display Properties dialog box. 

Some video configurations may incorrectly report to Microsoft Windows that a higher resolution or 
color depth is available than is actually supported by the video card, the monitor, or both. Consult 
your system documentation or, to select a different Color palette or Desktop area setting, click the
Microsoft Windows Start button, point to Settings, click Control Panel, click the Display icon, then 
click the Settings tab. 



Using Picture It! and Microsoft Plus 95
If you install Picture It! on a system that includes Microsoft Plus 95, you may not be able to change 
desktop themes. You can correct this problem by replacing the Themes.exe file on your local 
machine with the Themes.exe file in the \Shared\Grphflt folder on the Picture It! CD.



Picture Too Large alert message
When you choose the Custom Scan option and the Scan Picture command, the following message 
might appear:

PICTURE IS TOO LARGE.

The picture you are trying to open is too large for Picture It! to work with. Please make sure that 
the width and height of your picture are both smaller than 3968 pixels.

This problem is the combined result of a scanning area that’s too large and a scanner resolution 
setting that’s too high. You can fix this problem by using one or both of the following solutions:

Reduce the scan area in the scanner application.
Reduce the scanner resolution in the scanner application.



Printer out of memory Error
If you send a large file to a laser printer, you may get "an out of memory" alert message. Here are 
the likely sources and solutions of this problem:

Your printer doesn’t have enough memory to print the file. If your printer has room for 
additional memory, install it. To find out how much memory you can add to your printer, check the 
printer manual. 

You need to change the printer driver settings. If you’ve recently upgraded the printer 
memory, check the printer driver settings. The total amount of installed memory should be the 
same as the number that appears on the Device Options tab of the printer’s Properties dialog box. 
Should you need to change the settings, check the printer manual, printer manufacturer, or your 
operating system's online Help file.



OLE support
Slide shows created by Picture It! do not support the OLE Link to file option. Always embed objects
when working with OLE support and Microsoft Picture It! slide shows



Picture It! 99 and Microsoft Camcorder application
Microsoft Picture It! may terminate unexpectedly when used with the Microsoft Camcorder 
application that shipped with Office 97. 



Importing and exporting non-MIX files
File formats Microsoft Picture It! can open

 There are several third-party or custom image files formats that Microsoft Picture It! cannot 
open. Check the manuals of the software that created those files for more information on how to 
convert them to a form that Picture It! can read.

Microsoft Picture It! supports the following image formats:

DXF CDR EPS GIF JPG

PCD DRW PCX PNG TIF

TGA BMP, DIB WPG WMF PIC

FPX MIX v1, v2

For more information about supported features or restrictions of a particular format, see the 
following:

MIX v1, v2

Microsoft Picture It! version one format. Picture It! 99 reads and supports all version 1.0 files.

When saving to this format, Microsoft Picture It! can also write version 1.0 compatible files. When 
doing so, Picture It! will preserve your cutouts, "locking down," or saving, all the effects that are 
unavailable in version 1.0. . These effects include edges, shadows, fills, distortions, and text bends. 

Picture It! will also convert text objects with any effects to graphic objects that cannot be 
changed within version 1.0. You cannot edit the effects or the text, even if the file is re-opened in 
Picture It! 2.0.

DXF

The AutoCAD Format 2-D graphics filter (Dxfimp32.flt) supports all AutoCAD versions through 
Release 12, including AutoCAD for Microsoft Windows.

The filter has the following limitations:
Extrusions that are part of 3-D drawings are not supported.
Control codes and special characters embedded in text shapes that require special 

characters are not supported.
The .dxf files that require separate shape definition files are not supported.
For multiple viewport .dxf files, the file is imported using the current viewport.

CDR

The CorelDRAW graphics filter (Cdrimp32.flt) supports .cdr, .cmt, .cmx, and .pat files from 
CorelDRAW 3.0, 4.0, 5.0, and 6.0, and has the following limitations:

CorelDRAW Preferences--such as page size/orientation, units, grid, and guidelines--are not 
supported.

Lenses and powerclips are not supported.
Pages, layers, and groups are not supported.
OLE objects are not supported.
Rotated bitmaps are not supported.
Object and PostScript texture fills are replaced with solid gray fills.
Gradient fills are split into monocolored stripes.



Vector fills are not supported.
Multi area paragraph text is not supported. 

EPS

The Encapsulated PostScript graphics filter (Epsimp32.flt) supports the Adobe Systems 
Encapsulated PostScript Specification versions 3.0 and earlier. The filter supports .eps images from
tagged image file format (TIFF) and Microsoft Windows Metafile (.wmf) embedded previews. 
Microsoft Picture It! will only import the rasterized thumbnails from these files; EPS files without 
thumbnails will appear blank within Picture It!

GIF

The Graphics Interchange Format filter (Gifimp32.flt) supports file format versions GIF87a 
(including interlacing) and GIF89a (including interlacing and transparency). The GIF filter works 
with the Portable Network Graphics filter (Png32.flt) to import GIF files into Microsoft Picture It!.

The GIF filter has the following limitation: Only the first image of a multi-image (animated) GIF is 
imported.

JPG, JPEG

The JPEG graphics filter (Jpegim32.flt) supports Version 6.0 of the JPEG File Interchange Format 
(JFIF).

The JPEG filter has the following limitations:
The filter does not support JPEG Tagged Interchange Format (JTIF) files.
The filter does not support cyan-magenta-yellow-black (CMYK) JPEG files.

PCD

The Photo CD graphics filter supports Kodak Photo CD Version 3.0.

DRW

The Micrografx Designer/Draw graphics filter (Drwimp32.flt) supports Micrografx Designer 3.x, 
Charisma 2.1, and Draw files. The filter imports the entire first page of the file as it would appear 
in Micrografx Designer because these files don't contain information about the size of the image. 
Once the image is imported, you can crop the bounding box to make it fit the size of the image.

The Micrografx Designer/Draw filter has the following limitations:
Text arrays are not supported.
Some Micrografx Designer 3.x fonts are not supported.
Clip paths and tiled paths aren't supported.
Gradient fills aren't supported.

PCX

The PC Paintbrush graphics filter (Pcximp32.flt) supports all versions of the .pcx file format 
through ZSoft version 3.0, with support for 256-color images. 

PNG

The Portable Network Graphics filter (Png32.flt) supports files conforming to the Portable 
Network Graphics Tenth Specification (Version 1.0)

TIF



The Tagged Image File Format graphics filter (Tiffim32.flt) supports all image types and 
compressions that conform to TIFF Specification Revision 5.0 and 6.0, Part1: Baseline TIFF. These 
types include monochrome, grayscale, palette color, and RGB Full Color images. The filter correctly 
handles a single 8-bit alpha channel stored with an RGB Full Color image. The TIFF filter also 
supports the TIFF Extension for CMYK images.

The TIFF filter has the following limitations:
Only the first image of a .tif file with multiple images (subfiles) is imported.
The filter does not support multiple alpha channels (stored as subfiles) or alpha channels 

that don't have 8 bits per pixel.

TGA

The Targa graphics filter (Tgaimp32.flt) supports Truevision Targa images with up to 32 bits per 
pixel.

BMP    DIB

The Microsoft Windows Bitmap graphics filter (Bmpimp32.flt) supports Microsoft Windows and 
OS/2 bitmaps, Run Length Encoded (RLE) bitmaps, and device-independent bitmaps (DIB).

WPG

The WordPerfect Graphics import filter (Wpgimp32.flt) supports WordPerfect Graphics versions 
1.0, 1.0e, and 2.0, which correspond to WordPerfect version 6.x and earlier. For graphics stored in 
WordPerfect documents, the filter uses the size of the picture frame stored in the document to 
determine the size of the picture to import. For .wpg images created in DrawPerfect, the frame 
size is the size of the screen.

The WordPerfect Graphics import filter has the following limitations:
PostScript information is lost in Encapsulated PostScript images embedded in WordPerfect 

Graphics files.
WordPerfect Graphics files with large, embedded bitmaps may not appear properly on 

computers that use the Mach series video drivers from ATI. If you think you have this problem, try
running Microsoft Windows Setup and changing your video driver to the 8514/a drivers supplied 
with Microsfot Windows.



Associating a file type so Picture It! will be the default application to open 
it
Microsoft Picture It! will set itself as the default application to open an image file if the file type 
doesn’t already have a program associated with it. If you have a file type that Microsoft Picture It! 
can open, and you wish to set Picture It! as the default program to open it, do the following:

1 In My Computer or the Microsoft Windows Explorer, click the View menu, and then point to 
Folder Options.

2 Click the File Types tab.

3 In the Registered file types list, click the file type that you want to change.
The settings for that file type are shown in the File Type Details box.

4 Click Edit.

5 In the Actions box, click Open.

6 Click Edit, click Browse , and then select the Microsoft Picture It! icon. Microsoft Picture It! 
is in the Microsoft Picture It! directory under Program Files. 

Note: There are several third-party or custom image files formats that Picture It! cannot open. 
Check the manuals of the software that created those files for more information on how to convert
them to a form that Picture It! can read.



Associating a file type so another program will be the default application 
to open it
Microsoft Picture It! will set itself as the default application to open an image file if the file type 
doesn’t already have a program associated with it. If you have a file type that Microsoft Picture It! 
has set itself to open, and you wish to set another program to open it instead, do the following:

1 In My Computer or the Microsoft Windows Explorer, click the View menu, and then point to 
Folder Options.

2 Click the File Types tab.

3 In the Registered file types list, click the file type that want to change. The settings for that
file type are shown in the File Type Details box.

4 Click Edit.

5 In the Actions box, click Open.

6 Click Edit, click Browse, and then select the program you want to use to open that type of file. 

NT Users who use the Wang or Kodak Image Viewer to view .tif fax files should re-associate 
the .tif file extension with the Wang or Kodak Image Viewer, because Microsoft Picture It! will only
show the first image (so only the first page) of such a faxed file.



Uninstalling Microsoft Media Manager
If you decide not to take advantage of the cataloging features Microsoft Media Manager offers, 
you can uninstall the program. Uninstalling Microsoft Media Manager frees up disc space and active 
memory.

1 Click the Microsoft Windows Start button, click Settings, and then click Control Panel. 

2 Double-click Add \ Remove Programs.

3 Click the Install/Uninstall tab, then from the Select “Microsoft Media Manager” from the list 
and click Add/Remove.

4 Follow the on-screen instructions carefully.

Be sure to select the Convert folders back option from the Media Manager uninstall, so that 
you will still have access to the files created in folders converted to Media Manager folders.

Note:      If you uninstall Microsoft Media Manager without uninstalling Picture It!, cataloging 
functions within Microsoft Picture It! will no longer work.



Mustek flatbed scanners
At this writing, the drivers for Mustek flatbed scanners, including the 1200 Pro, do not work with 
the Picture It! Smart Task Scan feature. This is due to a driver error. Future updates to the 
scanning software by Mustek may fix the problem. Contact Mustek at http://www.mustek.com for 
software update information.



Turning off Virus Checkers
Some virus checking programs will not allow Picture It! to be properly installed. If you encounter 
problems during installation, it may be necessary to first turn off the virus-checking program. 

To turn off a virus-checking program perform one of the following procedures:
If an icon appears on the right end or bottom of your Microsoft Windows taskbar, right-

click the icon and choose a command to turn it off (command names vary, but may include Close, Exit
and Suspend)

--or--
If no icon appears on your Microsoft Windows taskbar, try holding down the following keys 

at once CTRL+ALT+DELETE. You will see a list of all the programs that are running. Select the 
virus-checking program, and click End Task.



Using version 1 or version 2 content with Picture It! 99
Most content used in previous versions of Microsoft Picture It! can still be used in Picture It! 99. If
you insert a version 1 or version 2 CD you can still open the content.

1 On the Picture It! File menu, click Open.

2 In Click a Folder list, point to the CD-ROM drive that contains the Picture It! CD.

3 Click the plus sign (+)next to the Content folder. 

4 To open a template, click the Projects folder and then choose the project you want. 

5 To open PictureArt, click the Pict_Art folder, and then choose the category and subcategory 
you want.



Getting Microsoft Windows NT version 4.0 Service Pack 3
If you have a version of NT version 4.0 that's older than Service Pack 3, you will need to upgrade in
order to use Microsoft Picture It!

Order the Windows NT 4.0 Service Pack 3 CD 

Customers in the 50 United States and Canada can order the North American version of Service 
Pack 3 for Microsoft Windows NT for US $14.95 (CDN $20.95) plus customer service and handling 
charges of US $5 (CDN $7.50). Customers can order the product by phone or mail. 

Phone (800) 370-8758 
Fax (716) 873-0906 
In the 50 United States, mail to

Microsoft NT Service Pack 3 
PO Box 1095 
Buffalo, NY 14240-1095 
In Canada, mail to 

Microsoft Service Pack 3 PO
Box 643 
Fort Erie, ON L2A 6M1 

Canada 

Request part number 236-00789 for the North American (128-bit) version and Part Number 236-
00791 for the International English (40-bit) version. 

IF YOU ARE ORDERING THE 128-BIT VERSION OF SERVICE PACK 3, PLEASE NOTE: The 
North American version of Service Pack 3 is intended for distribution only in the United States and
Canada. Effective January 1, 1997, export of this Service Pack from the United States is regulated
under "EI controls" of the Export Administration Regulations (EAR, 15 CFR 730-744) of the U.S. 
Commerce Department, Bureau of Export Administration (BXA). EI controls are the current 
equivalent of ITAR munitions export controls that previously applied to this product. EI controls 
require that you obtain a Commerce export license prior to any export, transmission or shipment of 
this product to any country, other than Canada, or to any person, entity, or end user subject to U.S.
export restrictions. For further information, the Commerce export license process and EI controls 
are described on BXA's Web site. Microsoft will distribute the North American version of Service 
Pack 3 to U.S. or Canadian companies or persons for end use in the U.S. or Canada only.



Picture It! Trial version filter problems when installed over Picture It! 
If you installed the Microsoft Picture It! Trial version after installing Picture It! 99, you may 
encounter some FPX filter problems. To fix these problems, please reinstall Picture It! 99.



Microsoft Media Manager Help
Some of the help topics in Media Manager's help file are out of date and inaccurate. 



Manually updating the Microsoft Media Manager index
If you add files to your Media Manager My Pictures folder from Microsoft Windows Explorer, you 
will need to update the index manually in order for the Picture It! search to find the files.

1 In Microsoft Windows, click Start, click Windows Explorer, then right-click your My Pictures 
folder .

2 Point to Index, then click Update. 



Display problems with Number Nine Visual Technology Video Card
There are some highlight drawing problems in Picture It! on the following system: 

Manufacturer: Number Nine Visual Technology
Adapter Type: Imagine(tm) Series 2 (HawkEye, Direct Draw) 
Version: 4.0
Monitor Type: Liyama Vision Master MF-8317



Hewlett-Packard LaserJet 5si and 4si
Some systems may experience problems when printing reprints to HP LaserJet 5si and 4si printers 
on Microsoft Windows 98. This problem may be fixed by downloading and installing the latest 
drivers for these printers from the HP web site at http://www.hp.com.



Minolta Dimage Scan Dual film scanner
Colors scanned using the Minolta Dimage Scan Dual film scanner may come out wrong. This is due to 
a driver error. The following steps may fix the problem:

1 Launch Microsoft Picture It!

2 On the View menu item, click Options.

3 Click the Scanner/Camera Options button.

4 Set Scanner Performance to Normal.



Plustek flatbed scanners
At this writing, the drivers for some Plustek flatbed scanners do not work with the Picture It! 
Smart Task Scan feature. This is due to a driver error. The following steps may fix the problem for
some scanners:

1 Launch Microsoft Picture It!

2 On the View menu item, click Options.

3 Click the Scanner/Camera Options button.

4 Set Scanner Performance to Normal.

I f the above steps do not help, future updates to the scanning software by Plustek may fix the 
problem. Contact Plustek at http://www.plustek.com for software update information.



Visioneer flatbed scanners
At this writing, the drivers for Visioneer flatbed scanners, including the PaperPort 6000, do not 
work with the Picture It! Smart Task Scan feature. This is due to a driver error. Future updates to 
the scanning software by Visioneer may fix the problem. Contact Visioneer at 
http://www.visioneer.com for software update information. 



Year 2000 issues
Microsoft Picture It 99 interprets dates differently, depending on which version OLEAUT32.DLL is
installed in the system folder of your computer.

If the version of OLEAUT32.DLL that's installed in your system folder is 2.20.4049 or later, 
Picture It 99 interprets dates entered with an abbreviated year format, such as mm/dd/yy, as 
follows:

1/1/00 through 12/31/29 are interpreted as 1/1/2000 through 12/31/2029
1/1/30 through 12/31/99 are interpreted as 1/1/1930 through 12/31/1999

If you have Office97 and/or Windows NT 4.0, your system probably has a version of 
OLEAUT32.DLL that follows the previously outlined rules.

If the version of OLEAUT32.DLL that's installed in your system folder is earlier than 2.20.4049, 
Picture It 99 interprets dates entered with an abbreviated year format as follows.

If the current century is the 20th, 1/1/00 through 12/31/99 are interpreted as 1/1/1900 
through 12/31/1999

If the current century is the 21st, 1/1/00 through 12/31/99 are interpreted as 1/1/2000 
through 12/31/2099

To find out which version of OLEAUT 32.DLL you have, perform the following procedure:

1 On the Start menu, click Find and then click Files or Folders. 

2 In the Named text box, enter Oleaut.

3 In the Look in list, click [C:], and check Include subfolders.

4 Click Find Now.

5 In the list of files, highlight Oleaut 32.dll 

6 On the File menu, click Properties 

7 In the dialog box, click the Version tab, and then read the version number.

If the version is earlier than 2.20.4094 you may wish to download the latest version of this file for 
greater flexibility when working with calendar dates in Picture It! You can obtain this file at: 
http://support.microsoft.com/download/support/mslfiles/Msvbvm50.exe



Microsoft Media Manager installed in Microsoft Windows 98
In Microsoft Windows 98 with Microsoft Media Manager Cataloging installed, folders placed inside 
the \My Documents\My Pictures folder cannot be accessed from Microsoft Internet Explorer. 
Microsoft Picture It! and other programs can still access these folders and subfolders.



PhotoDisc
Note: PhotoDisc digital images are an important part of Microsoft PictureIt!    The following background 
and ordering information is provided by PhotoDisc, Inc. as a service to PictureIt! users.

Enhance your PictureIt! projects with professional 
photography!

Have an idea in mind, but don’t have the right photo on hand? Get just what you’re 
looking for with ready-to-use digital images from PhotoDisc®, the leader in digital stock 
photography.

A Creative Edge.
PhotoDisc’s award-winning photos give you a full range of powerful and professional 
choices for your business and personal communications.    For creative, attention-
grabbing cards, calendars, flyers, mailers, presentations, newsletters, personal web 
pages and more, you’ll find thousands of options with high-quality images from 
PhotoDisc.

The enclosed PictureIt!-ready images are just a sampling from the PhotoDisc collection 
of royalty-free photographs available online. 

For lots of choices at an affordable price, PhotoDisc has an easy new online 
photography collection specially designed for PictureIt! and Microsoft Office® users.    
It’s called PowerPics™.    At www.powerpics.com you’ll find thousands of high-quality 
photos ranging from … 

personal choices such as holiday themes, travel, nature, animals, sports and vintage 
shots, to …

common business themes such as success, time, money, communication and 
teamwork, as well as a myriad of photographic backgrounds and icons (such as 
computers, telephones and more) …

that you can use to add impact to your everyday communications.    Searching through 
the collection is free.    And when you find what you’re looking for, you’ll be surprised at 
how affordable professionally taken photos can be to purchase.    

Each PowerPics image is available in your choice of two sizes — to get the best results 
onscreen or on your desktop color printer. Simply choose your images and your file 
size, and register to purchase. You can have the images you need in just minutes — the



JPEG files are carefully compressed for speedy downloading and easy, rewarding use 
with most PC applications.    

And because PowerPics photos are sold only online, they’re ready when you are: 7 
days a week, 24 hours a day. 

We’ve Taken Care of Everything for You.
As the highest-rated provider of digital stock photography, PhotoDisc has the keys to 
making sure the image is right, every time.    Each of the photographs in the PowerPics 
collection is chosen from the portfolios of award-winning photographers, carefully 
scanned with the highest-quality scanning technology, color-corrected and stored in full-
color JPEG format for dazzling impact.    

And once you’ve made a purchase from www.powerpics.com, your PowerPics images 
are always ready for you from your Previous Purchase page online.    

Five FREE Photos for PictureIt! Users! 
We’re so sure you’ll like the idea of fueling your imagination with professional 
photography online, that we’ve reserved five FREE images for you.    They’re waiting for
you right now at www.powerpics.com.    See for yourself how easy it is to download and 
use high-quality digital photos from PowerPics!

And PhotoDisc is adding fresh new images to the PowerPics collection constantly — be 
sure to check out www.powerpics.com frequently to see the latest ways to add polish to 
your creativity.    

For More Information.
For more information about PowerPics images, please use version 3.1 or higher of your 
browser to access www.powerpics.com on the internet.

Licensing.
For licensing information on the PhotoDisc images included with your PictureIt! 
software, please look to the Microsoft End User License Agreement. For complete 
PowerPics licensing information, please visit the PowerPics site. 



Playing Help movies in Picture It!
If the movies in Microsoft Picture It! Help and the Introduction do not play properly, turn on Video
Compression:

1 In Microsoft Windows, click Start, point to Settings, and then click Control Panel.

2 Double-click Add/Remove Programs, and then click the Windows Setup tab.

3 From the Components list, click Multimedia, and then click the Details button.

4 Select the Video Compression checkbox, then click OK.

5 Click OK again to exit the Control Panel. You may be asked to insert your Microsoft Windows 
CD.



Installing Picture It! on systems with Hewlett-Packard OfficeJet devices
If you have Hewlett-Packard OfficeJet devices installed on your system, you may have trouble 
installing Microsoft Picture It! Usually, turning off the OfficeJet software before installing 
Picture It! solves this problem. To turn off the OfficeJet software, right-click the OfficeJet 
Software Icon on the Task bar, then click Close OfficeJet Software.




